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I NE IGHT CONTROL OVERV IEW

LESSON DURATION: 30 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Describe the InEight cloud platform and how it relates to your project management process

l Define InEight Control and its purpose

LESSON TOPICS



1 . 1 INE IGHT CONTROL OVERV IEW

As one of the applications within the InEight portfolio of products, InEight Control is a project
management tool used for:

l Managing account codes

l Measuring progress

l Forecasting final man-hours and costs

l Managing revenue

l Managing budget/contract changes

1.1.1 ACCOUNT CODE MANAGEMENT

Within InEight Control, you can define and assign account codes to your cost items. This association
can be synced to your ERP, and can also be used to benchmark data with other projects.

1.1.2 PROGRESS MEASUREMENT

InEight Control is the application where your Cost Breakdown Structure and budget are established
and where you can monitor project progress. You can:

l Import your conformed estimate and structure from InEight Estimate

l Create and manage cost items

l Import approved quantities from InEight Plan
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l Import final hours and costs from your ERP system

l Track your actuals and compare them against your Current Budget and earned values

The following workflow illustrates how these functions relate and pass information between systems.

You can utilize this information to analyze trends, track productivity factors, and measure progress.

1.1.3 FORECASTING

InEight Control provides options for forecasting final costs, man-hours, and productivity for your
project.
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You can forecast your remaining work based on any of the following Forecast Methods:

l Current Budget

l Current Estimate

l Average performance

l Committed Cost

l Manual Entry

You can save private forecasts, share them with others, and push them to a “live” forecast which can
be reviewed by all and used for official reporting. You can also compare the Live Forecast to other
forecasts created, for example to compare to the previous month’s forecast.

The workflow diagram below illustrates how forecasting functions relate to the rest of InEight Control
and other systems.
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1.1.4 REVENUE MANAGEMENT

Within InEight Control, you can create and manage pay items for tracking pay quantities, actual and
forecasted revenue, and how much has been billed to the client.

1.1.5 CHANGE MANAGEMENT

InEight Control allows you to manage changes to quantities, man-hours, and costs in each cost item as
needed during the execution of the project. You can make three different kinds of changes within the
Change Management register:

l Budget move – Movement of costs between cost items where the total dollars moved must
balance to zero. There is no revenue associated with this type of change
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l Budget quantity and man-hour adjustment – change to quantities or man-hours within the
project without changing costs

l Contract adjustment – both the budget and the revenue either increase or decrease and are not
required to be a net zero transaction. You will associate pay items with the change order to
reflect the revenue change

Approved changes update your Current Budget within the CBS register.

The below workflow shows the relationship of Change Management to the rest of InEight Control.

Below is an example of what the Change Register looks like in InEight Control.
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1.1.6 INEIGHT CONTROL WORKFLOW

The following workflow illustrates how all the functions of InEight Control work together.
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REVIEW

1. Which InEight application do you use for capturing time and quantities in the field?

a. InEight Control

b. InEight Plan

c. InEight Progress

d. InEight Inspect

2. What key data is imported from the ERP system into InEight Control? (Select all that
apply.)

a. Costs

b. Quantities

c. Hours

d. Notes

3. Which of the following is NOT a function of InEight Control?

a. Budget Management

b. Daily Planning

c. Change Management

d. Progress Measurement

e. Forecasting

SUMMARY

As a result of this lesson, you can:

l Describe the InEight cloud platform and how it relates to your project management process

l Define InEight Control and its purpose

Page 28 of 572 InEight Inc.  |  Release 25.5

Review  Control User Guide



InEight Inc.  |  Release 25.5 Page 29 of 572

GENERAL NAV IGAT ION

LESSON DURATION:   45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Navigate the InEight Control Workspaces page

l Manage columns

l Group Pay Items

l Manage data blocks

l Create viewsets
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2 . 1 PAGE NAV IGAT ION

In the following lesson, you will open the InEight cloud platform to explore the layout and start to
navigate around the application. You will access InEight through your web browser, using the link
provided by your manager or facilitator.

This takes you to the All projects & organizations page, where you can select any project you are
associated with.

If your project is not displayed on the initial screen, you can search by selecting the magnifying glass
icon in the top right corner. This search function will search all terms in all columns.

When you select a project, it takes you to the Project home landing page.
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From here, you can navigate to InEight Control.
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NAVIGATE THE INEIGHT CONTROL WORKSPACES PAGE

1. On the Project home screen, select Control > Workspaces.
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l This brings you to the Workspaces page within the Control application

Title Description

1 Home Menu Returns to the Organization or Project home landing page

2 First Level
Menu

Select an organization or project, along with other master data
libraries, suite administration, and other settings, depending on your
role and access.

3 Second Level
Menu

Select what application you want to use (Control, Plan, etc.), as well as
other project settings.

4 Third Level
Menu

Navigate to separate individual modules inside each application (e.g.,
Contract > Bid packages, Plan > Quantity tracking). Options in this
menu change based on what application you are currently using.

5 Notifications View notifications.

6 User Profile User profile and log out.

7 Actions Menu Select available actions for the current register tab you are viewing.

8 Left Toolbar Contains 3 main buttons used most commonly throughout the suite.  In
this case, add is used to add cost items, Edit to edit cost items, and

Overview – Control Workspaces Page
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Title Description

delete to remove a cost item from the project.

9 Tabs Navigate to the CBS (Cost Breakdown Structure), ACS (Account Code
Structure), Pay items, Change register and Audit log register pages.

10 Viewset
Menu

Display different preset views or create your own viewsets.

11a Right Toolbar Contains functions for the register page you are currently viewing.
(Additional information shown below).

11b Side Toolbar Contains a filtering, CBS Tree, and sorting option.

12 Register
content

Where the page content displays in rows and columns, grouped
together in customizable Data Blocks.

Overview – Control Workspaces Page (continued)

2.1.1 RIGHT TOOLBAR OVERVIEW

The right toolbar allows you to use functions for the register page displayed. The toolbar options will
change depending on what tab you have selected (CBS, ACS, Pay Items, Change Register, Audit Log).
You will most commonly use the right toolbar for the CBS register page:

Icon Function

1 Group
Columns

Allows users the ability to group rows of the cost breakdown structure by like
information from selected columns.

2 Undo Undo button to undo changes.

3 Display Change currency displayed in data blocks.

Overview – Workspaces Page CBS Tab – Right Toolbar
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Icon Function

Currency

4 Add Data
Block

Add a data block to your register view.

5 Import Import CBS Data or Actuals from an Excel File.

6 Export Export your register view to an Excel file. Only the data blocks currently
displayed on the page will be exported to the file.

7 Row
Density

Adjust the line height at which the register content is displayed. Options are
relaxed, narrow, or tight.  Allows for more lines to be viewed on the page if
desired.

8 Find Find value in register content by selecting a data block column, selecting
either the Begins with or Contains criteria, then entering the value to search
for.

Overview – Workspaces Page CBS Tab – Right Toolbar (continued)

2 . 2 COLUMNS /GROUP ING /SORT ING

InEight Control allows you to customize columns in your data blocks according to your preferences.
Changes made to the placement of your columns will be retained the next time you access any page
you have customized.

2.2.1 MOVE COLUMNS

You can move a column from one place to another to customize your view using drag and drop.
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MOVE COLUMNS

1. On the Pay Items tab, click and hold any column.

2. Drag it to the left of right of another column.

l Two black arrows appear to guide you to the location the column will be dropped

2.2.2 SORT COLUMNS

You can sort columns in ascending or descending order for both for alpha and numeric fields on any
column by clicking once on the column header.
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SORT COLUMNS

1. On the CBS tab, select any column header.

l A yellow arrow appears, facing downward, indicating that you are sorting that column
alphabetically from A-Z or numerically.

2. To revert the sort, select the column header again.

l The yellow arrow faces upward indicating the reverse sort.

3. Select the column header once more to return the column to the original sort.

2.2.3 FILTER COLUMNS

You can filter your column data to show only specific, pertinent information that you need. There are
two ways to set a filter:

2.2.3 .1 METHOD 1: FILTER FROM COLUMN HEADER

You can set a filter for a column by clicking on the filter icon on any column header. This brings up a
drop down list of items that you can filter by to apply to that specific column.
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If you wanted to remove a single filter, locate the column you filtered, click the filter icon,
and select the Clear button.

On the resulting filter, you can hover over the filter icon on the right icon selection to view which filters
are applied.

Selecting the filter icon will remove all the filters applied to the columns.

2.2.3 .2 METHOD 2: FILTER FROM RIGHT TOOLBAR

You can also set a filter by selecting the Filter icon from the right toolbar and selecting Query.

This option is helpful when you:

l Need to search for the column you need to filter

l Need to apply filters to more than one column

Selecting the Filter icon from the right toolbar opens the Query builder slide out panel, where you can
set the filter value.
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2.2.3 .3 FILTER SLIDE OUT PANEL

The Filter slide out panel contains three key settings:

Title Description

1 Columns Drop-down list to select the column to filter.

2 Operator Determines what kind of filter to apply. Includes the following:
l Equal
l Greater than
l Greater than or equal
l Is not null
l Is null
l Less than
l Less than or equal
l Not equal

3 Query Name Name of query.

Filter Settings

The following steps walk you through how to set a filter using the filter icon on the right toolbar.
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FILTER COLUMNS

1. From the CBS tab of the Control Workspaces page, click on the View drop-down arrow.

2. Select the Project controls viewset.

3. Select the Filter, then Query icon from the left toolbar.
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l The Query builder slide out panel appears

4. Click on the Columns drop-down arrow to select a column.
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l Notice that the column titles are grouped by the data block in which they are housed

5. Select the Forecast Method column.

l This can also be typed into the text box to search for the column you need

6. Click on the Operator drop-down arrow and select Equal.

7. Click on the Value drop-down arrow and select Rollup.
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l Note that you can add additional filter criteria by clicking the plus icon

l Note that you can click Save to add the filter to the My saved filter section for future use

8. Click Apply to apply the filter.

2.2.4 PAY ITEM GROUPING

Pay item grouping allows you to group your data in the most efficient way that makes sense to you.
This is useful if you want the option to group certain columns, and subtotal pay items.
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The following steps walk you through how to set a pay item group by using drag and drop.

PAY ITEM GROUPING

1. From the Pay Items tab of the Control Workspaces page, click and drag the Billing methods
column header, and drop it in the space above.
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l Your Pay Items are now grouped by Billing methods

2. Click on the sort arrow to the left of Billing methods column header to reverse the order of the
sort grouping.

l Your Billing methods are now sorted, and the Unit Price displays as the first Billing
Methods grouping
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2.2.5 SUBTOTAL GROUPING

Subtotal grouping lets you group your data based on the subtotals in the CBS. This is useful if you want
the option to group certain columns. You can group the following columns:

l Forecasting columns

l Current Estimate

l Current Budget

l Actual columns

l Cost columns

l Man Hour columns

The following steps walk you through how to group by subtotals using drag and drop.
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SUBTOTAL GROUPING

1. From the CBS tab of the Control Workspaces page, click the Group By icon.

2. Click and drag the Unit of Measure column header, and drop it in the space above.

l Your columns are now sorted by Unit of Measure.

2.2.6 PAY ITEM MOVE OPTION

The move to feature is the only way to adjust the pay item order. This feature is similar to the adjust
CBS position feature in the CBS register. For a pay item to become a parent, billed revenue, billed
quantity, and current price must be zero, and no cost items can be assigned to it.

Selecting one or many pay items activates the Move to icon.
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Selecting the move to icon opens the move-to field, where you can select the pay item you want to
move your selected pay item to.

After selecting the move to pay item and then clicking on the Move to icon, you have the option to
move the pay item as a child or a sibling.
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2.2.7 PAY ITEM VIEWS

After your page view is arranged to your preference in the Pay Items page, you can create and save pay
item views.

The pay item view feature lets you select which columns to display in the current Pay item view, with
the Price and Revenue views as the default views.

You can click the pay item column selection icon to choose which fields to include in your view.
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Like the view feature in the CBS, you can create, save, rename, and delete views.
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2 . 3 DATA BLOCKS

Each data block is a set of columns grouped together based on categories of information. Using data
blocks helps you organize and manage all the columns on a page.

Data blocks are customizable, and you can view them side by side and move them around in the
register. The information in each data block displays in a grid like format, maintaining a spreadsheet
look and feel.

Each type of data block has its own unique default settings such as date range selectors and date
preset options (for financial periods). You can choose the total number of columns and panels for each
data block.

2.3.1 RESIZE COLUMN WIDTH

Data blocks can be customized based on your viewing preferences.. You can resize the columns widths
within a data block, so you are able to see all the data within a column.

In the below example, the Tasks Data block contains a column called Description. There are values in
the Description column which have the capability of being expanded for better visibility. The shortened
descriptions to be expanded are denoted by a ‘…’ after the shortened description name.
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If you want to resize and move the Description column to the right, select the Description column
border, and drag it to the right. Stop dragging the column when you’re satisfied with the column width.

2.3.2 DATA BLOCK CATEGORIES

There are three categories of data blocks: Standard, Cost Category and Custom data blocks.

2.3.2 .1 STANDARD DATA BLOCK

These include the following default data blocks: 

l Task Details

l Actuals

l Current Budget & Estimate

l Forecast

l Forecast Delta
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l Live Forecast

l Schedule

You can customize the columns grouped within each of these data blocks.

2.3.2 .2 COST CATEGORY DATA BLOCK 

These data blocks organize key project progress information by cost category, and include the
following:

l Cost categories: Actuals

l Cost categories: Current Budget

l Cost categories: Current Estimate

l Cost categories: Forecast

You can change the columns in Cost Category data blocks.

2.3.2 .3 CUSTOM DATA BLOCK

There are nine types of custom data blocks, each with their own unique characteristics:

You have the freedom to choose the type that best meets your needs. You will then select which
columns go into the custom data block.
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2.3.3 ADD A DATA BLOCK

The following step by step walks you through adding a standard or cost category data block to the CBS
tab of the Workspaces page.

ADD A STANDARD DATA BLOCK

1. On the CBS tab of the Workspaces page, click on the Add data block button on the right toolbar
to open the Data block slide out panel.

2. On the slide out panel on the left, drag and drop the Cost categories: CB data block into the
register page on the right. 

Each view holds a maximum of five data blocks.

l This will drop the data block at the very far right side and you can then move it via

drag and drop in the register
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You can view currently active project data blocks by either a thumbnail or list.

2.3.4 CREATE A CUSTOM DATA BLOCK

The following steps walk you through creating a custom data block from scratch.

CREATE A CUSTOM DATA BLOCK

1. On the CBS register page, click on the Add data block button, to open the data block slide out
panel.

2. At the bottom of the Data Block menu, select Create custom data blocks.
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3. Select Data Block Type: General.

4. In the Data block title, enter in [your initials] Training – Unit Cost.

5. Select Next.

6. Using one of the methods above, add the following columns to the data block on the right:

l Unit Cost (To Date)

l CE Unit Cost (To Date)

l Forecast Remaining Unit Cost

l Forecast Final Unit Cost

l CE Forecast Unit Cost G/L

7. Once your data block is finalized, click Save at the bottom right of the slide out panel.

On the Add data blocks slide out panel, you will only see the Custom data blocks
you create. Custom data blocks created by other users will only show up under
their respective logins.

2.3.5 FORECAST DATA BLOCK

When you open the Forecasts view, you can select existing private forecasts or choose to create a new
private or shared forecast. This helps to create a more manageable list of private and shared forecasts.
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2.3.6 DATA BLOCK CONTEXT MENU

The data block Context Menu allows you to perform different operations specific to the data block you
select.

The following table provides an overview of Context Menu options:
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Data Block Context Menu

Title Description

Choose columns Open the column chooser menu and move, add, and remove
columns from the data block.

Filter Filter data within a data block.

Save data block as Create a copy of the existing data block and save it.

Remove data block Remove the data block from the current view.

Color coded terminal
items
(Tasks data block
only)

Add colors to terminal items of your current data block.

Color-coded CBS
position
(Tasks data block only)

Adds colors to all CBS lines.

Show/Hide WBS
Phase Code
(Tasks data block
only)

Display or remove the WBS Phase Code column within the Tasks
data block.

In the following step by step, you will learn how to modify a custom or an existing data block using the
Context Menu.

EDIT A DATA BLOCK

1. In the CBS register, select the Context Menu icon of the custom data block you created.

2. Select Choose columns from the context menu.

3. Add a new column to your custom data block.

4. Remove a column from your custom data block by selecting the header and clicking the left-
facing arrow to return it to the left column.

InEight Inc.  |  Release 25.5 Page 59 of 572

Control User Guide 2.3 Data Blocks



5. To close the slide out panel, click the APPLY button on the bottom right of the slide out.

2.3.7 FILTER DATA BLOCK DATA

You can filter the columns in your data blocks to see relevant information pertaining to your specific
needs.

The following Step by Step walks you through filtering data block columns.

FILTER DATA IN A DATA BLOCK COLUMN

1. From any tab, on any column header, select the yellow arrow icon.​

2. Select your desired operator from the first drop-down list.​

3. Enter the value in the next field.​

4. Select the next fields for filters logic and additional operator.​

5. Select Apply. The pyramid turns yellow.​

6. To clear the filter, select the same column header and yellow arrow.

7. Select Clear.

2 . 4 V IEWSETS

Once you have all desired data blocks organized to your liking, you can create a saved view of your
page so that you can always revert to it. This saved view is called a Viewset. The viewset can also be
shared with other users.
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CREATE AND SAVE A VIEWSET

1. From the CBS register page, click on the View drop-down arrow.

2. From the Viewset drop-down list, select Save view as.

3. Name your view [your initials] – Saved view. 
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4. Click Save.

2.4.1 SENDING VIEWS AND DATA BLOCKS

Certain permissions are needed to send views and data blocks to roles.

You can send views to all users that have a certain role. You can also send it to specific projects or full
organizations. To send to a project, you have to be a user on that project or in that organization.

SEND A VIEWSET

1. With the Viewset selected and shown, from the Viewset drop-down list, select Send view.

2. In the Search for a User field, type an employee's name and select their name from the list.
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l To send to a project, you have to be a user on that project or organization. Then
select the Send View to drop down list and select the option you want.
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3. Click Send.

4. The selected Viewset will send a notification to the selected employee, and will be available in
their drop-down list with sender’s name and when the Viewset was sent.
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If the user does not have the proper permissions to view all the columns in the view that
was sent to them, then the employee will only be able to view the columns for which
they have permissions.

2 . 5 ROW DENS ITY

The row density feature allows you to change the spacing between rows within the various pages and
slide out panels in Control, allowing you to view your data with the amount of spacing you prefer.

There are three options available:
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l Relaxed

l Narrow

l Tight

The Row density icon is available on the CBS, ACS, Pay Items, Change Register, and Audit Log tabs.
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When you select the Row density icon, a drop-down menu appears, where you can select the row
density (space between rows) you prefer.

The row density you select applies to all registers within Control, including all tabs and slide out panels
on the Workspaces and Project Library pages.

Row density is user-specific, so different users can apply different row densities within Control, and the
row density option you select will remain the next time you log in.

Row density is independent from the Viewsets you create. The row density you select is
therefore not saved as part of your viewsets.

2 . 6 AUD IT LOG

The Audit Log tab within the CBS register is used to capture changes that were made within InEight
Control and is broken down into five sub-tabs located on a left sidebar menu. Each log is designed to
capture the changes that happened within each of the different registers and during synchronization.

All five audit logs can be accessed by selecting the Audit log tab on the menu bar, then selecting each
individual audit log on the far left.
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2.6.1 CBS

You can access the CBS audit log by selecting CBS from the left side menu.

The CBS audit Log captures changes in the CBS register and utilizes an attribute field to identify what
type of change was made. Other columns include:

l Changed By (who made the change)

l Change Date (the date and time the change was made)

l The attribute value before and after

l Forecast cost before and after

l Forecast man-hours before and after

l Posting date before and after

2.6.2 ACS

You can access the ACS Audit Log by selecting ACS from the left side menu.

The ACS Audit Log functions similarly to the CBS Audit Log, but contains the changes that were made
within the ACS (Account Code Structure) tab. The fields utilized to capture what changes were made
are:
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l Change attribute

l Changed By (who made the change)

l Changed Date (the date and time the change was made)

l Attribute value before and after

2.6.3 PAY ITEMS

You can access the Pay Item Audit Log by selecting Pay Items from the left side menu.

The Pay Item Log again functions similarly but contains changes that were made to the pay items. The
fields utilized to capture what changes were made are:

l Attribute

l Changed By (who made the change)

l Changed Date (the date and time the change was made)

l Value before and Value after

l Total price before and after

2.6.4 INTEGRATION

You can access the Integration/Sync Audit Log by selecting Integration from the left side menu.
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The Sync Audit Log is different from the other three. This log is used to capture:

l Whether the syncronization process between InEight Control and the ERP system was completed
successfully

l How long the sync process took to complete and who requested the sync

It keeps track of the functions performed under the Actions > Sync menu.

The syncing process will be discussed further in the11.3 Audit Log Integration on page 508.

To help troubleshoot sync issues, you can click the link under the Processing details column to get
more information on which steps succeeded, are suspended, or failed.

If a sync error should occur, you can click on the Log Handle link to obtain troubleshooting information.
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This brings you into the InEight Suite App Logs screen, where you can see information relating to the
error including Level, Time, Domain, Area, Exception Message, Exception Type and Correlation Id,
which can help you determine the cause of the sync error.

2.6.5 IMPORT HISTORY

You can access the Import history audit log by selecting Import history from the left side menu.

The Import history log contains status information for all imports coming into all InEight products. For
example, cost item and actuals import processes can both be viewed in the Import history log for
status, then you can eventually make corrections and reprocess.

The Import history audit log allows you to take action on import and sync failures, based on error
messages. Error messages are contained within the error file for those imports that have failed import.

You can view progress in sync longs, view error messages, and then resolve issues in effort to continue
with your import.

Section Description

1 File name The name of the actual import file being used to import data.

2 Status The current status of the import file. There are six import status that
can define the current state of an import process.

3 Processing
Details

This column describes the processing state in which the file is being
processed. This column is not applicable for all statuses.

4 Total line
items

This is the total line items that are included within the Excel import file.

5 Errors This is a count of the number of errors during import.

6 Total import This is the total amount of records that were successfully imported
from the Excel import file.

7 Added This is the total amount of added estimate resources that were added in

Control — Audit Log
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Section Description

estimate
resources

the CBS.

8 Added pay
items

This is the total amount of pay items successfully imported from the
Excel import file.

9 Created by This is user responsible for importing the Excel upload file.

10 Created date This is the actual date the Excel upload file was imported.

11 Last edited by This is the last user to edit the Excel upload file.

12 Last edited
date

This is the last date the Excel upload file was edited.

Control — Audit Log (continued)

If you hover over one of these Status symbols below, it provides you with a brief explanation of the
selected status.

Here are some examples:
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There are six possible import statuses listed below.

Status Status Icon Definition

Failed Import failed due to a duplicate row within the
Excel file.

Failed with
errors

Import failed with an attachment to download
with further information.

Pending The Excel import file is pending, further action
is needed. The double blue arrows will open a
new window where you can correct and re-
process the Excel import file. The blue circle
with the line through it will cancel the import
completely.

Cancelled The Excel import file has been cancelled.

Processing The Excel import is still processing. Once this
is complete, the status will move into one of
the other five statuses.

Complete Processing of the Excel import files is
complete.

Import history Statuses

2.6 .5 .1 PENDING STATUS

When an import is in a Pending status, this means that further action is needed to complete the Excel
file import.

There are two options:

InEight Inc.  |  Release 25.5 Page 73 of 572

Control User Guide 2.6 Audit Log



OPTION 1

1. By selecting the double blue errors, you will be taken to another window to continue processing
the faulty records.

As an example, in the below screenshot, there are 3 existing errors. If you hover over one of the
errors, it will tell you what needs to be corrected.

In this case, there is an issue with the account code assignment, as the pop-up hover suggests.

2. When you double click into one of the 3 errors, it will take you directly into an account code
assignment screen where you can make the correction.

From here you can select an account code and click on Assign.
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3. After all corrections have been made to the existing errors, you can select the Import button on
the top right on the screen.
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4. A warning message appears stating that changes will be made, and this project will be disabled
until completion.

5. Once processing has finished, you will receive an Import complete message.

6. The Import history page now shows that the imported file is now successfully imported and
updates the Last edited date.
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OPTION 2

1. Selecting cancel, the blue circle with the line through it, will cancel the import completely.

2.6.5 .2 FAILED WITH ERRORS STATUS

When an import is in a Failed with errors status, the system will generate a Word error report. The
document displays detected errors while attempting to import the Excel file values. Errors will need to
be reviewed within the Word document

An example of the Failed with errors Word error file provides direction on how to proceed with
correcting the Excel import errors, and a course of action to run the import again
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The only option with a Failed with errors status is to review the errors, resolve them within the initial
Excel file import, and then re-import the file.

2 . 7 PROJECT INTRODUCT ION

You will be using the project titled “Steel Structure Training Job” for the InEight Control training.
Within this Control training, you will create cost items and other data that will be utilized in trainings
covering the other InEight products (Plan, Progress, etc.)

The project consists of the construction of multiple steel support platforms in a greenfield site. The
project scope ranges from site preparations, concrete foundation and footing pours, steel erection,
and bolted connections.
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REVIEW

1. Match each term to its correct definition:

Term Definition

Home
Menu

Select available actions for the current register tab
you are viewing.

Actions
Menu

Navigate to the CBS, ACS, Pay Items, Change
Register and Audit Log register pages.

Tabs
Select what application you want to use (Control,
Plan, etc.), as well as other project settings.

Right
Toolbar

Contains functions for the register page you are
currently viewing.

Second
Level
Menu

Returns to the Organization or Project home landing
page

2. Which two of the following are not a data block category?

a. Standard

b. Unique

c. Cost category

d. Custom

e. Audit

3. How are filtered columns in InEight Control indicated in the content register’s data
blocks?

a. Column header is highlighted green

b. Column will shade red
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c. Sort/Filter button in column header is yellow

d. No indication is given

4. How do you change the spacing of your rows in Control?

a. Select the Row density icon from the right toolbar

b. Select Row density from the Actions menu

c. Change Row density in the Project settings

SUMMARY

As a result of this lesson, you can:

l Navigate the InEight Control Workspaces page

l Manage data blocks

l Group Pay Items

l Manage columns

l Create viewsets

l Change row density
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3 . 1 INE IGHT CONTROL WORKFLOW – COST
ITEM SETUP

InEight Control is the application used to create and manage cost items. The cost breakdown structure
developed and maintained in Control is utilized by other InEight applications which inherently share
the same data set to eliminate duplicate data entry.
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3 . 2 COST ITEM OVERV IEW

3.2.1 COST BREAKDOWN STRUCTURE

The CBS (Cost Breakdown Structure) is the main tab of the Workspaces page in Control and is the tab
where you typically spend most of your time. Each row in the CBS represents a work activity and is
called a cost item.
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The CBS is organized in a hierarchy of superior and subordinate cost items. A cost item is superior
and/or subordinate based on its relationship to other cost items. This is similar to a parent and a child
relationship where an individual can be both a parent and a child at the same time. The CBS is color
coded to identify which level of the hierarchy a specific cost item is located.
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If a cost item has no subordinates it is considered a terminal cost item. Terminal cost items are where
cost is tracked. All superior items are a roll up of the budget, manhours, and cost of the cost items
below. Terminal items are identified with a special symbol located at the first column of each data
block.

This terminology and associated graphics provide a way to communicate and understand the hierarchy
of the Cost Breakdown Structure. The following table provides definitions for each of these terms.

Term Definition

Superior Cost item that has subordinate subcost items that roll up under it.

Subordinate Cost item that is a child to a superior cost item.
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Term Definition

Terminal Cost item that has no subordinate beneath it. Costs and hours are
defined at the terminal level.

As accurate as estimators try to build the estimate, changes occur during the project’s execution that
affect the CBS register in Control. To learn how to maintain, improve, and use the CBS register
properly, this topic focuses on the fundamentals of the Cost Breakdown Structure.

3.2.2 CBS TREE

The CBS tree provides a way to navigate up and down your Cost Breakdown Structure and a way to
filter down to a subset of the structure.

You open the CBS tree slide out panel by clicking on the CBS Tree icon on the Side Toolbar.

When selected, the CBS tree icon turns yellow and the slide out panel appears.
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l Select Expand all to expand the entire Cost Breakdown Structure

l Select Collapse all to collapse the entire Cost Breakdown Structure

l Click on the arrow icons to expand a cost item to view its subordinates

l Select a cost item and then click Apply to filter your view to that cost item and its subordinates

l To clear the CBS filter, click the CBS tree icon and then click Disable

You can select more than one cost item on the tree to create a customized view.
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3.2.3 COST ITEM MENU

You can access a variety of cost item details and actions from the Cost Item menu.

You can open the Cost Item menu in one of two ways:

l Right-click the cost item

l Click the three vertical dots in the Description column

The following table provides details for the options in the Cost Item menu.
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Option Details

Copy cost item Copy the selected cost item with its associated resources.

Copy selection Copy the value from a specific cell.

Paste Paste the copied content.

Insert copied cost items Insert the copied cost item in a CBS position that is above,
below, or subordinate to the selected cost item.

New cost item Create a new cost item.

New subordinate cost item Create a new cost item that is subordinate to the selected
cost item.

Delete cost item(s) Delete the selected cost item.

Adjust CBS position Move the selected cost item to a new position in the CBS.

Update Forecast (T/O) qty with
Plan component total qty

Copy the total quantity of the associated component in
InEight Plan to the Forecast (T/O) quantity of the selected
cost item.

Cost item details Open the Cost Item Details slide-out panel, where you can
manage the cost item.

Actuals details Open the Actuals Details slide-out panel, where you can
input claimed quantities and view actuals history and
commitments.

Change summary Open the Change Order Details slide-out panel, where you
can view associated change orders, the budget change
summary, and the change order summary.

Contract details Open the Contract Details slide-out panel, where you can
view associated contract details from InEight Contract.

Cost item dashboard Open the Cost Item Dashboard slide-out panel.

3.2.4 COST ITEM DASHBOARD

The Cost Item Dashboard slide-out panel shows multiple cost item affiliated graphs. These graphs let
you further analyze cost item past and current performance trends related to time-phased distribution,
current budget changes, value over time, completion progress indicators, and a CBS audit history log.
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3 . 3 COST ITEM SETUP

3.3.1 COST ITEM CREATION

While typically most of your structure imports from your estimating system, you may need to revise
the CBS to reflect the way the work will be performed in the field. You may also encounter contract
changes or new work. To accommodate these needs, you can add, edit and arrange cost items as
needed.

If you need to build additional structure from scratch, you can create new level one cost items as
needed. If needed, this would allow you to create an entire new structure from scratch on a blank
project, giving you the flexibility to create a complete project structure within Control.

The cost item window includes a section where you can add multiple cost items. Newly added cost
items become positioned at the bottom of the CBS hierarchy. As part of the cost item creation process,
you can quickly create multiple cost items and then click Save when you are finished.

The following steps walk you through how to create cost items.
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CREATE NEW COST ITEMS

1. From the project’s home page menu, select Control.

2. Select Control > Workspaces on the left side of the Main menu.

3. Select the CBS tab to open the CBS register of your project.

4. Select the Add Cost Item icon on the top left of the page.
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5. Select Create a new blank cost item, then click Yes.

l This opens the Cost item details page where you can enter the pertinent information for
the new cost item
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6. On the Details tab, enter the following information:

l Description: [enter a cost item description]

l UoM: Lump Sum

l Cost Segment: Direct Cost

l Allow as-built: All

7. Click Add new cost item on the new cost item list in the left-side panel to add an additional cost
item.

8. Enter the following information:

l Description: [enter a cost item description]

l UoM: Lump Sum

l Cost Segment: Direct Cost
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l Allow as-built: All

9. Click Save.
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l Your new cost items are now created in the CBS

CREATE A NEW SUBORDINATE COST ITEM

1. From the project’s home page menu, select Control.

2. SelectWorkspaces.

3. On the CBS tab, scroll down and find a superior cost item in the Tasks data block where multiple
subordinate cost items exist.

4. Right click the superior cost item to bring up the options menu.

5. Select New Subordinate Cost Item to create a subordinate cost item to your superior cost item.

6. Select the Inherit data from parent cost item radio button, then click Yes.

l This allows you to copy the parent item’s information and avoid entering common
information a second time.
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You can create a new cost item in two ways:

l New Cost Item: This creates a new cost item with the next available
number at the current hierarchy level that you selected. Example: If you
select 1.6 it creates 1.7 if available.

l New Subordinate Cost Item: This creates a new subordinate cost item with the
next number available one level lower than the current level selected. Example: If
you selected 1.6, it will create the next 1.6.x where X is the next number available.

3.3.2 REQUIRED COST ITEMS

The Required cost items feature lets you create standardized or commonly used cost items at the
organization level, and then add them at the project CBS level. Changing any of the required cost items
at the organization level, such as the account code or UOM, also updates the cost items at the project
level.

When required cost items are added in Settings > Control > Others > Required cost items, the feature
provides standardization across all projects for those cost items that are commonly used.

This feature can be a substitute for copying and pasting cost items from one project into another and
ensures the same WBS phase code is being used regardless of the project a team member is working
on.
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3.3.3 DESIGN TOTAL QTY AND MAN-HOURS COLUMNS
IN CBS

Control displays the sum of the Forecast T/O quantity from the associated InEight Design items against
the attributed cost items. You can compare the Design total quantity and Design total man-hours to
the Forecast (T/O) quantity and Forecast hours columns, to make sure the values match up with what
is in Design.
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3.3.4 CREATE COST ITEMS IN INEIGHT CHANGE

You can also create cost items with resources in Change, and then have them created in Control upon
the approval of a contract adjustment. This reduces the amount of extra steps needed for creating cost
items in multiple areas.

Creating cost items in Change is performed by first creating an issue with your newly created cost
items, then executing your change order.

In Control, go into the Change Register and click on the change order to review the new cost items that
originated from Change.
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Revise the change order to make any further adjustments, such as associating pay items to your cost
items. Notice how the cost category assignments have all come over to Control that originated from
the change document.

Approving the change order creates the new cost items with the resources specified in Change, and
places them within the hierarchy specified in the contract adjustment, and if none is specified, then
they are placed at the bottom of the CBS.
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3.3.5 COST ITEM ARRANGEMENT

As the project progresses, you may need to rearrange cost items to accommodate project changes.
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MOVE A COST ITEM

1. On the CBS register tab, highlight the new subordinate cost item you created.

2. Right click on the cost item of your choice.

3. Click on Adjust CBS position.

4. Click and drag your cost item and move it directly under the superior cost item you want it to go
under.

5. Click Save.

l Your subordinate cost item should now be moved.

3.3.6 VIEWING THE CBS GROUPED BY COLUMN

Navigating throughout the CBS can be difficult and tedious when searching for specific information, as
data is spread across the entire CBS. Jobs can contain a lot of various data, and can be difficult to sort
through and view the desired information, especially in a list format. The CBS Group by feature allows
users to display the CBS in groups of "like" information. This feature allows you to drag and drop
columns that you are interested in grouping.

The Group Columns by feature is invoked by selecting the Group Columns icon in the upper the right
set of action icons, which opens up a gray bar above the CBS data blocks. Clicking the Group Columns
icon a second time disables the feature.

Once you navigate away from the page, the groupings will still exist. Selecting a different view will
retain the same groupings as well.

CBS GROUP BY COLUMN

1. On the CBS register tab, select the Group Columns icon on the right toolbar.

2. Drag the column header of a column and drop it into the grey bar area.
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3. Drag and drop a second column header into the grey bar area.

4. Your project cost items are now grouped by both columns.

3.3.7 COST ITEM DELETION

You can delete one cost item or multiple cost items by selecting the cost items, right clicking, and then
selecting Delete Cost Item.

When deleting cost items from the CBS, deleting the forecast, clearing out the account code, or
changing attributes to delete a cost item is not necessary.
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You can also select a cost item and click the Delete icon on the left toolbar.
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A cost item must meet the following conditions to be deleted:

l Total Cost (To Date) = 0, MH (To Date) = 0, Eqp Hours (To Date) = 0, Qty Complete
(To Date)=0

l C B-Total Cost = 0, C B-Total MH = 0, CB-Total Quantity = 0, C B-Qty Remaining = 0

l If the cost item is a parent item, all the subordinate cost items will also need to be
checked to see if they can be deleted

If you are deleting multiple cost items and do not meet the following conditions for deletion, a
downloadable file appears that lists all of the validations and why they failed.

3.3.8 COPYING COST ITEMS WITH RESOURCES

You can copy and paste entire cost items with resources from the CBS tab to any cost item you select.

When you copy a cost item, you cannot copy the current budget because the current
budget must be approved in a contract adjustment or budget move.

Follow the step by step to copy a cost item.

COPY AND PASTE COST ITEMS

1. From the CBS tab, select one or more cost items that you want to copy that contain a resource.

This can be checked in the Resources column. If the cost item has a 1 or higher,
then a resource is attached to that cost item.

2. Right-click your selected cost items.

3. Hover over the Copy selection and select Copy cost item.
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4. Right-click on another cost item in the CBS tab.

5. Hover over the option Insert copied cost items. You have three options as to where to place the
copied cost items:

l Insert above

l Insert below
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l Insert as a subordinate

You can also view the pasted cost items in the Resources tab of the Cost item details slide-out panel.

3 . 4 COST ITEM EXCEL IMPORT

When you need to add multiple cost items to your project, adding them manually can be tedious and
time consuming. To save time, if you can export your cost items to Microsoft Excel (e.g., export to Excel
from your estimating software), you can import them into Control, allowing you to update your
estimate in bulk, without needing to manually enter data into individual cells.

Click the Import icon on the right toolbar of the Control >Workspaces page to go access the Excel
import feature.

The table below indicates the data you can import into Control from Excel.
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Data Type CBS Columns

Tasks CBS position, Description, UoM, code-related fields, user-defined fields, other
settings found in the Task details data block in Control.

Schedule Schedule ID, schedule dates, Scheduled, Schedule plug days, Plug days,
Cost curve, Roll up schedule

Current
Estimate

CE final MHrs, final costs, total equipment hours, MHr/Unit, units/MHr,
equipment hour/unit, labor cost/MHr, equipment cost/MHr, Secondary Qty,
Scales 1, 2, and 3.

Cost
Categories

Total and unit costs.

When you click on the Import icon on the CBS tab of the Workspaces page, you have three import type
options. You can import cost items, actuals, or a schedule.
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After you make a selection, the Import CBS data window opens.

Title Description

1 Import from
Excel

You can either drag and drop or browse to the file to import. Microsoft
Excel files (.xlsx,, .xls) and Comma Separated Value (.csv) files can be

Overview – Import CBS Dialog box
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Title Description

imported.

2 Options You can add new cost items and update cost items that already exist in
the project, choose to only update existing cost items, or only add new.

3 Cost item
matching
criteria

When adding and updating cost items, the structure in the spreadsheet
you are importing from may be in a different order than the structure in
Control. By specifying a code for matching your cost items, the import
routine will know which cost items in the spreadsheet are new when
adding new items, and which cost items to update with data from the
spreadsheet when updating cost items.

4 Information
message

This information provides a description of available functionality and
instructions for proceeding to the next step.

Overview – Import CBS Dialog box (continued)
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Clicking Next opens the Map columns dialog box, where you can map your Excel columns to the
appropriate column in Control.

Title Description

1 Template After you map the import file columns to the CBS columns in Control, you
can save your settings as a template for future use. This is helpful when you
need to make scope changes or updates on a regular basis.

2 Control
field

The names of the column headers in Control that you can map your data to. 

3 Mapped A green checkmark indicates the column in your import file is mapped

Overview – Map Columns Window

Page 114 of 572 InEight Inc.  |  Release 25.5

3.4 Cost Item Excel Import Control User Guide



Title Description

correctly to the CBS column. The Green key indicates the matching code
you specified is locked.

4 File
columns

The names of the column headers in your import file that you can map to the
CBS columns in Control.

Overview – Map Columns Window (continued)

3.4.1 FORECAST EXCEL IMPORT

When manually importing cost items by either updating existing cost items or importing new cost
items, you can also import forecast values via Excel. How the fields are mapped in Excel determines
which CBS forecast columns are populated.

Examples of some forecast columns that can be mapped via the Excel CBS import cost item process
include, Forecast total cost, Forecast total MHrs, and Forecast total unit cost. Cost categories can also
be selected for importing into Control.
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3.4.2 SPREADSHEET RULES

For the import process to work correctly, the items in your Excel spreadsheet must be formatted in a
certain way so that Control can recognize the items. The following table indicates important
spreadsheet rules to follow to make sure your data imports successfully.

Attribute Rules

Import Reads the first worksheet within the referenced workbook.
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Attribute Rules

function

First row of
data

Considered to be the header row of the data. This imports as titles which are
referenced during the mapping process.
The import stops reading headers if it encounters a blank header cell.

Numbers Needs to be the actual number, and not the summation of cells.
Values cannot contain the $ symbol or other currency symbols.

Second row
of data

Considered the first row of data to be imported.

If you make changes in the spreadsheet, you must save the spreadsheet before importing
(only saved data will be imported).

Below is a list of items to be aware of during the population of the import template.

1. The Excel file should not be open while simultaneously using the import wizard.

a. If there are any edits made to the spreadsheet, it must be saved and closed prior to
importing.

2. CBS positions cannot be duplicates. They must be unique to each cost item.

a. The system will show an error if there are any duplicates.

3. The WBS phase codes are not required during the import but must also be unique per cost item.

4. Cost categories are spelling and case sensitive, and must match directly to the cost categories
spelling.

a. The cost categories list can be exported from the import wizard.

5. The Excel sheet cannot contain any blank cells during the import. Blank cells show an error and
cause the import to stall.

6. Make sure any blank columns from an export file are removed before importing again.

7. Date formats must match spreadsheet date formats. The Import Wizard will prompt you to
chose a date format used in the spreadsheet.

a. The Import wizard will prompt you to chose adate format prior to initiating the import.
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3.4.3 BEST PRACTICES AND RECOMMENDATIONS

1. Use WBS phase code as the matching criteria for updating existing items.

a. WBS phase code are tied 1:1 for each cost item. The CBS position can be changed,
but the WBS phase code remains the same regardless of CBS position.

2. Set up the views for exporting of data to match the import template created. Views are
customizable for flexibility in what is being imported/exported.

3. Import template mapping is unique to each individual user. Master mapping cannot be set at a
global level. It is recommended to provide users with a step-by-step import mapping document
to set up data mapping initially during the on-boarding of InEight.

4. When exporting data in Control, current system drops trailing zeros on CBS positions. Example:
1.10 exports as 1.1.

a. One way to get around this is opening data as a CSV file in Excel.

5. Once you have downloaded the export file, proceed to the following steps.

l Open blank Excel sheet

l Navigate to Data tab

l Click Get Data > From File > From Text/CSV

l Choose downloaded export file

l Click Import

l Click Load

Your data will now be imported into the sheet where updates are made. Once you have completed
your updates, you may save and re-import the same file.

3.4.4 CBS HIERARCHY

If you select CBS position as the matching criteria for the import, the import routine recognizes the
hierarchy of your structure by the numbering of the codes.
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After the import is complete, if the CBS position for the new cost items match existing cost items in the
CBS, your new CBS cost items will import as you have defined them. The existing CBS cost items will
shift down and be relabeled to match the next corresponding number.

When adding new cost items to an existing CBS position, a warning message displays informing you the
CBS positions you have picked already exist. The message then asks you to confirm if you would like to
continue with this import.

3.4.4 .1 CBS PREDICTIVE HIERARCHY

New cost items created via the import process automatically adjust the CBS structure hierarchy to
match your import as needed and predict the movements in the current hierarchy, and the hierarchy
that is being added via the Excel import.
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For example, you have three cost items that you want to import, as shown below. Positions 1 and 1.1
already exist in the CBS, and position 2.1.2 is new.

The import process imports Excel CBS positions 1 and 1.1, and places 2.1.2 at the bottom of the
hierarchy.

The following steps walk you through the import process.
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The following steps are only applicable when importing new cost items.

IMPORT CBS DATA

1. From the Control > Workspaces page, on the CBS tab, click on the Import icon on the right
toolbar.

2. Select Cost Items when the Import CBS data window appears.

3. Click on the Browse button to select a file to import.
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4. Browse to the Excel file you wish to import.

l The file and its location should be indicated by your instructor if you’re in a classroom
setting, otherwise you can select one of your own

5. Select the import file and click Open.

l The import file is now selected
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6. Under Options, select New Items (if not already selected).

7. For the Cost item matching criteria, select Cost items and cost item attributes from the drop-
down list.

8. Click Next.

l This takes you to theMap columns window

l Note that the File columns fields are set to Blank-do not import by default

9. Under File columns, click in the field on the same row as the UoM CBS column, then click
again to expand the drop-down list for that field.
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10. Select UOM from the drop-down list to map the UOM column in the Excel file to the UoM CBS
column.

11. Repeat the selection process to select the appropriate File columns to map to the following CBS
columns:

l CBS position

l Description

l WBS Phase Code

l Forecast (T/O) quantity

l CE Final MHrs

l CE final cost
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l A green check mark indicates successful mapping of your file columns

12. To save these settings for future use, click in the Template field and type Steel Structure
Template.

13. Click the Save icon to save the template.

14. Click Next.
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l A progress bar appears informing you the import is in progress

l A prompt appears, indicating the project will be disabled from use during the importing
process

15. Click Import now.

l A prompt appears informing you that the project is currently locked for the importing
process
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l Once completed, you will receive the following prompt, informing you the data imported
successfully

3.4.5 RESOLVING IMPORT ERRORS

When conducting the import, you may run into errors. This will be indicated when you attend to run
the import routine by the following prompt:

The prompt window includes a Review errors and items for import link, which you can click on to
resolve any issues prior to final import. An error resolution page opens where you can identify and
resolve your errors.
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There can be situations where the cost item Excel import process will successfully process
some cost items, but fail to import other cost items. In this situation the process will
show as failed. For example, you imported 100 cost items, and 90 of the cost items
import successfully. There are 10 cost items that did not import successfully. In this
scenario you would need to resolve the import errors.

3.4.6 EXCEL IMPORT FOR COMMITTED COST

Importing committed cost mainly helps to keep track of subcontract cost items where you would have
a purchase order that would drive all of your cost.

You can import two types of committed cost:

l Open/Remaining Committed Cost

l Total committed cost

Open/Remaining Committed Cost is the cost you still have left to pay on the purchase order. Total
committed cost is the total purchase order amount for the purchase order.

Committed cost were previously located in different areas of Control. You can have Open and Total
committed cost columns in your CBS. The same columns are also in the Commitments tab of the Actual
Details Slideout where you can make manual edits to the committed costs. Columns in CBS for Open
and Total committed costs only reflects the manual edits you made in the Actual Details Slideout. Open
and Total committed costs are also shown in cost item details slideout cost categories tab.

You can import committed costs using the import icon on the CBS and selecting Commitment.
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3.4.6 .2 GENERATING THE COMMITMENT COST EXCEL
SPREADSHEET

To bring in committed cost from the excel import, you first need an existing value in your CBS that
matches the Excel Spreadsheet value. This can be one of two options:

l WBS phase code

l CBS position

You will also need the Type of committed cost you want to import, either Open/Remaining Committed
Cost or Total commitment.
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Open/Remaining Committed Cost and Total commitment types need to be spelled exactly
word for word as it is written in the screenshot. If you shorten any of the wording in the
Type column, the system will not accept the import and you will receive an error.

Each Type of committed cost has to be its own line item on the Excel spreadsheet. You can do multiple
transactions for one cost item, but only one commitment type per line item. if they are different types,
you need to separate them out into different line items.

Each column needs to be created and defined if you are to do a Commitment Excel Import. You must
include a Cost column and a Category column as shown in the above image.

Open/Remaining Committed Cost should never be greater than your total.
Open/Remaining Committed Cost cost should either be equal or less than the Total
commitment cost.

3.4.6 .3 IMPORTING COMMITMENT DATA

Follow the step by step to Import commitment data.
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IMPORT COMMITMENT COSTS

1. From Control's CBS tab, select the import icon. Then select Commitment.

2. After you have created your Excel spreadsheet with your commitment costs, select Browse from
the Import from Excel window. Then select the Excel file name you saved.

3. After you return to the Import commitment data window, under the Options section, select the
Import type drop down arrow. If it is not already selected, select the Commitment values
option.
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4. Select the Cost item matching criteria drop down and choose either WBS phase code or CBS
position.

5. After selecting the drop down options, select Next in the bottom right corner.

6. From the Map columns screen, select the columns you are importing from your Excel
spreadsheet.
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7. The Control field should match the File columns. For example, Commitment type in Control field
should match Type in File columns as shown below. Once done, select Next.
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8. If there are no errors in the mapping stage, you should see a green check mark on the next
screen, indicating everything is ready to be imported.

If you receive any errors in the mapping stage, you will receive an error with a download option
to download a word document that shows you all the errors.

9. Click Next and then select Import now. This will create a line item in the Import history section
of the Audit Log tab.

10. From Control, go to the Audit Log tab. Then select Import history. Hover over the yellow triangle
to view the information on the pending import item.
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After the pending import is Complete, the committed costs populate in the Cost
Categories Details tab, as well as the CBS. It the costs also appear in the
Commitments tab from the Actuals Details Slideout and populates into the new
Open and Total cost committed columns.

If the imported commitment costs fail to import, the Aduit Log Import history would show that the
import failed completely.
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REVIEW

1. Which of the following is how can you identify a terminal cost item on the CBS register
page? (Select all that apply.)

a. The row is highlighted a different color

b. A symbol displays on certain cost item fields

c. The row is indented

d. The ‘Is Terminal’ column is checked

2. When moving a cost item to be above another cost item at the same level, which icon
should display when you drag and drop the cost item?

a. The one with a subordinate bar

b. The one with three equal bars

c. The one with an equal sign

d. The one with a plus sign

3. If you make changes to your spreadsheet, you must _____ the spreadsheet prior to
importing it into Control.

a. close

b. copy

c. save

d. refresh

SUMMARY

As a result of this lesson, you can:

l Explain the Cost Breakdown Structure and its purpose

l Create, arrange and delete cost items

l Import cost items
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After completing this lesson, you will be able to:

l Manage estimate resources

l Gain visibility into resource billing rates
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4 . 1 INE IGHT CONTROL WORKFLOW – COST
ITEM MANAGEMENT

4 . 2 EST IMATE RESOURCES

InEight Control refers to labor, equipment, material, installed equipment, and supplies as resources.
You will use these resources as the basic building blocks for detailing the estimated costs which creates
your budget.

The Project library contains all resources used to estimate costs for the cost items within the CBS.

Most of your CBS cost detail will import directly from InEight Estimate, but you may need
to create additional cost item detail for conforming your budget and creating change
orders.

Estimate resources in the Project library are organized into seven resource types:
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Resource Description

Labor The human resources that do the work, classified by trade (e.g., pipefitters,
electricians, iron workers).

Construction
Equipment

Owned construction equipment.

Rented
Construction
Equipment

Construction equipment rented from a third party.

Installed
Material

Materials that will remain installed on site after the project is completed,
(e.g., concrete, piping, aggregate).

Installed
Equipment

Equipment that will remain installed on site after the project is completed,
(e.g., boilers, heat exchangers, vessels, cooling towers).

Supplies Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types
(e.g., dump fees, hauling charges and equipment rented by the month, and
subcontracted work).

Estimate resources are the equivalent of the Resource Rate Register in InEight Estimate.

You can access the Estimate resources page from the home page slide-out menu:

1. FromMenu > Control > Workspaces > Project Library and then selecting the Estimate Resources
tab.
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2. Another way to access Estimate Resources is from the CBS page. Highlight a line item and
hovering over the number in the Resource column for that cost item, as shown below.

l As a result, the Resource Summary window appears, where you can select Resource
Library to open the Project library
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Resource Description

1 Resource Type The seven resource categories for organizing your resources.

2 Resource
Code

Alphanumeric label to quickly identify resources.

3 Description Additional label to provide more resource detail.

4 Default
Quantity

The quantity the resource will have by default when it is assigned to a
cost item.

5 Unit of
Measure

The unit the resource is measured by.

6 Utilization
Count

The number of units of that resource being used in the project.

7 C E-Unit Cost
(Scale 1)

The resource’s rate per unit.

8 Cost Driver Tells you what drives the cost for that resource when it is assigned to a
cost item (cost, quantity, or fixed).

9 Account Code Code assigned to resources for accounting and benchmarking
purposes.

Overview – Estimate Resources

You can add additional estimate resources to the library by selecting the Add estimate resource icon.  
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l The Add labor estimate resource screen opens.

To add a resource to the correct resource type, make sure you are on the appropriate resource type
tab (Labor, Construction Equipment, etc.) before clicking on the Add icon.
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4.2.1 RESOURCE BILLABLE RATES

Within the Resource Rates tab, you can import, modify and add billable rates to estimate resources.
This is particularly helpful on time and material or cost plus contracts to drive accurate invoicing.

Resource billing rates are also used for Forecast final revenue, as it will rely on the billing rates of the
resources on the cost items that are assigned to pay items. These values generate revenue forecast for
cost items that are associated to a cost plus or time & material (billing method) pay item.
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CREATE A LABOR RESOURCE

1. In the Steel Structure Training Job, selectMenu > Control > Workspaces and make sure you are
on the CBS tab.

2. Hover over the number under the Resource column of the Task Details data block for a
subordinate cost item.

3. Select Resource Library from the Resource summary window.

4. With the Labor resource type selected, click on the Addestimate resource icon. 

5. Fill in the blanks with the following:

l Code:  Lab001-XX (XX your initials)

l Description: Welder

6. Scroll down to Default Quantity and change the value from 0 to 1.

7. Select the Resource Rates tab.

8. Select the Labor cost category and type 50.00 in the Scale 1 unit cost.

9. Scroll down to the Resource Rates and enter in values for the following Billing Rates:
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l Scale 1

l Scale 2

l Scale 3

1. Click Add to add the new resource to the register of estimated resources.

Now that you have created a resource, you will add this resource to the Erect Steel – Heavy cost item
in your Project.

ADD RESOURCE TO JOB

1. From the Steel Structural Training Job, make sure you are in the CBS.

2. Right click on your subordinate cost item.

3. Select Cost item details.

4. Select the Resources tab.

5. Select Add estimate resource.

6. Click Add.

4 . 3 COST ITEM DETA ILS

The cost item detail slide out panel contains many different fields to edit and enter cost item-related
information. To access this screen, select the cost item and right-click to open the menu.  Select Cost
item details. There are four tabs to select from:

l Details tab

l Attributes tab

l Cost Categories tab

l Current Estimate Resources

l Forecast Resources tab
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All editable cells in the cost item detail slide-out panel are single click.

4.3.1 DETAILS TAB

The Details tab contains the values and settings related to the cost detail of the item.

Below is an explanation of some of the key settings on the Details tab.
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Term Function

Cost source Indicates how costs are entered on the cost item.
l Detail – Resources and duration defined to determine costs
l Plug – Unit and total costs entered at the cost category level

Live
Forecast
method

Determines the Forecast Method for the cost item. (See Lesson 9 - Forecasting
for more Forecast Method details).

Cost
segment

Categorizes whether the cost item is a direct or indirect cost.
l Direct Cost – costs that directly pertain to the deliverables (pay items) of
the job

l Job Overhead – Overhead costs associated with running and managing
the job (e.g., management, jobsite facilities)

l Business Overhead – Overhead costs associated with running the
business (not directly related to running the job)

l Subcontract – subcontract associated costs

Allow as-
built

Determines whether you can enter actual costs and quantities for a cost item.
l None – Cost item does not accept cost or quantities. This is typically seen
in Superior cost items

l All - Allows a cost item to accept both direct costs and quantities
l Quantities – Cost item only accepts quantities
l Cost – Cost item only accepts costs, man hours, and equipment hours.

Quantity
driver

Superior cost item will have the Forecast T/O qty update when the superior cost
item (parent cost item) receives an update. The change to the qty will be the
original value multiplied by the same multiplier that was applied to the superior
cost item.

For example: if the superior cost item qty doubles, the item with Superior CI will
double as well. Cost items with Fixed as the selection will not be affected by
changes to the parent cost item.

Cost item
contribute
quantity

Checked cost items will have the Forecast T/O qty roll-up to the parent cost
item if the UoM on both of the items are the same.

Pay item
contribute
quantity

Checking this box lets you choose which cost items contribute to the Pay item's
forecast (T/O) quantity and can affect earnings rules for the associated pay
item. This field is only visible if you have the Enable Pay item Forecast (T/O)
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Term Function

quantity rollups setting turned on in Settings > Control > Revenue.

4.3.1 .1 PAY ITEM CONTRIBUTE QUANTITY

The Pay item contribute qty function works only when the Pay item Forecast (T/O) qty rollups toggle is
set to On in Settings > Control > Revenue. If you have a unit price pay item, its forecast (T/O) quantity
is the sum of all the contributing cost items forecast (T/O) quantities.

This function lets you define which cost items roll up their quantities to a pay ite

In the CBS, you can quickly modify the pay item contribute quantity either in bulk or by selecting a
single cost item.
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Selecting the Pay item contribute qty check box updates both the Current forecast (T/O) and the
Update earning rules, only if Earnings rules are set to calculate based on Forecast (T/O) qty value in Pay
items.
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Deselecting the Pay item contribute qty check box in the CBS also updates both the Current forecast
(T/O) and the Update earning rules.

4.3.2 ATTRIBUTES TAB

The Attributes tab allows you to tag the new cost item with user-defined entries.
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1. User-Defined Fields –free text fields that you can type values into manually

2. Tags – Many of these fields are validated fields (known as tags), meaning you can choose from
options in a drop-down list

Some of these tags and their drop-down values are defined at the organizational level and others are
customizable via the Project Settings under the Configure tag list value.

4.3.3 COST CATEGORIES TAB

The Cost Categories tab allows you to view your current budget, actuals, live forecast and forecast
remaining cost, broken down into more detailed cost categories (e.g., labor, construction equipment,
supplies, materials, etc.).

The header in the Cost Categories tab shows the % Complete, Live forecast method, and the Latest
actuals in forecast values.

InEight Inc.  |  Release 25.5 Page 153 of 572

Control User Guide 4.3 Cost Item Details



If you have the correct permissions, you can change the Live forecast method. You can also change the
view of the Cost Categories values to show either Total or Per Unit cost.

This is also where you enter the estimated cost into the different cost categories for the plug cost
source.

You can expand the labor category and enter your cost at the appropriate level (e.g., Labor Base
wages). You need to enter the cost under the appropriate level of the category.  For example, if you
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enter the cost at the Labor category level, the cost will appear in Undefined Labor level because you
did not enter it at a specific sub-category level.

The following Step by Step walks you through adding costs to the Cost Categories tab of the Cost item
details slide out panel.

ENTER COSTS IN COST CATEGORIES

1. Within the InEight Control main page, on the CBS tab, right click on the cost item you created.

2. Select Cost Item Details to open the Cost item details slide out panel.

3. Click on the Cost Categories sub tab.

4. Under the Current Estimate column, expand the Labor cost category.

5. In the Current Estimate column, enter a value in the Current Estimate column for Labor Base,
then press the Tab key.

4.3.4 CURRENT ESTIMATE RESOURCES TAB

The Current Estimate Resources tab is where you can view and manage the CE resources for terminal
cost items.

From the Current Estimate Resources tab you can view and manage:

l Cost item details

l Current estimate resources

l Productivity and overall settings
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l Resource details
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To see a total sum of the resources in Current estimate resources, you must have the
Cost Source set to Detail.

When the cost item’s cost source is set to Plug, you will not use the Current Estimate
Resources tab. Instead, costs are “plugged” or entered directly into cost categories on the
Cost Categories tab of the cost item.

4.3.4 .2 COST DRIVER

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
their default cost driver is CI Duration, meaning their costs are driven by the duration of the cost item.
If you want a resource to only be assigned to a specific cost item or work activity for half the time, you
can change its quantity to .5 and it will be driven by half of the cost item’s hours.
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Updating the total quantity of a resource with CI quantity as the cost driver will not auto-
update the hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.
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If you change the Cost Driver to CI Quantity, the fields below will not be editable. It
causes the adjusted duration to become zero or read-only. However, it can be editable if
it does make a cost impact.

With CI Quantity as your cost driver for your resources, you can adjust the Work Hours manually,
where previously that column was read-only. For example, perhaps you want your Laborer to work
specifically 80 hours.

The Forecast (T/O) Qty is very significant when it comes to quantity driven resources. It determines
how the cost is driven and what affects the cost of that specific line item.
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For example, perhaps there is a scope change and you need to change the Forecast (T/O) Qty from 700
to 350.

A screen appears to have you choose whether it will affect the C E-Final Unit Cost or CE-Final Cost.
Typically, you will keep the Unit Cost constant and adjust the Final Cost.

Notice your Welder’s work hours adjusted from 80 to 40 because they are driven by the Forecast (T/O)
Quantity of the cost item.
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If the Cost Driver is set on Fixed, you can only update the resource’s hours by typing into the resource
itself and updating the work hours directly.

Many of the numbers are tied to equations under the Productivity resources below.  If you edit the
numbers, it will have an impact on the resources depending on the cost driver.

4.3.5 FORECAST RESOURCES TAB

The Forecast Resources tab is where you can view and manage estimate resources assigned to a cost
item.

From the Resources tab you can view and manage the:

l Forecast details live forecast method

l Add new resources and adjust duration-driven resources by changing their productivity

l View and adjust resource rates of assigned resources
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Like the Details, Attributes, and Cost Categories tabs, you access the Forecast Resources tab from the
Cost Item Details slide out panel.
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The Forecast Resources tab shows as an accordion menu where you can select a specific drop down
menu you want to view.

4.3.5 .3 PRODUCTIVITY AND OVERALL SETTINGS

If the resource’s cost driver is set to CI Duration, you can change any of the values on the Productivity
tab under Adjusting duration driven resources below, and it will change the work hours of your
resources without you having to do the math yourself.
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4.3.5 .4 RESOURCE DETAILS

Resource Details shows the unit cost category breakdown of the selected resource listed above. The
Resource rates tab expands to a unit breakdown on a selected item under resources. It is fully editable
if you have the right permissions to do so.
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ORPHAN INDICATOR

If you change the resource rate of one of the assigned resources, then a triangle will appear.  The
triangle is an orphan indicator.  This means a value associated with this resource does not match the
resource’s value in the Estimated resources in the Project library. When you hover over the triangle, it
will give you a summary of all the differences between the library value and the orphaned value. 
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This is shown in case you want to change the values back to match the library. If you change the values
back to match the library, the triangle will disappear.

4.3.5 .5 COST ITEM MAN-HOURS

Aside from on the Cost Estimate Resources tab, you can also define productivity on the CBS register
page. The following steps walk you through how to add the planned man-hours for a cost item from
the CBS register page.

DEFINE COST ITEM MAN-HOURS

1. On your CBS register tab, make sure the Current estimate data block is displayed on the page, by
selecting the CE + CB viewset.

2. Under the CE Final MHrs column, enter 16,000 for a cost item, then press the Tab key. Note – If
the cost item is a “detail” cost source you will not be able to manually adjust this field. 
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4.3.6 ISSUE TAGGING IN THE CBS

You can associate an issue to a cost item in the CBS. Issue Ids in Change have a hierarchy of issues and
subordinate issues. Associated an issue to a cost item applies to parent-level issues. Child issues take
on the cost item of the parent issue.

When you click in the Issue column, the Assign issue dialog box is shown. The list of issues originates
from the list of the issues in Change.
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The Assign issue dialog box does not contain the full list of Issues that Change contains.

Page 168 of 572 InEight Inc.  |  Release 25.5

4.3 Cost Item Details Control User Guide



If a parent issue in Change becomes a subordinate while you already have that issue assigned to a cost
item in the CBS, the cost item then changes Issue ID to match the parent item that the linked issue was
then relocated under. For example, if the parent issue ID was a 2 in Change and it was moved under
the parent issue ID 1, then the cost item previously linked to the parent 2 changes to the parent issue
1.

4 . 4 LOCK BUDGET

4.4.1 BUDGETS VS ESTIMATE

You can maintain an Original Budget, a Current Budget, and a Current Estimate, as is shown from the
CBS tab of the Control main page, using a custom data block.
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4.4.1 .1 ORIGINAL BUDGET

The Original Budget (OB) is a snapshot of the project plan in its original state, prior to execution. It is a
baseline used for comparison as the project progresses. You cannot edit your Original Budget values;
they are read-only in the CBS register, available for reference only.

Once set, the Original Budget never changes.

In the CBS register, you can find the OB values for man-hours, quantities, and costs.

4.4.1 .2 CURRENT BUDGET

The Current Budget (CB) is the project’s operational budget, including only project changes approved
through a controlled process. The Current Budget is therefore the sum of your Original Budget, plus or
minus any approved changes.

See the Change Management section for more details on managing and approving
budget changes.

In the CBS register, you can find CB values for planned, earned and forecasted costs, hours and
productivity.
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4.4.1 .3 CURRENT ESTIMATE

The Current Estimate (CE) represents the most up to date estimate of your work. You can update your
Current Estimate quantities, hours, and costs at any time in the CBS register, with no required approval
process or work flow.

You can use the Current Estimate as a sand box to build out change orders and do what-if analysis to
plan for potential changes, without worrying about affecting the Current or Original Budgets.

All editable cells in the Current Estimate CBS grid are single click.

4.4.2 LOCK BUDGET AND PRICE

When you first create your project, your cost breakdown structure is unlocked, meaning you can make
changes to your current estimate, but there is no locked down budget for tracking purposes. Your
Original Budget and Current Budget data blocks therefore contains no values.
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Locking your budget creates an Original and Current Budget based on your Current Estimate values.
Keep in mind that:

l Your Original Budget cannot change

l Your Current Budget can only change via approved change orders (see Lesson 7 – Change
Management)

l During project execution, you can compare your actual costs and man-hours to your Original and
Current Budgets to track you progress

In the CBS you can lock the budget by selecting Actions > Lock/unlock budget > Lock Budget or Lock
project budget and price.

The Budget Lock Status columns then changes to a locked symbol.
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In Pay Items, you can also lock your price and budget for pay items by selecting Actions > Lock/unlock
price>Lock Price or Lock project budget and price.

The Price Lock Status columns then changes to locked.

4.4.3 UNLOCK BUDGET AND PRICE

After you lock your budget, in rare instances, it might be necessary to unlock your Original and Current
Budgets, though this is typically not recommended. For example, after initial import of your estimate
into Control, you might need to make further adjustments to your cost breakdown structure to
conform your estimate to the working plan for the project. Normally, unlocking your budget is the
exception, not the rule.
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In Pay Items, like locking the budget for cost items, you unlock the price from the Actions menu.
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REVIEW

1. When you first import or create your cost breakdown structure, by default your budget
is:

a. Locked

b. Unlocked

c. Suspended

d. Auto-filled

2. Under the Cost Details tab, what are the three types of cost segments that you can
choose from?

a. Direct Cost, Job Overhead, Business Overhead

b. Detail, Plug, Quote

c. Superior, Subordinate, Terminal

d. Fixed, Superior CI

3. The Resources tab is where you can:

a. Adjust the unit rate of your project’s resources

b. Adjust Man-Hours

c. Adjust and add equipment costs

d. All of the above

e. None of the above

SUMMARY

As a result of this lesson, you can:

l Manage estimate resources

l Gain visibility into resource billing rates
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l Manage cost item details

l Lock the budget
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PROGRESS MEASUREMENT

LESSON DURATION:   60 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Define the measurements for analyzing the progress of a project

l Set up a Date Range for progress data

l Get Plan quantities, actual costs, and actual man-hours using the Sync feature

l Explain the settings used for managing progress data shared between applications

l Add and adjust actuals manually

l View actuals history
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5 . 1 INE IGHT CONTROL WORKFLOW –
PROGRESS MEASUREMENT

5 . 2 PROGRESS MEASUREMENT OVERV IEW

One of the standard forms of contract payment terms in the construction industry is based on the
value of specific contract deliverables. It is also based on the work completed during the previous
month towards those pay items. Throughout the life of a project, you will want to track the progress of
work completed.

It is important to identify and define a few key terms related to progress measuring, and to identify
how to utilize InEight Control as a tool for accessing and maintaining critical job factors.

5.2.1 BUDGETS VS ESTIMATE

Within InEight Control, you can maintain an Original Budget, a Current Budget, and a Current Estimate,
as is shown from the CBS tab of the Control main page by using a custom data block.
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5.2.1 .1 ORIGINAL BUDGET

The Original Budget (OB) is a snapshot of the project plan in its original state, prior to execution. It is a
baseline used for comparison as the project progresses. You cannot edit your Original Budget values;
they are read-only in the CBS register, available for reference only.

Once set, the Original Budget never changes.

Within the CBS register of InEight Control, you will find the Original Budget (OB) values for man-hours,
quantities, and costs.

5.2.1 .2 CURRENT BUDGET

The Current Budget (CB) is the project’s operational budget, including only project changes approved
through a controlled process. The Current Budget is therefore the sum of your Original Budget, plus or
minus any approved changes.

See the Change Management lesson for more details on managing and approving budget
changes.

Within the CBS register of InEight Control, you will find Current Budget (CB) values for planned, earned
and forecasted costs, hours and productivity.
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FORECAST (T/O) - CB QTY DELTA COLUMN

The Forecast (T/O) - CB qty delta column shows you the difference between the Forecast (T/O)
quantity and the current budget total quantity columns.

The calculation for this formula is [Forecast (T/O) qty] - [CB total qty].

You can filter on non-zero CBS records, which makes you aware to update either the Forecast T/O
Quantity or CB Total Quantity.
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5.2.1 .3 CURRENT ESTIMATE

The Current Estimate (CE) represents the most up to date estimate of your work. You can update your
Current Estimate quantities, hours, and costs at any time in the CBS register, with no required approval
process or work flow.

You can use the Current Estimate as a “sand box” to build out change orders and do what-if analysis to
plan for potential changes, without worrying about affecting the Current or Original Budgets.

Within the CBS register of InEight Control, you will find a wealth of columns for measuring and
analyzing your project progress. InEight Control uses its own terminology for these measurements that
match up well with common Earned Value Management terminology. Before comparing these terms,
the following section reviews some Earned Value Management basics.

5.2.1 .4 UPDATING FORECAST (T/O) QUANTITY

The different ways to update the Forecast (T/O) quantity include:
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1. Direct entry into data block.

2. Direct entry into Cost item details slideout.

3. Excel import.

4. Undo.

5. Copy/paste into data block.

6. Rolldown from assigned pay item (need to have this setting enabled).

7. Cost item API.

8. Selective import.

9. Rolldown from parent (Qty driver is Superior CI).

10. Rollup from children ( Contribute qty is checked).

UPDATING CE UNIT COST FOR CE TOTAL COST

When you update the Forecast (T/O) on both the CE and the Forecast, you are prompted to update
either the CE unit cost for CE total cost. You can also choose to update either the CE labor cost/Mhr or
CE total MHrs, and either CE construction equipment cost/hr or CE total equipment hrs (if applicable).

This will then update the Forecast values because Forecast is based off Remaining qty * selected unit
cost, and your Remaining qty will update with a Forecast (T/O) qty change. This also affects your %
complete (Qty claimed / Forecast (T/O) qty) which impacts all the earned value columns. It will also
update the Forecasted revenue values as well (based on the % complete).

ENSURING TOTAL QUANTITY ALIGNMENT BETWEEN CONTROL
AND PLAN

You can easily filter the Forecast (T/O) - Plan component qty delta column. There is also a menu option
in the Actions menu to update the Forecast (T/O) qty to match the Plan qty - Update Forecast (T/O) qty
with Plan component total qty

5.2.2 PLANNED VALUE (PV)

Planned Value (PV) are the costs and hours you have estimated and scheduled for the project. Think of
PV as your approved budget of scheduled items. In Control, your PV includes the following columns:
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l CE Total Cost

l CE Total MHrs

l CB Total Cost

l CB Total MHrs

5.2.3 EARNED VALUE (EV)

Earned Value (EV)Measures the amount of money you merit in return for the work performed up to
that point. You can use EV to measure how much of your planned costs and hours you should have
spent so far, according to the percent of work completed. It uses the below formula to calculate this:

Planned Value x % of work completed = Earned Value

In InEight Control, your EV includes the following columns:

l CE cost earned

l CE MHrs earned

l CB cost earned

l CB MHrs earned
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5.2.4 SCHEDULE PERFORMANCE INDEX

Schedule performance index (SPI) measures how close the work is being completed according to the
designated schedule. It is Earned value/Planned value, and is calculated as earned current budget
cost/CB planned value (to date)
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The SPI calculation uses the time phased budget values as planned values. To accommodate the time
phased budget values, the planned value includes the cumulative time phased budget planned value to
date.

5.2.5 ACTUAL COST (AC)

Actual Cost (AC) refers to the costs you incur when you perform the work.

In InEight Control, AC is known as Total Cost (To Date). In addition, InEight Control refers to actual
man-hours as MH (To Date).
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5.2.6 VARIANCE

Variance is the difference between EV and AC, expressed in the following equation:

Earned Value - Actual Cost = Variance

It indicates if you are performing better or worse than planned up to that point. InEight Control uses
the term Gain/Loss (G/L) rather than variance, including the following columns:

l CE actual cost G/L (to date)

l CE MHrs G/L (to date)

l CB actual cost G/L (to date)

l CB MHrs G/L (to date)

5.2.7 REMAINING

Remaining is a general finance term for money that is not yet used. InEight Control uses the following
terms:

l CE remaining cost

l CB remaining cost

These terms refer to a very specific relationship expressed in the equation:

Planned Value - Actual Cost = Remaining Value

In other words, it is the difference between what you originally planned and what you have spent so
far, to help you understand how much cost or how many man-hours you have left.
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The table below summarizes each EVM term with its equivalent term in InEight Control and what it
measures.

EVM Term InEight Control Term What it measures

Planned Value
(PV)

CE total cost
CE total MHrs
CB total cost
CB total MHrs

Budget of scheduled values

Earned Value
(EV)

CE cost earned
CE MHrs earned
CB cost earned
CB MHrs earned

Planned Value x Percent Complete

Actual Cost (AC) Actual cost (to date)
Actual MHrs (to date)

Actual/expended values

Variance CE actual cost G/L (to
date)
CE MHrs G/L (to date)
CB actual cost G/L (to
date)
CB MHrs G/L (to date)

Difference between Earned Value and Actual
Cost
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EVM Term InEight Control Term What it measures

Remaining CE remaining cost
CB remaining cost

Difference between Planned Value and Actual
Cost

The following displays Planned vs. Earned vs. Actual values within a custom data block of the CBS
register of InEight Control:

5.2.8 PRODUCTIVITY

If you are the contractor building a project, you will need to monitor the performance of your crews,
including how productive they are and how much they are being paid.

Productivity is a measure of effectiveness. The rate of output per unit of input. An example would be if
you have estimated that you can install a light switch in 1 hour and it takes you 1.5 hours you are not
being very productive. In InEight CB-PF is productivity and can be measured with the following
equation:
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5.2.8 .5 COMPENSATION FACTOR (CF)

Compensation is the amount of money paid to an employee for their hours worked. Compensation
Factor is a numerical value comparing the budgeted compensation to the actual compensation. An
example would be if you had budgeted using master electricians (making $35/hour) to install light
switches, but you actually used 2nd year apprentices (making $26/hour) where you would have a
compensation factor that is off. In InEight, Compensation Factor is displayed as CF (To Date). You can
calculate it as follows:

5.2.8 .6 LABOR EFFICIENCY INDEX (LEI)

Labor Efficiency Index (LEI) is a numerical value assigned to indicate the effectiveness of resource
utilization. You can calculate LEI using the following formula:

Labor Efficiency Index = Productivity x Compensation Factor

.90 = .67 x 1.35

If LEI is greater than 1, it means that you are using your resource effectively.

If LEI is lower than 1, it means your resources are being used poorly.

5.2.9 INEIGHT PLAN QUANTITY

The Plan component total qty column shows the sum of the component quantities from Plan and
Control and lets you update the Forecast (T/O) qty to match this value.
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Using the Install conduit cost item as an example, it is assigned to WBS phase code 1139 in the CBS.

In Plan, WBS phase code 1139 is assigned to components Conduit material with a quantity of 150 and
Install conduit with a quantity of 120.

InEight Inc.  |  Release 25.5 Page 191 of 572

Control User Guide 5.2 Progress Measurement Overview



In the CBS, the Plan component total qty for the Install conduit is 270, which is a total of the two WBS
1139 components in Plan.

The Forecast (T/O) - Plan component qty column is the difference between the Forecast (T/O) and the
Plan component quantity.
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5.2.9 .7 UPDATE FORECAST (T/O) QUANTITY WITH PLAN
COMPONENTS

The Update Forecast (T/O) qty with Plan component total quantity option located under the Actions
drop-down, copies the Plan component total quantity over to the Forecast (T/O) quantity. You can also
right-click in the context menu to see this option.

5 . 3 DATE RANGE SETUP

InEight Control gives you flexibility in the form of a Date Range option. The following Step by Step
walks through how the Date Range setup feature works.
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DATE RANGE SETUP

1. Click the View drop-down to change your view.

2. Select the Progress viewset from the View drop-down list.

3. In the Actuals data block, select the left calendar field on the date range chooser and choose the
first day of this month.
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l To manually select your date range, click into the date cells along the header of the Actuals
data block and select your desired to and from dates

4. Select the right calendar field on the date range chooser and select the last day of this month.

5. Select the calendar icon.

6. Select Last month end from the calendar.
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l To select your date range from the pre-set list, click on the calendar icon within the
Actuals data block header and select the desired date option

Both week and month end date rules are determined during project setup within
the Fiscal Calendar setting. (See lesson 12.1 Project Settings on page 519 for more
information.)
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5 . 4 MANAGE ACTUALS

In Control, you can choose from four methods for tracking actual values:

l Sync – Lets you connect directly with other systems to update data in real time.

l Import – Allows you to upload spreadsheet data.

l Manual entry – You can input data directly into the system.

l API – Allows you to connect data from external sources, such as an ERP.

These methods help ensure that project records are accurate and up to date. The following topics
provide more details on methods for managing actuals:

Actuals by Sync

Actuals by Import

Actuals by Manual Entry

Actuals by API

5 . 5 ACTUALS BY SYNC

Update Control data in real time by connecting with InEight applications and other external systems.

5.5.1 SYNC QUANTITIES

A quantities sync lets you to bring actuals from other InEight applications into Control. Quantities are
brought into Control through a Get Quantities sync. The Actual qty (to date) column is updated when
the sync is complete.
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Sync operations are accessed from the Actions menu in the CBS.
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PERFORMING A GET QUANTITIES SYNC

1. From the Actions menu, choose Sync > Get quantities.

2. Choose the time period for the sync (Through previous pay period or Job to date).

3. A status message notifies you that the sync has initiated.
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5.5.1 .1 TYPES OF GET QUANTITIES SYNCS

Depending on your project configurations, the Get Quantities sync can bring in values from InEight
Design, InEight Plan, or InEight Contract. Each of these applications tracks quantities differently,
depending on its role in the project lifecycle.

InEight Design

In InEight Design, engineering deliverables are broken down and tracked as scope items. As work on
scope items is completed, team members can claim partial or total quantity values. Scope items are
linked to cost items through the WBS phase code. As a result of a Get Quantities sync, scope item
quantities update the actual quantity for their associated cost items.

InEight Plan

Quantities from InEight Plan represent completed progress in the field. Quantities can be captured
directly in the Quantity Tracking module, or they can be captured through approved daily plans from
InEight Progress. Components are linked to cost items through the WBS phase code. As a result of a
Get Quantities sync, component quantities update the actual quantity for their associated cost items.

Page 200 of 572 InEight Inc.  |  Release 25.5

5.5 Actuals by Sync Control User Guide



InEight Contract

Quantities from InEight Contract represent completed progress associated with a third-party contract.
Contract line items can be broken down into schedule of value items to track field progress. These SOV
items can be claimed directly in InEight Contract, or they can be claimed as contract components in
InEight Plan. SOV items are linked to cost items through the WBS phase code. As a result of a Get
Quantities sync, SOV quantities update the percent complete and actual quantity for their associated
cost items.
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To update complete from InEight Contract, you must enable the settings for the project in Control >
Project Tracking > Actuals. Switch the Update % complete from Contract toggle to On.

After the Update % complete from Contract setting is enabled, select from the Calculate percent
complete for individual cost items as a percentage of drop-down list to define how you want to
calculate the percent complete for cost items.
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The calculation for this option is: (updated % complete on the cost item) = (SOV unit
price) x (Claimed qty in Contract or Plan) ÷ (Denominator in settings). Actual qty (to date)
= % complete * Forecast (T/O) qty OR CB total qty (depending on settings).

5.5.2 SYNC HOURS AND COSTS

If your project uses external systems to capture man-hours and costs, those values can be brought into
Control through a sync. If your project uses an ERP system, you can bring in man-hours and costs by
performing a Get Actual Cost and MHrs sync. If you have values tracked through contracts, you can
enable project settings to bring those values in from InEight Contract. Hours and costs brought into
Control through a sync update which updates the Actual cost (to date) and Actual MHrs (to date)
columns.
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ERP

After man-hours and costs are verified in your ERP system, you can initiate a sync to bring those values
into Control. Similar to the Get Quantities sync, the Get Actual Cost and MHrs sync is accessed from
the Actions menu.
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If your project captures work hours through InEight Progress, those hours and their associated costs
are approved in Progress before being sent to the ERP.
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InEight Contract

InEight Contract can record actual costs in the form of goods receipts, accruals, invoice receipts, or
payment forms. You can configure your project settings to pull these actual costs into Control through
a batch process.

In project settings, under Control > Project Tracking > Actuals, switch the Get actual cost from
Contract toggle to On.

After you enable this setting, Contract values update the actual cost for the associated cost items. Note
that it may take up to 15 minutes for the background batch process to complete.
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5.5.3 AUDIT LOG

You can check the status of a sync in the Audit Log on the Integration tab.

5 . 6 ACTUALS BY IMPORT

You can import actual costs, man-hours and quantities by using an Excel or CSV file.

An actuals import is similar to claiming actuals in Control. After you upload a spreadsheet containing
actuals, those values are added to any existing actuals for the specified cost items. Your spreadsheet
values should represent new claiming on a cost item rather than the total sum to date.

From the CBS tab in Control Workspaces, you can access the Import function by clicking the Import
icon, and then selecting Actuals.
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After you add the import file, you can select the matching criteria in the Map columns dialog box. The
Map columns dialog box has a select number of Control fields which pertain to actuals. The table
below shows details of the available fields.

Control field Details

WBS phase code The unique WBS phase code. Can be used as the cost item matching
criteria. Required to select this or CBS position as the cost item
matching criteria.

CBS position The position in the CBS hierarchy. Can be used as the cost item
matching criteria. Required to select this or WBS phase code as the
cost item matching criteria.

Posting date Required field. Control will prompt you to specify the date format used
in your import file.

Notes Text field for any notes that pertain to this specific claiming update.

Claimed quantities Quantities in this field will be added to the Actual qty (to date) field for
the specified cost items.

Number of man
hours

Values in this field will be added to the Actual MHrs (to date) field for
the specified cost items.

Number of equipment Values in this field will be added to the Actual eqp hrs (to date) field for

Page 208 of 572 InEight Inc.  |  Release 25.5

5.6 Actuals by Import Control User Guide



Control field Details

hours the specified cost items.

Cost Values in this field will be added to the Actual cost (to date) field for the
specified cost items.

Cost categories You can download a list of your project’s cost categories from the
Import actuals data dialog box. The values in the import file must match
the Control values exactly.

Actuals user defined
1-2

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Actuals user defined
3-6

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate Resource You can specify estimate resources to be included with this claiming
update. Use the resource code for the estimate resource as the value
for this field. This update will be visible from the Actuals Details tab in
Actuals History.

Follow the steps below to import actuals.

IMPORT ACTUALS

1. Prepare the import file.

2. From the CBS, click Import > Actuals.
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3. In the Import actuals data dialog box, add the import file, and then select the cost item matching
criteria.

4. Map the Control fields to the file columns.
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5. Select the date format used in the import file.

6. The import file will be checked for errors. If the file contains no errors, click Next.

If the import contains errors, download the error file for more information.

7. Click Import now to complete the import.
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Visit Cost Item Excel Import for more information on performing an import.

5 . 7 ACTUALS BY MANUAL ENTRY

In some situations, you may need to enter actuals directly in InEight Control. This can be helpful when
field data is delayed, incomplete, or needs correction. Manual entry also gives you greater flexibility
when tracking progress tied to lump sum or indirect costs, or when values include confidential or
sensitive data.

The steps below outline how to claim actuals by manual entry.
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CLAIM ACTUALS BY MANUAL ENTRY

1. From the CBS, right-click a cost item, and then select Actuals details.

2. On the Claim Actuals tab of the slide-out panel, select the type of actuals from the tabs on the
left.

3. Enter the quantity, hours, or cost to be claimed.
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4. Enter additional details as needed.

5. When finished, click Apply.

5.7.1 CLAIM QUANTITIES

Track completed progress progress on a cost item by entering a claim on the Quantities tab in the
Actuals details slide-out panel.

Before claiming quantities for a cost item, make sure the Hide in Plan, Progress, and Design column is
checked. This option prevents conflicts by making the cost item unavailable for claiming outside of
Control.
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See the table below for details on the available fields on the Quantities tab.

Field Details

Forecast (T/O) qty Shows the forecast takeoff quantity for the cost item.

Actual qty (to date) Shows the actual quantity claimed to date for the cost item.

Claimed quantity Required field. Enter the quantity you wish to claim for this entry.

Posted date Select a posting date for this claiming entry.

Actuals user defined
1-2

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Actuals user defined
3-6

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.
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Field Details

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

(continued)

You can enter negative quantities when claiming in Control.

5.7.1 .1 CLAIM QUANTITIES FOR MULTIPLE COST ITEMS

Select Claim quantities for multiple cost items to claim actuals for multiple cost items on the same
posting date. The Claim quantities for multiple cost items window shows the same fields that are found
on the Quantities claiming tab in a grid format.

Follow the steps below to complete a manual claim for multiple cost items.

CLAIM QUANTITIES FOR MULTIPLE COST ITEMS

1. From Claim Actuals > Quantities of the Actuals Details slide-out panel, click Claim quantities for
multiple cost items.

Page 216 of 572 InEight Inc.  |  Release 25.5

5.7 Actuals by Manual Entry Control User Guide



2. Select the posting date for this claim.

3. Click Add cost item to add additional cost items to claim on this posting date.
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4. Click the checkbox to select cost items. When you are finished, click Add.

5. Click inside the Claimed quantity field to enter a quantity for each cost item.

6. Enter additional details as necessary.
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7. When finished, click Claim.

Note that you can also claim quantities for multiple cost items by selecting the cost items in the CBS
register, and then opening the Actions menu and choosing Claim multiple CBS quantities.
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5.7.2 CLAIM MAN-HOURS

Claim work hours for a specific employee or for a crew on the Man Hours tab in the Actuals details
slide-out panel.

To claim hours for a crew, enter the total number of hours worked in the Number of hours field and
leave the Employee name and Employee ID number fields blank.

See the table below for details on the available fields on the Man Hours tab.

Field Details

CE total MHrs Shows the Current Estimate total man-hours for the cost item.

MHrs (to date) Shows the actual man-hours claimed to date for the cost item.

Number of hours Required field. Enter the hours you wish to claim for this entry.

Posted date Select a posting date for this claiming entry.

Employee name If entering hours for a single employee, enter the employee name.
Make sure that the entry matches the name in the employee record.

Employee ID If entering hours for a single employee, enter the ID number. Make
sure that the entry matches the ID number in the employee record.
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Field Details

Actuals user defined
1-2

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Actuals user defined
3-6

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.7.3 CLAIM EQUIPMENT HOURS

Claim hours for an equipment item on the Equipment Hours tab in the Actuals details slide-out panel.
See the table below for details on the available fields on the Equipment Hours tab.

Field Details

CE total equipment
Hrs

Shows the Current Estimate total man-hours for the cost item.

Equipment Hrs (to Shows the actual equipment hours claimed to date for the cost item.
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Field Details

date)

Equipment ID # You can enter the ID for the equipment item. Make sure that the entry
matches the ID number in the equipment record.

Posted date Select a posting date for this claiming entry.

Hours used Required field. Enter the hours you wish to claim for this entry.

Actuals user defined
1-2

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Actuals user defined
3-6

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.7.4 CLAIM COST

Claim cost for a cost item on the Cost tab in the Actuals details slide-out panel. See the table below for
details on the available fields on the Cost tab.
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Field Details

CE total cost Shows the Current Estimate total cost for the cost item.

Actual cost (to date) Shows the actual cost claimed to date for the cost item.

Claimed cost Required field. Enter the cost you wish to claim for this entry.

Cost category Required field. Select the cost category for this entry.

Posted date Select a posting date for this claiming entry.

Actuals user defined
1-2

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Actuals user defined
3-6

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.7.5 ADD ADDITIONAL CLAIMING ENTRIES

You can record separate claiming entries for a single cost item from the Actuals Details slide-out panel.
Click the Add icon from the bottom of the slide-out panel to add additional entry fields.
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5.7.6 USER-DEFINED FIELDS

There are 6 user-defined fields you can use when you claim actuals in Control. These field labels can be
customized to fit your business practices. Examples of custom labels include “Start Date”, “Area”, or
“Category”. An additional field is available to select a resource from the Project library.

Custom labels for the user-defined fields can be set up in Platform > Suite Administration > Custom
labels.

User-defined
field Type Description

Actuals user
defined 1-2

Date Use this field to enter dates, such as start and finish dates.

Actuals user
defined 3-6

Free
text

Use these fields to enter any variable attribute based on your
business processes.

Estimate
resource

Choice Select a resource from the Project library. You can only select
one resource per transaction.
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5 . 8 ACTUALS BY AP I

Your organization can set up API integrations to synchronize actuals between InEight Control and an
ERP or other external system. Refer to the Control Integration Specification document for more details.

5 . 9 EST IMATED ACTUALS

Estimated actuals lets you track costs, quantities, man-hours, and equipment hours on a cost item
before these values are validated through the ERP system. This provides more up-to-date visibility on
progress and increases forecast accuracy. Estimated actuals can be generated in Control through
quantity claims, or brought in from approved daily plans in Progress. After actuals are validated in the
ERP system, you can reverse the estimated actuals and maintain the confirmed actuals.

To view estimated actuals in Control, you must first enable the feature in Control’s project settings. To
enable, go to the Project Tracking tab in settings, and under Estimated actuals, switch the Turn on
estimated actuals toggle to ON, and then select the applicable cost categories under Control and
Progress.

When you enable estimated actuals, you can add relevant columns to a data block to view estimated
actuals.
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The following table shows columns related to estimated actuals.

Column Description

Confirmed actual cost The expended cost verified through the ERP system.

Confirmed actual
equipment

The expended equipment cost verified through the ERP system.

Confirmed actual man hours The number of labor hours verified through the ERP system.

Confirmed actual qty The cost item quantity verified through the ERP system.

Estimated actual cost Recorded actual cost that has not yet been confirmed through
the ERP system.

Estimated actual
equipment

Recorded equipment cost that has not yet been confirmed
through the ERP system.

Estimated actual man hours Recorded labor hours that have not yet been confirmed through
the ERP system.

Estimated actual qty Recorded cost item quantity that has not yet been confirmed
through the ERP system.

Last estimated actual cost
reversal

The date and time the last Reverse estimated actuals >
Reverse estimated actual cost action was performed.

Last estimated actual man
hours reversal

The date and time the last Reverse estimated actuals >
Reverse estimated actual man-hours and labor cost action
was performed.

Last estimated actual eqp
hours reversal

The date and time the last Reverse estimated actuals >
Reverse estimated actual equipment hours and construction
cost action was performed.
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5.9.1 CLAIM ESTIMATED ACTUALS IN CONTROL

CLAIM ESTIMATED ACTUALS

1. From the CBS, right-click a cost item, and then select Actuals details.

2. From the Quantities tab, enter a claimed quantity.
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3. When you select Estimated actuals to be added on claiming, cost category values automatically
populate based on the claimed quantity entered using Current Estimate unit rates.

4. Click Apply when you are done.

The estimated values for the cost item can now be viewed in the relevant columns.

5.9.2 ESTIMATED ACTUALS FROM PROGRESS

With the correct settings enabled, estimated actuals can be brought in from Progress based on
approved daily plans.

Note in the example below, prior to the creation of a new daily plan, the estimated actuals for this cost
item have a value of 0.
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In Progress, labor hours and equipment hours are tracked on the Time Sheet tab of a daily plan.

Quantities are tracked on the Quantities tab of a daily plan.
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After the daily plan is submitted and approved in Progress, the estimated actuals values automatically
update in Control.

Estimated actuals values are only general estimates. They are not confirmed until synced with an ERP
or an external payroll system.

5.9.3 REVERSE ESTIMATED ACTUALS

After actuals are reviewed and confirmed in your ERP system, they are brought into Control through a
sync. These values are then reflected as “confirmed” actuals. Following this process, you can reverse
the estimated actuals, since the confirmed actuals now reflect the most up-to-date information.

If you keep the estimated values without reversing after syncing with the ERP system,
those values are detected as double values.
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REVERSE ESTIMATED ACTUALS

1. From the CBS, select the cost items which have recorded estimated actuals.

2. From the Actions menu, select Reverse estimated actuals, and then select the appropriate type
of reversal.

3. Click Yes to confirm the reversal.

4. In the CBS, the estimated values are reset to 0.
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5 . 10 ACTUALS H ISTORY

Once progress is tracked against a cost item, you can view its actuals claim history. You can view
actuals history of a cost item by right clicking on a cost item and selecting Actuals details from the
menu. On the resulting slide out panel, you can view the history of when actual quantities, costs, and
man-hours were posted by clicking on the Actuals History tab of the cost item.

The Actuals history tab displays and groups the actual claim history by posting date. Within in each
posting date folder you can view as-built progress details of quantity, cost, man-hours, and equipment
hours of the specific cost item selected in the CBS.

In addition, by clicking on the posting date link, you can view more specific claim history details such as
actuals type, cost category, employee change by, and notes.

5 . 11 PROGRESS CONTROL SETT INGS

InEight Control integrates with several other programs. Within the tool, a few specific columns allow
you to manage the information that is sent to other InEight applications and to your ERP system. Below
is a table of the key columns and their functions.

Column Name Function

Allow As-Built Allows you to choose whether a cost item accepts actual cost, quantities,
both, or none.
Once this item receives actual costs, quantities, or man-hours, this setting

Page 232 of 572 InEight Inc.  |  Release 25.5

5.10 Actuals History Control User Guide



Column Name Function

cannot be adjusted (changed from All to None).

As-built lock Once you lock the ERP status, your ERP does not allow the WBS to be
progressed.
Example use cases for locking ERP status:

l Work will not begin for two more years
l Foreman is not allowed to claim more quantity because work is 100%
complete

l Work is complete and you do not want people mistakenly charging
cost to completed to cost items

Hide in Plan
and Progress

Allows the user to choose whether to have a cost item available to use in
InEight Plan and InEight Progress.
Example use case for Hiding in Plan and Progress:

l Indirect staff cost codes should not be available for direct labor to
charge

The steps below walk you through the various columns and discuss options for changing the settings.

PROGRESS CONTROL SETTINGS

For this step you will need to have a subordinate available to use.

1. On the Control main page CBS tab, select the Progress view.

2. Navigate to the Task Details data block.

3. Select the second Data Panel in the Task Details data block.

4. Double click in the Allow As-Built field of the subordinate cost item and select the drop-down
arrow.

5. Select All.

6. Navigate to the Third Panel of the Task Detail data block.

7. Select the Hide in Plan and Progress check box of the cost item.
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5 . 12 VENDOR WORK HOURS FROM
PROGRESS

5.12.1 VENDOR MHRS FROM PROGRESS

You can see the subcontract man-hours in Control for cost items that derive from InEight Progress.
Subcontract performance can be tracked in Progress with data coming into Control for increased
transparency, improved monitoring, and analysis.

In addition to assigning a vendor to a cost item, and viewing the assigned vendors from InEight
Contract, you can also see the claimed MHrs originating from Progress in Control >Workspaces, upon
approval in Progress.

After the claimed vendor hours are approved in Progress, the Actual vendor MHrs (to date) and Actual
columns populate with the claimed hours. This helps to find and focus on the true causes of any issues
and support the ongoing work in the best way possible.

The Actuals Details slide-out panel shows the number of hours worked by the assigned vendor.
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In Progress > Daily Plans > Timesheet, the new Vendor tab lets you choose which vendors to include on
your daily time sheet as selected vendors to claim hours.

Only those vendors that are assigned in Control > Workspaces can claim hours against a timesheet
Progress’s daily plan. In Progress, if a vendor is not assigned to a cost item in Control, the vendor hours
task block is disabled and hours cannot be claimed.
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If a vendor is assigned to a cost item in Control, the vendor can claim actual hours.
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5.12.2 ASSIGN VENDOR COLUMN IN THE CBS

You can assign a vendor to a cost item, and also view the assigned vendors from InEight Contract.

If a vendor is assigned via a contract, the vendor name is automatically assigned to a cost item and
cannot be removed.
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Clicking in an Assigned vendor field lets you add new vendors. Vendors originate from the master data
library for the entire organization.
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5 . 13 TRACK OPEN /REMA IN ING AND TOTAL
COMMITTED COSTS

Additional information about purchase orders and contracts (for any particular task) can be viewed and
updated within CBS columns. This provides users with a more comprehensive data set in one location.
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Committed costs are the purchase orders or subcontract commitments that a cost item may have
against it. To determine open and total commitments, look at the agreed or pending purchase order
amounts that are associated to any particular cost item. This information is typically exported from
your ERP or accounting system.

Open/Remaining committed cost: Total committed cost - Actual cost (amount that still needs to be
paid for a cost item).

Total committed cost: The summation of all purchase order and/or contract obligation amounts
assigned to a cost item.

Open/Remaining committed cost adjustment: A debit or credit to the existing Open
committed/Remaining cost value.

New open committed cost: Open/Remaining committed cost + Open/Remaining committed cost
adjustment.

However, there is also the option to use a generic API to push committed cost values into InEight
Control. If your organization does not have an ERP system, you can configure the endpoints in APIM
and push over your committed cost values.

VIEWING OPEN/REMAINING AND TOTAL COMMITTED COSTS

1. On the CBS register tab, select the Group Columns icon to the right of the page.  The icon
will turn yellow when turned on.

l Tasks, Task details and Commitments data block need to be present on this screen
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l If the Commitments data block has not been created, create a custom data block
using the Data Icon and include columns Remaining committed cost, and Total
committed cost. Insert this data block into your view.

2. Drag the UOM column from the Task details data block, and drop it into the grey bar area

l Notice how UOM's are now are now visible by groups.

3. To view a more granular level of information, navigate into the context menu for a cost item,
and select Actuals details.
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4. Once in the Actuals details, navigate to the Commitments tab.

l Here is a more concentrated view of the cost category breakdown of the Open and
Total commitments

l It's also possible to update information. For example: the below cost item for Water &
Ice Distribution, the New total committed cost is showing that a contract was signed
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for $1,267.87.

l There is $700.00 left remaining to pay the full $1,267.87 subcontract, as shown in
the New open committed costs column
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l Assuming a bill of $100.00 was just paid, it's possible to update the Open committed
cost adjustment field with this value. Notice how the New open/remaining committed
cost decreases to $600.00, after making an adjustment of $-100.00 to the Open
committed cost adjustment field.

5. Select Apply to apply the above changes.

6. Back on the CBS, you can now see your new updated values for this cost item.

Both the Open/Remaining committed cost and the Total committed cost values can be
edited in the Actuals details slideout > Commitments tab (with the right permissions).
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5 . 14 COMMITTED COST FROM CONTRACT

When the Drive committed cost values setting is on, your committed cost is then derived from
Contracts.

When the switch is off, your committed cost is driven from the ERP. Regardless of the state of the
switch, you can always manually enter your committed cost directly in the product or via a Microsoft
Excel import.

With the setting on, all of your committed cost values initially zero out, and then pull over all of your
committed cost values that exist in InEight Contract.

For example, if you have a cost item that is associated with a contract, those values are pulled over
from Contract and populate the total committed cost and open/remaining committed cost columns.

The calculation is Forecast final cost = your Total committed cost; Forecast remaining cost = your
Open/Remaining Committed Cost.

In a contract on the Line items tab, change your view to Progress. Take note of the WBS phase code
and then view the Gross amount. The gross amount for the cost item is the exact amount for the total
committed cost, which includes your line item amount, plus tax.

Total gross amount is your line item amount plus tax. That is going to be your total committed cost
value. The calculation for that: Total committed cost = Line item amount + Tax (this is also called Gross
amount in Contract)

If you have a cost item that is associated with multiple line items in a single contract or across multiple
contracts, the total committed cost for that cost item is the gross amount for all the line items that
cost item is associated with.

If the WBS element is associated to three different line items, the sum of those three gross amounts is
the total committed cost value. A best practice is to associate a single cost item to a single line item.
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To get your Open/Remaining Committed Cost, calculate what you still have to pay for your remaining
commitments. It is your total committed costs minus what you have already paid. You track payments
in contract in three different ways:

l goods receipts

l accruals

l invoices

Invoices are generated in your payment forms.

The calculation is Open/Remaining Committed Cost= Total committed cost - Max(Goods receipt
amount, Invoice amount) - Accrual amount.
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EXERCISE 5.1 — PROGRESS MEASUREMENT

The purpose of this exercise is to give you more familiarity with the InEight Control progress
measurement terminology.

1. From the CBS register in InEight Control, create a new viewset with one or more custom
data blocks that contain the planned, earned, and actual measurements you would want
to see in your project.

2. Add additional productivity measurements (e.g., CF, LEI) as desired.

Congratulations, you have completed this exercise!
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REVIEW

1. How can you determine what your productivity is for a specific timeframe?

a. Excel Spreadsheet (Date Range Select)

b. Forecast Final MH (Date Range Select)

c. CB Total MH (Date Range Select)

d. Actuals CB Productivity Factor (Date Range Select)

2. What term describes your Original Budget plus or minus approved changes?

a. Current Actuals

b. Current Budget

c. Current Estimate

d. Current Cost Changes

3. How can you view the actuals history of a cost item?

a. Select the Actuals History viewset

b. Right clicking on a cost item and selecting Cost item details

c. Right clicking on a cost item and selecting Actuals details

d. Selecting Actuals History from the Actions menu

SUMMARY

As a result of this lesson, you can now:

l Define the measurements for analyzing the progress of a project

l Set up a Date Range for progress data

l Get Plan quantities, actual costs, and actual man-hours using the Sync feature

l Explain the settings used for managing progress data shared between applications
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l Add and adjust actuals manually

l View actuals history
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LESSON DURATION:   45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Differentiate and utilize InEight forecasting methods

l Manage forecasts

l Manage Time Phased Forecasting

l Push to Live Forecast

l View the Fiscal Calendar settings
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6 . 1 INE IGHT CONTROL WORKFLOW –
FORECAST ING
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6 . 2 FORECAST ING OVERV IEW

6.2.1 FORECAST DATA BLOCK

All forecasting is done using the Forecast data block.

The Forecast data block contains columns for determining the Forecast Final Unit Cost, Forecast Final
Cost, Forecast Final MHrs, and productivity, as well as the Forecast Method. Further in the lesson, you
will learn the details of how to input a forecast.

The Control main page includes a default Forecasts viewset that contains the Forecast
data block.

6.2.2 PRIVATE FORECASTS

The Control application allows you to create multiple private forecasts as needed, giving you flexibility
to try out different forecasting methods and “what if” scenarios. The Manage Forecasts section of this
lesson walks you through how to save and share your forecasts with others on your project.

You can access all the forecasts you have access to via the drop-down on the Forecast data block
header.

This shows you all your forecasts, as well as any other forecasts that have been shared with you.

6.2.3 LIVE FORECAST

In Control, the Live Forecast is the official project forecast used for financial reporting and is shared
with all members of the project automatically. Data from other forecasts can be pushed to the Live
Forecast to keep it up to date. The Live Forecast is managed using its own data block.
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The Control main page includes a default Forecasts viewset that contains the Forecast
data block.

Only users with the right permissions have access to update the Live Forecast. Updating the Live
Forecast is covered in greater detail further in the lesson.

6.2.3 .1 LIVE FORECAST GRID NAVIGATION

You can access the cost categories slide-out panel quickly by clicking the Live Forecast View Cost
Categories icon.

Clicking the icon takes you directly to the cost categories slide-out panel in the cost item details.
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6 . 3 FORECAST METHODS

The Forecast Method establishes the appropriate forecast unit cost, which is used to calculate the total
forecast cost. The Forecast Method applies to individual cost items and can be changed at any time.

You can use several forecast production methods to calculate the cost of the remaining work
associated with a cost item. This enables the control of forecasting on a cost item by cost item basis by
controlling the calculation of the cost of the remaining work. The different methods available for
forecasting are:

Method Calculation Apply to

Current Budget
(CB)

Actual Total cost + (Current budget unit cost * Quantity
remaining)

Terminal or
superior
cost items

Current Estimate
(CE)

Actual Total cost + (Current estimate unit cost * Quantity
remaining)

Terminal or
superior

Forecast Methods
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Method Calculation Apply to

cost items

Average
Performance

Actual Total cost + (Actual unit cost * Quantity remaining) Terminal or
superior
cost items

Manual Manually entered forecast value Terminal or
Superior
cost items

Rollup The sum of subordinate forecast values Superior
cost items

Committed Cost Actual Total cost + Open/Remaining committed cost Terminal or
superior
cost items

None The Forecast total cost will be 0 Terminal or
superior
cost items

Contract Line item gross amount + Draft vendor change order
amount + Remaining to buy (value allocated to the first
line item in the contract)

Terminal or
superior
cost items

Detailed ETC Actual Total cost + sum (Forecast remaining cost) for all
assigned forecast resources.

Terminal
cost items

Static manual time
phased
forecasting (TPF)

The sum of the manually distributed time phased forecast
cost.

Terminal or
superior
cost items

Custom (customer
specified)

Calculation specified by customer. Terminal or
superior cost
items

Forecast Methods (continued)

6.3.1 FORECAST METHOD ASSIGNMENT

There are three different ways to assign a forecast method:
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l Globally to all cost items in the project

l Selection of multiple cost items

l Individual cost item

6.3.1 .1 GLOBAL FORECAST METHOD

From the Actions menu, you can set the forecast method globally for all the cost items within the
project.

The Global forecast method only applies to the forecasted items of the user who
performs the function. It does not apply to other users in the project.

The following steps walk you through applying a global Forecast Method.

SET GLOBAL FORECAST METHOD

1. From the CBS tab register, select the Viewmenu.

2. Select the Project Controls viewset.

3. Click on the Actions drop-down menu and select Global Forecast Method.

4. Select the Current Budget Forecast Method.

5. Click Apply.

Only terminal cost items will adjust per the global Forecast Method selected. The
parent item Forecast Method will stay as Rollup.

6. Click Yes on the prompt that appears.

6.3.1 .2 FORECAST METHOD FOR SELECTED ITEMS

You can also set the forecast method for selected cost items, as shown in the steps below.
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SET THE FORECAST METHOD FOR SELECTED ITEMS

1. In the Tasks data block, select the check box next to the desired tasks.

2. Select the Actions drop-down menu and select Set Forecast Method.

3. On the resulting slide out panel, select your desired Forecast Method and click Apply.
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6.3.1 .3 FORECAST METHOD FOR INDIVIDUAL ITEMS

You may need to change the forecast method for a single cost item. The following Step by Step walks
you through how to do so.

SET THE FORECAST METHOD FOR INDIVIDUAL ITEMS

1. In the Forecast data block, locate the Forecast Method column.

2. Double click on the Forecast Method field for the your desired cost item.
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l A dropdown menu appears where you can select your Forecast Method from a list

6.3.1 .4 AVERAGE PERFORMANCE FORECAST METHOD

The average performance forecast method lets you use actuals for a specific time frame range to
determine the unit cost and rate for the remaining work when calculating the remaining forecast.
Forecasting using average performance lets you forecast the remainder of work based off completed
work.

When Average performance is selected as the forecast method in the CBS, you can click the value in
the Average performance settings column and select a date range to use for the actual rate of
completion for the remainder of work.

This feature lets you identify a length of time you want to utilize a cost item's hours and quantities to
determine the install rates for the remaining work.

Click an Average Performance Settings CBS record to access the Average Performance Settings
window.

Setting Usage notes

Calculate average performance over all
dates

The average performance for the cost item
takes all the dates into account when
calculating its average performance.

Calculate average performance based on
most recent

You can determine how many weeks or
months to calculate the average performance
for a cost item. For example, you determine
that the last 2 weeks performance best
represents how to progress, then you would
calculate two weeks of average performance.
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Setting Usage notes

Calculate average performance over a
specified range

Selecting a date range uses only the specified
time range for calculating the average
performance.

Calculate average performance from date You can select a specific date to calculate
average performance. After the learning period
for the selected cost item is complete, you can
use the average performance for a specific
date and onward.

The average performance settings can also be accessed in the cost item details slide-out panel.
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As an example, if you choose to calculate the average performance based on the most recent three
weeks, the Forecast remaining cost and Forecast remaining MHrs change based off the cost item’s
performance from the last three weeks.

The Forecast method and Average performance settings changes are also shown in the cost item
details slide-out panel.
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6.3.1 .5 COMMITTED COST FORECAST METHOD

Committed Costs are obligations made for contract work or purchase orders that you have agreed to
pay for. The Committed Cost forecast method provides you with the ability to use committed cost
information to forecast your cost at completion.
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Forecasting cost items can be done in the live or private forecast, and can be forecasted at the parent
or terminal levels. The Committed Cost Forecast method can only be used when cost items have an
Allow as-built of All or Costs. When the Allow as-built values are set to None or Quantities, this forecast
method cannot be used because cost and committed costs cannot be claimed.

The Committed Cost forecast is mostly utilized on cost items that are driven from purchase orders or
contracts. It is not used when you're claiming quantities. For example, this forecast method isn't
suitable for direct labor items where quantities are claimed to generate progress and crew
performance. This forecast method works well for cost items that are tied to a contract or PO.

When Open/Remaining Committed Cost values are being entered, these values will also update the
forecast values in the CBS. There is also an integration available that allows you to import committed
cost data from your ERP, instead of manually entering in the data. For more information on
Commitment Costs, visit subject Track Open/Remaining and Total Committed Costs within this topic3.3
Cost Item Setup on page 94

The following columns will help you view the Committed Cost forecast method:

Forecast total cost: Forecast cost at completion which is equal to the Open/Remaining committed cost
plus any Actual cost to date.

Forecast remaining cost: This is the amount of money that remaining to be paid out. This column is
equal to the Open/Remaining Committed Cost.
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The Committed cost forecast method is most commonly used for costs that are associated to a
purchase order tracked through an ERP system. This method doesn't focus on quantities or percent
complete, but rather the progression of costs paid towards the final agreed upon PO value.”

6.3.1 .6 CONTRACT FORECAST METHOD

Using this forecast method, you can forecast by Contract values. This forecast method is only available
in the forecast drop down for cost items that are assigned to a Contract.

Any modifications that you make in Contract automatically updates and comes into
Control.

When a cost item is assigned to a contract, you have the option of adding the read-only column
Number of contracts to your CBS. This column is an integer value that counts the number of contracts
a particular cost item is associated to. You have to go into Contracts to see which Contract your cost
item is associated to.
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If the Number of contracts column is set to zero, the Contract Forecast Method becomes unavailable
from the Live Forecast, Private Forecast, and the Cost Item Details slideout drop down for Live Forecast
Method on the Details tab.

Contract Forecast Method pulls the cost that is associated to a specific cost item from Contracts. Cost
items can be associated to the following if using Contract Forecast Method:

l Many different Contracts

l Many different line items across different Contracts

The cost item's Forecast Final Cost value sums up the line item amounts of all cost that is associated to
a cost item from Contract.

UNAPPROVED CONTRACT LINE ITEMS

The line item price is included in the associated cost item's Contract forecast method when creating
new line items in a Contract vendor change order.

After a new line item is saved, a batch process is initiated in the background that sends the line item’s
net price over to Control.
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The net price from Contract shows in Control’s forecast total cost column, which also includes the tax
from draft pending vendor change orders.

6.3.1 .7 CUSTOM FORECAST METHOD

The Custom forecast method lets you specify a calculation for a forecast cost and manhours. For more
information, refer to Project Control settings where Custom forecast methods can be configured.

Page 268 of 572 InEight Inc.  |  Release 25.5

6.3 Forecast Methods Control User Guide



6 . 4 MANUAL FORECAST ING

Scenario

Assume you have a structural steel installation code being performed by a subcontractor. They
have notified the project team that the material cost of the steel has gone up due to a change of
thickness of some of the column base plates. You will need to forecast an increase in the total
subcontract cost of the code to reflect this change.

You also receive an update from the concrete superintendent that the code for a concrete
pouring operation will now be using journeymen instead of apprentice concrete finishers. He has
provided the total and you will update the total cost and the labor cost per man-hour.

6.4.1 EAC VS. ETC

You can manually enter forecast values for both your Estimate at Completion (EAC) and Estimate to
Completion (ETC) values.

Control uses different descriptions than EAC and ETC as indicated below.
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Forecast Term Control Term What it measures

Estimate at Completion
(EAC)

Forecast Final Cost
Forecast Final MHrs

As-built + (Forecast Unit Cost x Quantity
Remaining)

Estimate to Completion
(ETC)

Forecast Remaining
Cost
Forecast Remaining
Man Hour

Forecast Unit Cost x Quantity Remaining

The image below illustrates what EAC and ETC measure:

6.4.2 MANUAL EAC (ESTIMATE AT COMPLETE)
FORECAST

You can use the Manual (Estimate at Completion) Forecast Method to make a simple, quick adjustment
to the calculated forecast numbers, or to forecast the cost of the work remaining, while ignoring actual
costs in the calculation of the forecast.

When you enter a forecast cost at the total level, you can have forecast costs:

l Distributed to the cost categories, or

l Back calculated if forecast man-hours are adjusted
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To set the forecast total or EAC forecast, type a value into one of the following cells within the
forecasting data block:

l Forecast final cost

l Forecast final MHrs

l Forecast Final Man-hours per Unit

l Forecast Productivity Factor

l Forecast Final Cost per Unit

The next two Step by Steps walk you through how to define the Manual (EAC) forecast by adjusting the
Forecast Final Cost and the Forecast Final Man-Hours.

MANUALLY ADJUST FORECAST FINAL COST

1. In the Forecast data block, double click the Forecast Final Cost cell for a cost item.

l This will allow you to edit the dollar value manually

2. Change this value to 125,000.
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To revert to the original value when manually typing into the cell, press the Escape
(Esc) key. 

All other cost categories proportionally adjust automatically once the labor is
adjusted.
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In the Forecast data block, blue dots indicate what the forecast driver is. A forecast
driver is the manually edited value that the Forecast Final Cost is based off.

In the *Live forecast data block, orange triangles will appear in the top right-hand
corner of the cell. These indicate what the forecast driver is and give a detail of the
change when hovered over.
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3. Hover over the Forecast Final Cost cell of the value you entered and select the View cost
categories pop-up.

l You can see the adjustments that were made by cost category

6.4.2 .1 PROPORTIONAL ADJUSTMENT

As you make changes, you may receive a prompt asking you how you would like to adjust other values
affected by your change. For example, when you change your Forecast Final Cost, this will affect either:

l Forecast Final MH or

l Forecast Final $/MH
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While one of those values will remain constant, the other will adjust as indicated in the table below:

Forecasting – Proportional Adjustment Example

Action Result

Original Forecasted Values Forecast Final Cost = $1000
Forecast Final MH = 100
Forecast Final $/MH = 10

Manually adjust Forecast
Final Cost

Forecast Final Cost changes from $1000 to $2000

Resulting adjustment
Option 1:
Adjust Forecast Final MH

Forecast Final Cost / Original Forecast Final $/MH = Adjusted
Forecast Final MH
$2000 / 10 = 200 MH

Resulting adjustment
Option 2:
Adjust Forecast Final $/MH

Forecast Final Cost / Original Forecast Final MH =
Adjusted Forecast Final $/MH
$2000 / 100 = 20/MH

6.4.3 MANUAL ETC (ESTIMATE TO COMPLETION)
FORECAST

The Manual ETC (Estimate to Completion) forecast method can be used to make an adjustment to
forecast the unit cost of the work remaining and adding it to the as-built costs in the calculation of the
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forecast.

To set the forecast remaining or ETC (Estimate to Complete) forecast, type a value into one of the
following cells within the forecasting data block:

l Forecast Remaining Labor Cost/MHr

l Forecast Remaining Labor Cost

l Forecast Remaining Man-hours per Unit

l Forecast Remaining Productivity Factor

l Forecast Remaining Cost per Unit

This will set the unit cost and man hour factors. When applied to the remaining qty to deliver and
added to the existing actuals this will equal your total forecast amounts.

6.4.3 .2 DETAILED ETC FC METHOD

The Detailed ETC (estimate to completion) method lets you modify the crew makeup and production
rates that drive the remaining forecast values (based on remaining quantities and hours).

For example, if you started your project and you used apprentices, and now you prefer to use
journeymen, you can swap out resources for your forecast resources and use journeymen instead of
apprentices.

In Control settings > Project Tracking, you can now enable forecast methods for terminal cost items
when the allow-as built is set to all or cost for Detailed ETC. When the Detailed ETC forecast method is
enabled, all existing Current Estimate Resources for that cost item are copied to the Forecast
Resources tab in the CBS > Cost Item Details slide-out panel.
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When the Detailed ETC setting is enabled, a new tab is available in Cost Item Details called Forecast
Resources. This new tab is almost identical to the Current Estimate Resources tab, with the major
difference being that the Forecast Resources tab contains forecast information. You can edit these
resources and values separately from the current estimate resources for a cost item.
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6 . 5 FORECAST MANAGEMENT

Scenario

Imagine you are covering the concrete portion of the Steel Structure project, and you want to do
a “what if” forecast based on a potential change in the type of concrete to be used. This forecast
will affect many codes and you do not want it to affect the forecast information for everyone else
on the project. Also, your manager requested that you send him the new forecast so he can
review the data and compare it to the Live Forecast, which will help decide which path to take.

Depending on the size of your project, you may have multiple engineers involved in forecasting project
tasks. For example, a larger team may divide up responsibilities by discipline, with discipline-specific
field engineers putting together information for a project manager.

InEight Control accommodates multiple people doing the forecasting, by allowing users to create and
save their own forecasts, so they can forecast their items without affecting anyone else’s work. They
can then share their forecasts with others as needed, accessing all the shared forecasts from the drop-
down folder of the Forecast data block.

6.5.1 SAVE FORECASTS

Once you have adjusted your forecast in the Forecast data block, you can save the forecast.
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SAVE FORECASTS

1. To save the forecast, click on the drop-down arrow in the center of the Forecast data block.

2. Select Save as… from the menu drop-down list.

3. In the Forecast Name field, type InEight Control. In the Sharing field, keep the forecast as
private.
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4. Click Save.

The Forecast data block now displays the saved forecast. Any changes made within
this data block will be saved to that forecast. To get back to the Forecast data
block, select the Add data blocks button and insert the Forecast data block.

Alternatively, you can revert to the Forecasts saved view.

6.5.2 LOAD FORECASTS

You can load existing shared forecasts, as shown in the Step by Step below.

6.5.3 PROJECT LEVEL SHARED FORECASTS

You can create up to five forecasts that are automatically shared with members assigned to the
project. This lets you collaboratively work together with other team members to work on a forecast,
prior to getting pushed to the live forecast. Other members can also edit and push the live forecast.

Selecting the Shared link lets you manage between private and shared access. All team members that
share your forecast view can view and edit the forecast, and view any changes made update in real
time.
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SHARED FORECASTS

1. To share the forecast, click on the drop-down arrow in the center of the Forecast data block.

2. Select Private from the drop-down list.
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l The Shared forecast option automatically defaults in the drop-down selection

l You can also send a copy of the forecast to one or more team members

l Select Cancel on the Send a copy to dialog box, and then select Save on the Manage access
dialog box
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l Selecting Private access removes access for all team members

l Change the shared forecast name by clicking in the Forecast name field and typing in a
new name
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l Selecting Refresh from live lets you restore forecast values from the live forecast
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You can send forecasts to multiple people at once, by searching for and adding
people to the list before clicking Send.

6.5.4 COMPARE FORECASTS

You can compare forecasts by inserting the Forecast Delta data block in your view and selecting two
forecasts from the data block title bar to compare.
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You can use all columns in the Forecast Delta data block to compare the live and saved forecasts.

COMPARE FORECASTS

1. Select the Add data block button on the top right-hand corner of the Control Workspaces page.

2. In the slide out panel on the left, select the Forecast Delta data block and drag it beside the
Forecast data block.
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3. Using the drop-down menus on the Forecast Delta data block, select both the first and second
forecasts in their respective drop-down's.

6 . 6 T IME PHASED FORECAST ING

Projects are typically overwhelmed by escalating forecast values as the project progresses. What the
business thought they were going to spend doesn't end up being very accurate at the end of a project.

One way to mitigate this is to take the forecast and break it down into more consumable, estimate
related time blocks/periods, as shown in the screenshot below. This prompts the project engineers to
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think about what activities, bills, and costs are going to occur in smaller more mentally digestible time
periods.

Projects need to spread their estimate by periods to verify forecast accuracy vs. the actuals spent
within that period. One of the key goals of time phased forecasting is to see when you are forecasting
to spend allocated budget. You can then determine how accurate your forecast was versus the actuals
spent within that period. Based on forecast accuracy, this gives you the opportunity to make manual
adjustments within the Time phased forecasting register. It also provides the ability to have the system
automatically distribute the forecast for you based upon certain criteria.

TPF gives you visibility into when you are going to spend dollars associated to a cost item in  monthly
time periods. TPF also helps with cash flow, enabling customers to provide more insight into how much
money they need to pay employees and other bills.

After selecting a cost item from the CBS, TPF can be accessed from Control > Workspaces > Actions >
Time phased forecasting. This is only if the project settings for TPF is enabled under the Forecast
section.

The table below shows the columns from the Time Phased Forecasting page.
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Resource Description

1 Auto Distribute
remaining forecast
based on cost
curve and start/end
dates

This will automatically distribute remaining forecast based on the
cost curve being used, in addition to the Start and Finish dates.

2 CBS position The CBS position identifier number.

3 Description The description of the CBS.

4 WBS Phase code Work Breakdown Structure code number.

5 Start This is the scheduled start date for the cost item.

6 Finish This is the scheduled finish date for the cost item.

7 Cost Curve This is a graph/calculation of the costs of production as a function
of total quantity produced. Cost curves can be created, viewed
and maintained in Settings > Control > Schedule, in the Cost
Curves section on the page.

8 Forecast method Forecast methods include: Current Budget, Current Estimate,
Average Performance, Manual (EAC), None, and Rollup.

9 Forecast remaining
cost

This is the unsettled balance of forecast. Cost that is projected to
still be required to be paid out (varies depending on forecast
method).

10 Forecast final cost Total cost to date + Forecast remaining cost, cost item projected
total cost at completion.

11 Phased Forecast
Remaining Cost
Delta

This is the remaining forecasted cost that has not yet been
allocated to a monthly period. It is the difference between the
Forecast remaining cost and the sum of forecasted cost currently
represented in all remaining months on the TPF window.

12 Load more This will load additional month columns to view in the TPF
window.

Overview – Time phased forecast
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Resource Description

13 <date> cost The forecasted cost projected to be incurred during that individual
month.

Overview – Time phased forecast (continued)

There is a Load More column that exists in the middle/top of the page. When selected,
additional monthly time buckets will be added to the page.

6.6.1 TPF REGISTER

The Time phased forecasting register allows you to time phase auto spread forecast remaining costs,
which are based on cost curves, and start/end dates. You can alsomanually override specific months
and change the distribution costs.

For example: you have $250,000 to spend on a cost item (Forecast remaining cost). You can use Time
Phased Forecasting to spread your dollars into monthly allocation buckets. This can be done by
automatically spreading the $250,000 forecast, or by manually overriding the forecast and entering
your own values into the monthly buckets.
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6.6.2 AUTO DISTRIBUTE

The Auto distribute icon allows you to have the system automatically allocate remaining forecast as
determined by your Actual Start date, Actual Finish date, and Cost Curve.

The Auto distribute icon allows you to automatically distribute dollars into monthly allocation buckets.
In this case, the allocating of dollars will begin on the Start date of May 2020 and stop allocating on
Finish date month of October of 2020.

6.6.3 MANUAL TIME PHASED FORECAST

Using the same example, it’s also possible to manually forecast the allotted $3,000 into your desired
monthly buckets. By manually entering in $400,000.00 into the Oct 2020 bucket, your Phased forecast
remaining cost delta changes to $135,714.29. This represents the remaining amount of dollars to still
be forecasted.
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On the right side of the screen, a blue circle displays by the forecast quantity when a manual override
to the forecast quantity is performed. If you hover over the blue circle, it shows a description of the
manual override.

On the left side of the screen, a manual override to the forecast amount shows a warning symbol by
the cost curve. Hovering over the warning sign shows that the cost item contains a manual change to
the time phased months, and thus, the cost curve is no longer accurate.

6.6.3 .1 PROPORTIONAL MAN HOURS AND QUANTITY

In addition to Cost, Man hours and Quantity displays on the Time phased forecast grid. If you manually
adjusted the cost for one of the months in the grid, a dialog box appears asking to proportionally
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adjust Man hours and the Quantity.

If for example you doubled your cost in the Time phased forecast, it would also proportionally double
your Man hours or Quantity. You can view the values that the man hours and quantity would
proportionally adjust to in the read only cells.

If you manually adjusted Man hours or Quantity in the Time phased forecast grid, a dialog box appears
asking to proportionally adjust cost and man hours .
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Both dialog boxes have the option to adjust proportionally without showing the message again. If you
selected this option and want to revert settings back to see the dialog again, in the Time phased
forecast grid, go to the Settings icon and select Enable dialogs.

In the Time phase forecast grid, you can also select to export to Excel.
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Selecting this exports everything that is in your view to an Excel spreadsheet.

6.6.4 STATIC MANUAL TIME PHASED FORECASTING
(TPF)

Static manual TPF lets you distribute a time phased forecast in the future without causing a
redistribution. All values entered in the TPF are constant, and any deltas based on current month
actuals that do not equal what was forecasted for that month, must be spread manually.

To enable the static manual forecast method, the Forecasting and Push time phased forecast to Live
forecast toggles must be set to On in Settings > Control > Forecast.
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The static manual forecast can be enabled on the Time phased forecasting page by first making a
change to any of the distribution fields. After you click the Publish button, the Push these values to the
Live forecast dialog box opens. When the Do not redistribute manual spread check box is selected, the
values entered in whole months remain as-entered and are not automatically redistributed when
actuals are incurred or months close.

The forecast method for the CBS record automatically changes to static manual TPF, and the forecast
remaining cost and forecast total cost changes based on the distribution amount adjusted in TPF.

If costs are claimed for the CBS item, the forecast total cost remains the same, but the forecast
remaining cost is reduced from the claimed actual quantity.
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In TPF, the claimed amount now shows the phased forecast remaining cost, which represents the
remaining amount that still needs to be spread. The phased forecast remaining cost now must be
deducted somewhere from the TPF distribution.

6.6.5 TIME PHASED FORECAST SETTINGS

Time phased forecast can be turned on in Settings > Control > Project Settings, in the Forecast section
of the page.

If the setting is turned off, you will not see the Time phased forecasting option in the Actions drop-
down, CBS tab, in the Control > Workspaces page.
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6.6.5 .2 ENABLE TIME PHASED FORECASTING

6.6.5 .3 COST CURVES

Cost curves determine the proportion of money to be expended in a certain period of time. In the case
of Time phased forecasting, the type of cost curve being used determines how forecast will be spread
across the monthly forecasting buckets.

In addition, the fiscal calendar also influences how the forecast is spread.

Cost Curves are found in Settings > Control > Schedule, in the Cost Curves section of the page.

By selecting a Cost Curve and selecting the View icon, you can view its default distribution.
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In this case, the Linear Cost Curve settings displays the cost curve durations and values.

For example, using a Linear Cost curve, with a Start Date of 05/12/2020, the Forecast Remaining cost is
$3,000,000.00, with a Phased forecast remaining cost delta of $0. This means that you are forecasting
to spend $3,000,000.00, and your Phased Forecast Remaining Delta is zero because your Time Phased
Forecast is now fully met (you have fully forecasted $3,000.000.00).

Since your scheduled Start date is 05/12/2020, the system will start forecasting money on this cost
item in May. Based on the Linear Cost curve and the fiscal calendar it will stop forecasting money in
October 2020. This is based off your scheduled Finish date of 10/26/2020. Over the period of 6
months, your spend is totaling 3,000.000.00.
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6.6.6 TIME PHASED FORECAST PREREQUISITES

There are certain requirements for a cost item to be eligible for time phased forecasting.

1. The Schedule data block must have a Start and Finish date.

2. The Schedule data block must have a Cost curve association.

6.6.7 TIME PHASED FORECAST VIEW

You may want to create a View in your Control Workspace similar to this one showing a Time Phased
Forecast in comparison with the Live forecast. This shows the hours you are forecasting to spend
money (TPF) vs. the Live forecast.

The following steps walk you through how to plan Time phased forecasting.

TIME PHASED FORECAST PLANNING

1. To start time phased forecasting, on the CBS tab, select your pre-determined CBS items as
shown below.
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2. Select Time phased forecasting from the Actions menu.

l This action opens the Time Phased Forecast window, where you can see the CBS on the
left side of the screen, and its associated forecasting monthly allocation cost buckets on
the right

3. For one of your cost items, type in $500 in one of the monthly bucket fields.
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l Notice how the field now has a blue circle next to the $500.00. If you hover over it, you see
the value before, after, and the date the change was made

l Because of the manual adjustment, a warning sign appears on the Cost curve for this cost
item. The cost curve is not being changed to manual, but the system records that this cost
item is no longer linear, because it has been overridden

l The override made to this cost item is no longer needed, and you now decide you want to
revert to its original setting, and have the system Auto distribute the forecast

4. Make sure your cost item is checked, then select the Auto distribute icon.
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l This action will revert the time phase values back to the same numbers as they were prior
to any manual adjustments, plus:

a. It will erase any manual adjustments

b. It will distribute the remaining forecast values based on cost curve and start/end
dates of that specific cost item, as determined by the fiscal calendar

l The result of selecting the Auto distribute icon starts its forecasting spread on the cost
item’s Start date of 05/12/20, and will Finish its schedule on 10/26/20

It is important to remember the purpose of utilizing Time Phase Forecasting is to
see how you are forecasting to spend money over a period of time. The
expectation is to get the forecast adjusted to where it should be, and update costs
as needed.

6.6.8 TIME PHASED FORECAST MICROSOFT EXCEL
IMPORT

You can import a Microsoft Excel file to update the values in Time Phased Forecast by selecting Import
on the Time Phased Forecast page to download the time phased template. To import time phased
forecast values, you can download a template as shown in number 2 in the image below to use as a
guide to import your new time phased forecast values. The same format provided in the download
template is required for the import to be successful.
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The Excel file includes the cost items that are in your current Time Phased Forecast view. Columns in
orange are required, columns in yellow are optional to change, and columns in grey are ignored and
cannot be changed. When you are finished making your Excel changes, you can then import the Excel
file into Control to update the Time Phased Forecast with your new values. Column header names are
ignored if changed.

Updates are made when you select Publish. Excel imports are shown in the Import History Audit Log,
where you can download the Excel file to see a list of errors if the process fails.
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TIME PHASED FORECAST MICROSOFT EXCEL IMPORT

1. To start time phased forecasting, on the CBS tab, select your pre-determined CBS items as
shown below.

2. Select Time phased forecasting from the Actions menu.
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3. Select the Import icon.

4. Click Download time phased template.

5. Adjustment any of the fields under the yellow columns. For example, for CBS position 2.3,
change the February 2024 Cost from 13.62637329 to 9, then save your changes.
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6. Select the Import icon again.

7. Select Browse, and then navigate to the Excel file you just saved, then select Open.

8. Select Import.
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6.6.9 COLUMN CHOOSER

When you open the Time phase forecast, a column chooser has been added to the grid.

After you choose which columns to show, the left side of the grid updates with your selection.

InEight Inc.  |  Release 25.5 Page 309 of 572

Control User Guide 6.6 Time Phased Forecasting



On the right of the grid, you can also adjust your view for each month's Cost, Man hours, and Quantity.
This can be done using the drop down next to the month and deselecting the options you do not want
to see on your grid.

If you select cost from past dates, the data is read only.

6.6.10 AUDIT LOG

All changes made within TPF are captured in the Audit log within Control Workspaces. The Audit log
captures changes based on any changes made to a forecasted CBS item.

In the example, it shows that a forecasting value was changed on 08/13/19 for Audit ID 232. The
forecasting value had been changed from 89.36 to 100.00 for the Aug ’10 remaining cost time period.

6 . 7 PUSH TO L IVE FORECASTS

As mentioned above, the Live Forecast is the official forecast used for financial reporting and shared
with all members of the project.

You can push forecasts entered in the Forecast data block to the Live Forecast either individually or by
selection. This allows you to send only the items that you choose from your forecast to the Live
Forecast.
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The Live Forecast can only be updated if the user is assigned the appropriate role with the associated
permissions. Project Admin or Power User can edit the Live Forecast directly.

Forecast changes made in the Forecast data block WILL NOT be pushed to the Live
Forecast without an additional action detailed in the Step by Step below.

Changes made to your Forecast are only seen by you, unless you share them with
someone else (see topic 9.4 Forecast Management) or update them to the Live Forecast.

PUSH LIVE FORECAST BY SELECTION IN THE CBS TAB

1. From the CBS tab with the Forecast data block in the view, select a group of cost items, by
clicking the row header check boxes.

2. Click on the drop-down arrow in the center of the Forecast data block.

3. Select Push to Live Forecast.

The Push to Live Forecast option is disabled until you select one or more cost items.

4. After review, select Yes and your forecast values will push to the Live Forecast.

6.7.1 TIME PHASED FORECAST PUSH TO LIVE

The time phased forecast feature lets you make edits in your time phased forecast. You are then able
to push those edits to your live forecast.

You can edit your total forecast remaining cost and forecast remaining hour values in the Time phased
forecast window. It would then override your forecast remaining cost and your forecast remaining man
hour if there is a change.

The Time phasing Forecasting option must be enabled first in order to have the Push Time phased
forecast to Live option available to be enabled. Enabling only the Forecasting option does not
automatically enable both.
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The Time phasing section can be located in the Project Settings of Control under the Project tracking
tab.

When you have enabled both options under the Time phasing section click save. Then go back to the
CBS tab.

Follow these step by steps to use a time phased forecast push to live.

TIME PHASED FORECAST PUSH TO LIVE FORECAST

1. Select cost items from the CBS tab with a Forecast remaining cost to use in the push to live
feature.

Make sure the cost items you selected have start and end dates. Otherwise you
cannot edit them in the Time phased forecasting window.

2. From Control's CBS tab, select the Actions tab. Then select the Time phased forecasting
option.

3. In the third data block where it has the Month and Year, scroll to the Remaining cost. Now move
the scroll bar over to January of 2021.
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4. If you believe the line item could take up more time and money, you can adjust the Cost and
Man hours for the following month. These changes will then be added to the phased forecast
remaining columns once you push to live.

Quantity will show as changed with a delta next to the column. Currently, you
cannot push quantity updates to live.

5. When you have made all the changes you need, select the cost items you want to push to live.
You can either select one or all.

6. Dialog appears asking if you want to push these values to the Live forecast. Select Yes to
continue. The Cost and Man hours difference shows in the orange columns.
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7. When this is pushed to live, your Forecast remaining cost and Forecast remaining man hour
should update in the Live forecast. Your Forecast Method will then change toManual ETC.
Manual ETC will have a green dot indicator that states it was pushed from Time phased forecast
when you hover over the item.

The Forecast remaining cost and Forecast remaining man hour columns will have an orange
wedge indicator that shows you which values have been updated manually changed when you
hover over the indicator.

6 . 8 F ISCAL CALENDAR

InEight Control has built in settings that automatically set the actuals in the forecasting-related data
blocks to match your company’s month end calendar. This allows you to hold the actuals at a certain
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cutoff date to allow for forecasting to be done based on month end actuals.

These fiscal calendar settings include a suspended period for you to finalize your forecast numbers
without incurring any new actuals.

During this suspended period, your numbers are “frozen”, allowing you to finish month end reporting
without worrying about the numbers changing. Any new actuals accumulated during the suspended
period will populate once the suspended period is over.

You will note that the Live forecast data block contains a label in its header called “This Month”.
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This label reminds you that the values in the live forecast data block are only for the current month, as
defined in the Organization Settings under Fiscal Calendar (see Lesson 3 – Project Setup).

VIEW FISCAL CALENDAR SETTINGS

1. From the Project home page of the your job, select Settings from the left side menu.

l You can also access settings from the first-level menu or by clicking on the View project
settings tile on the home page

2. On the resulting Project Settings page, click on the Fiscal Calendar tab.

Page 316 of 572 InEight Inc.  |  Release 25.5

6.8 Fiscal Calendar Control User Guide



InEight Inc.  |  Release 25.5 Page 317 of 572

Control User Guide 6.8 Fiscal Calendar



In this section, you can define the following fields (if you have the appropriate access):

Field Name Purpose

Week ending day Determines which day of the week is the last day.

Financial year
start month

Allows the financial year-end to be different from the calendar year-
end.

Month end day Determines what the last day of the month is.

Last weekday Sets the day for the above setting.

Financial period
closing day

Allows you to set the financial period to end on the same day or
allow a period to close out the finances.

Month end plus
days

Sets how many closing days.

Financial period
closing time

Establishes the time when the Forecast data block actuals will be
reset to the next period.

Closing time zone Sets the closing time zone.

6.8.1 FORECAST EQUATION UPDATES TO CURRENT

The actual numbers claimed are periodically synced. The date of actuals which apply to your forecast
can be seen in the Data Block Header.

The fiscal settings in Platform determine when actuals for the period will be synced.

6 . 9 L IVE FORECAST SNAPSHOTS

When you sync your live forecast, Control creates a snapshot. After that sync has been completed,
everything in your live forecast is captured and saved in a snapshot for that month. As soon as the
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month ends, the most recently synced items in the live forecast, is your snapshot for the month.

In the live forecast column, select the drop-down menu to show the live forecast snapshots. The
snapshots saved are labeled with the month and year they were created.

You can view the current live forecast for the month. For existing projects, cannot snapshot previous
months.

For example, if you select a previous snapshot such as January, it loads into your live forecast. You can
put in any columns you want to organize the view. If you do have a column in your view that is not a
live forecast type (such as open/remaining committed cost and total committed cost), those columns
show as blank and disabled. This occurs because the snapshots only capture the live forecast values.
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All columns from past live forecast snapshots are read-only. You cannot change anything that has been
calculated in the past snapshots. A warning icon with a tool tip also appears in the column header.
Hover over it to show the warnings.

When you load an old snapshot, the CBS hierarchy does not rearrange to show how the live forecast
previously looked when that snapshot was taken.

The Forecast cost G/L change column shows you what has changed between last month and this
month for your gain loss values.

Page 320 of 572 InEight Inc.  |  Release 25.5

6.9 Live Forecast Snapshots Control User Guide



The Forecast cost change column calculates the difference between the Forecast final cost and the
previous month's Live Forecast final cost.

Green coloring for the numbers indicates an increase in forecast cost change between the two months.
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EXERCISE 6.1 — FORECASTING

Now that you have covered all the functions of forecasting, it is time to perform your own forecasts.
Utilizing the forecasting methods you have learned, practice creating forecasts as indicated below.
You can use your own project (if available) or the training project used in this lesson.

1. From the Control main page, select the CBS tab.

2. Change to a view that contains the Forecasts data block.

3. Save a new forecast.

4. Update the forecasts of cost items of your choice to practice using each of the following
Forecast Methods:

l Current Budget

l Average Performance

l Manual EAC (based on costs or hours)

5. Send your forecast to a person.

6. Note the differences.

Congratulations, you have completed this exercise!
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REVIEW

1. How is the Current Budget Forecast Method calculated?

a. Forecast Total Cost = Current Budget

b. Forecast Total Cost = As-built Total Cost + (Current Budget Unit Rate * Current
Budget Remaining Qty)

c. Forecast Total Cost = As-built Total Cost + (Current Budget Unit Rate * Current
Estimate Remaining Quantity)

2. How does the Live Forecast receive updates?

a. They happen automatically

b. Push to live forecast from the Forecast data block title bar drop-down

c. Push to Live Forecast from the Actions drop-down menu

d. Viewed in the CBS change log

3. Who can a forecast be sent to?

a. Project Manager

b. Project Engineer

c. It automatically goes to everyone

d. Anyone you add to the list

4. Which data block do you use to compare forecasts?

a. Forecast

b. Forecast Delta

c. Forecast Comparison

d. Live Forecast

5. The fiscal calendar settings for Live Forecast are located under:
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a. Organizational Breakdown Structure

b. Account code structure

c. Operational resources

d. Project settings

SUMMARY

As a result of this lesson, you can:

l Differentiate and utilize InEight forecasting methods

l Manage forecasts

l Manage Time Phased Forecasting

l Push to Live Forecast

l View the Fiscal Calendar settings
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l Explain the change management process

l Complete a cost budget move

l Complete a quantity budget move
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l Describe the change order approval process
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7 . 1 INE IGHT CONTROL WORKFLOW – CHANGE
MANAGEMENT

7 . 2 CHANGE MANAGEMENT OVERV IEW

Changes can happen during all phases of a project. There will likely be modifications to quantities,
design, schedule, and/or cost. You will need to manage changes that have been identified and
determined to have an impact to the project. It is also vital that you have a way to compare the project
from its original plan with all the changes that have affected the project.

For your sample project the Steel Structure Training Job, you will perform three different types of
changes to the budget:

l Budget Move (Net Zero Dollar Move)

Options:
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1. Associated Budget Move – define budget moves with a From and To process to provide
ultimate traceability of budget moves.

2. Non Associated Budget Move – define budget moves freely to provide the most flexibility.
A quicker way to perform a budget move.

o Budgeted dollars are moved from one cost item to another, without changing the
overall budgeted price

o Can change MH/QTY and Unit Costs of the cost item

l Quantity or Man-Hour Adjustment

l Adjust values for quantities or man-hours applied to a single cost item

l Can change MH/QTY and Unit Costs of the cost item

l Contract Quantity Adjustment

l Adjust budget to capture changes in work scope (quantity)

l Adjust dollars from existing or new pay items

l Allows “locking” of Total Price, Unit Price, or Pay Quantity

When you perform a budget move, contract adjustment, or budget quantity and man hour adjustment,
you can select a maximum total of 250 cost items or 100 pay items. When you exceed the maximum,
the Budget move and contract adjustment option in the Actions menu drop-down becomes
unavailable. This improves the speed, reliability, and performance of the change order.

7 . 3 ASSOC IATED BUDGET MOVE (NET ZERO
DOLLAR MOVE)

During a project, you may encounter changes that result in a budget move which adds no additional
budget to the total project budget. For example, you may decide to change the means and methods
for completing an operation which results in moving budget from one operation to another.
Performing a budget move allows you to accurately track budget changes to maintain a clear history
and ensure costs moving forward are accurate.
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Scenario

In the example structural steel scenario, the Original Budget for Erect Steel – Light that was
initially carried from Estimate to Control has been found to be in excess, and a portion of this
budget’s dollar value needs to be moved to your newly created cost item,Module [your User
ID#] - Erect Steel Heavy.

It is important to remember that Current Budget cost and man-hours are only maintained at the
terminal level, and you cannot move cost to/from a parent cost item. You can move dollar values
between multiple cost items at the same time.

You can match CE from CB only in a non-associated budget move and in a cost items first
contract adjustment.

InEight Control contains a Budget Move Wizard that walks you through the following steps for
performing a budget move:

1. Select From & To Items

2. Define Relationships

3. Assign Amounts

4. Adjust Cost Categories

5. Summary (submit to pending)

The following Step by Step walks you through how to perform a net zero-dollar Budget Move in the
tool.

PERFORM A NET ZERO DOLLAR ASSOCIATED BUDGET MOVE

1. Hover over the Actions drop-down menu, hover over Budget move & contract adjustment, then
select Budget move.
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l The Budget Move – Details window appears

l The Details window can be used to enter any relevant information, but is optional

2. The default budget move workflow is Non-Associated. Select the Associated radio button.

3. Type 001XX (where XX are your initials) in the Issue # free text box.

l The Issue # is a text field used solely for informational purposes

4. Type Spread budget from Light Steel to Module Heavy Steel in the Description text box.
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5. Click Next.

l The Select From & To Items tab appears

6. Select a cost item from the task list on the left.

7. Select a cost item from the task list on the right.

8. Click Next.

l The Define Relationships window appears

l The Define button allows you to select what type of relationships the two cost items share

9. From the Define button, click on Select All.

l The Cost category, Qty or MHr only option allows you to modify only the budgeted values
of the “From” cost item, similar to the Budget Quantity & Man-Hour Adjustment option
from the Actions menu

l Selecting the Budget move with Cost category, Qty or MHr to option allows you to move
budgeted values of the “From” cost items to the “To” cost items

10. Click OK to close the Define window.

11. Click Next.
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l The Assign Amounts window appears

l From this window, you will assign amounts to be moved from one cost item to the other

l The CB Total Cost and CB Total MH values entered under the To: section automatically
deduct from the equivalent fields in the From: section

l CB Total Quantity values entered under the To: section do NOT automatically deduct from
the From: section because you could be moving between cost items with differing units of
measure

You have the option to either manually or automatically deduct the CB-Total MH. If
you select “Advanced options” you can specify whether man-hours automatically
deduct or not.

12. In the To: section of the window, enter 10,000 in the CB-Total Cost field.

13. In the To: CB-Total MHrs, enter 100.00.

14. In the To: CB-Total Quantity enter 20.00.

l Note that the equivalent costs and man-hours deduct automatically from Erect Steel –
Light, but NOT the CB Total Qty

15. Enter -20.00 in the From: CB Total Qty field.
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16. Click Next.

l The Adjust Cost Categories window appears

l From this window, you can assign your pending budget changes to existing and new cost
categories of your cost item

17. Click the Add cost category link.

18. SelectMaterials on the resulting pop-up window, then click OK.
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19. In the To: field for Materials, enter 10,000.00.

20. Change the To: Labor field to 0.

l The values shown in the Available and Totals fields will auto-adjust based on the values
entered in the To: Pending fields

21. Click Next.

l The Summary window appears
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22. Review your proposed changes, then click Submit to send the Contract Adjustment for approval.

l This budget move is now listed in the project’s Change Register with a status of Pending

Later in this lesson, you will learn how to approve and modify budget changes from the Change
Register. These changes will not reflect in the Current Budget until the contract adjustment is
approved.

7.3.1 BUDGET MOVE WITH A SINGLE COST ITEM

In other times during your project, you will encounter changes that have the potential to cause a move
in your budget within the cost categories of a specific cost item. For example, you may find that some
items that you estimated to be self-performed work may be faster and cheaper if they were
subcontracted out. Therefore, you can perform a budget move for a single cost item and redistribute
the budgeted cost between different cost categories.

Scenario

In the example structural steel scenario, the Original Budget for a cost item needs to be moved
from the Labor cost category to the Subcontract cost category. This estimated self-performed
work will now be subcontracted work because this cost item is not our specialty and it would take
us longer and be more expensive for us to self-perform this work rather than a specialty
subcontractor whom is faster and cheaper.
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The following Step by Step walks you through how to perform a 1:1 Budget move within a single cost
item in the tool.

PERFORM A BUDGET MOVE WITHIN A SINGLE COST ITEM

1. Select the Actions drop-down menu, hover over Budget move & contract adjustment, then
select Budget move.

l The Details window appears

l Select the Associated budget move workflow radio button

2. Type 002XX (where XX are initials) in the Issue # free text box.

l The Issue # is a text field used solely for informational purposes

3. Type Move cost from self-performed to subcontracted in the Description text box.

4. Click Next.

l The Select From & To Items window appears

5. Select a cost item from the task list on the left.

6. Select a cost item from the task list on the right.
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7. Click Next on the dialogue box to continue.

l The Define Relationships window appears

8. From the Define button, select Cost category, Qty, or MHr adjustment only.

l Selecting the Cost category, Qty, or MHr adjustment only option allows you to move
budgeted cost category values within a single cost item

9. Click OK to close the Define window.

10. Click Next on the bottom right of the budget move screen to continue.

l The Assign Amounts window appears

11. Click Next on the bottom right of the budget move screen to continue.

l The Budget Move – Adjust Cost Categories window appears

l From this window, you can assign your pending budget changes to existing and new cost
categories of your cost item
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l Note: We will skip the Assign Amounts window section because we are not changing the
Mhrs or Quantity

12. Click the Add cost category link.

13. Select Subcontract on the resulting pop-up window, then click OK.

14. In the To: field for Labor, enter -50,000.00.

15. In the To: field for Subcontract, enter 50,000.00.

l The values shown in the Available and Totals fields will auto-adjust based on the values
entered in the To: Pending fields
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16. Click Next.

l The Summary window appears

17. Review your proposed changes, then click Submit to send the Contract Adjustment for approval.

l This budget move is now listed in the project’s Change Register with a status of Pending

7.3.2 NET ZERO BUDGET MOVE FROM CHANGE

You can also perform a zero-budget move from Change which ultimately creates a budget move in
Control.

7.3.2 .1 CHANGE ATTRIBUTES

When you create a budget move in Control, all the attributes that were setup in Change now flow into
Control automatically.
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7 . 4 NON-ASSOC IATED BUDGET MOVE

The Non-Associated Budget move is a quicker way to complete a budget move compared to the
Associated Budget move type. Within the Budget Move screen, the Non-Associated method consists of
a two-step process, as compared to the six-step process within the Associated method. The two steps
in the Non-Associated method are the Details and Assign Amounts steps.
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7.4.1 NON-ASSOCIATED BUDGET MOVE
PREREQUISITES

Prior to performing a budget move, you can change the Current Estimate (CE) to what you want your
Total budget to be. Then, you can go into your budget move and match the Current Budget (CB) to the
CE. This can be accomplished by using the auto calculate icon in the Budget Move Screen, which is
discussed later in this topic.

Within the CBS, you can edit the CE fields directly within the CBS grids. You can also navigate into the
cost item’s cost categories to make the adjustments. This is not a required prerequisite, but a best
practice. Depending on the contract type it is often ideal to have the Current Estimate equal the
Current Budget.

In the CBS, the 2 columns that should match are the CB total cost and CE final cost.

If you know that a change order is on its way, you can modify the CE to accommodate for the incoming
budget adjustment.

7.4.1 .1 AUTO CALCULATE ICON

Cost Item Management lesson
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Set up the CE values in the CBS before entering a contract adjustment/budget move, then select the
icon and in the dialog and choose whether you want to update the Adjusted CB cost, man hours,
and/or quantity, and then select Apply.

This updates the Adjusted CB total cost and/or Adjusted CB total Mhrs and/or Adjusted CB total qty to
match the corresponding Current estimate values.

You can match CE from CB only in a non-associated budget move and in a cost items first
contract adjustment.

You can only use the auto-calculate icon to impact budget (after already setting up your current
estimate values/forecast).

You cannot edit any of the CB values.

7.4.2 MANUAL TOTAL COST BUDGET MOVE

After selecting the Non-Associated budget move option, then clicking on Next, the Budget Move
screen appears. From this screen you have the option of moving the Current Budget from one cost
item to another. You can also move cost from one cost item to multiple cost items. When first entering
the Budget Move screen, any of the blank ‘Adjusted CB’ related fields are editable fields.

In the below example, under Adjusted CB total cost, $5,000 is about to be moved from cost item 5.1
into cost item 5.3. This can be done by manually entering a negative $5,000 in the Adjust CB total cost
for cost item 5.1, then entering in a positive $5,000 for cost item 5.3. With the appropriate
permissions, you have the option to either Approve or Submit this budget move. You can also Cancel,
save as a Draft, or select Back to take you to the previous screen.

The subtotal at the bottom shows the Adjusted CB total cost at $0. This is because we are removing
and adding the same amount of dollars from one cost item into another.
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In the below example, the Approve and Submit icons are disabled. This is because an adjustment is
being made to one cost item for $-5,000, but there hasn’t been an adjustment made to other cost item
(s) for $+5000. Once the adjustment has been made to add $5,000 to a cost item, the Approve and
Submit icons will be enabled. The Adjusted CB total cost must equal zero on the Subtotals line.

It’s also possible to spread the Adjusted CB total cost amongst several cost items. In this example,
$5,000 is being taken from cost item 5.1, cost item 5.2 is adding $3,000, and cost item 5.3 is adding
$2000. Both the Approve and Submit icons are enabled because the entire $5,000 is being taken from
cost item 5.1 and allocated to other cost items. If the $5,000 were to be allocated disproportionally,
then both the Approve and Submit icons would be disabled.
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7.4.3 MANUAL COST CATEGORY BUDGET MOVE

Within the budget move screen, you also have the option of editing a cost item at the Cost category
level by right clicking on a cost item.

After selecting Cost category, a grid displays with the cost item’s cost categories, much like it shows in
the CBS. You have the option to move the $3,000 from the Materials cost category to a different Cost
category, such as Labor.
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Not only has the $3,000 moved from Materials to Undefined Labor, but the Adjusted CB total cost and
Adjusted CB labor total cost remains at $3,000 for this cost item.

Alternatively, you have the option of first populating the Cost categories with values, as opposed to
entering values directly in the Budget Move screen.
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7.4.4 UPDATE CURRENT ESTIMATE VALUES BASED ON
CURRENT BUDGET ADJUSTED VALUES

You can update your current estimate values based on the adjusted current budget values for contract
non-associated budget moves.

In the Assign Amounts step of the Non-associated budget move wizard, you can add the following
columns from the Column chooser that show how the current estimate values are based on the
adjusted current budget values:

l Cost source

l Update CE total cost

l Update CE total MHrs

l Update forecast (T/O) qty

l CE total cost

l CE total MHrs

l Forecast T/O qty

l New CE total cost

l New CE total MHrs

l New forecast (T/O) qty

The check boxes under the Update CE total cost, Update CE total MHrs, and Update forecast (T/O) qty
let you opt to update the current estimate based on what is adjusted in the current budget after the
budget move is approved.
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In a non-associated budget move, the Update CE total cost and Update CE total MHrs
check boxes are active for plug cost source only. They cannot be edited for Detail cost
items because cost is driven by your associated resources.

For example, if the Adjust CB cost is $500, $500 is added to the CE total cost after the contract
adjustment is approved if the Update CE total cost box is checked. You can preview the results in the
New CE total cost, New CE total MHrs and New forecast (T/O) qty columns.

You can select multiple cost items to update the Update CE total cost, Update CE total MHrs, and
Update forecast (T/O) qty columns in mass by selecting the Update CE from CB option in the Auto-
calculate feature.
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To have the Current estimate cost, man-hours, and quantity check boxes selected by default to be
updated with adjusted Current budget cost, man-hours, and quantity values when doing change
orders, you can switch the Default CE values to be updated from CB values toggle to ON in Settings >
Control > Project Tracking.

When the setting is enabled, all applicable check boxes are selected. This is a quick way to keep CE and
CB values in sync without having to double enter values.

You can match CE from CB only in a non-associated budget move and in a cost items first
contract adjustment.
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For more information, see the Default CE values to be updated from CB values section in Tasks
settings.

7.4.5 BUDGET MOVE APPROVE/SUBMIT

After making the desired budget moves, you can select the Approve icon with the appropriate
permissions. After approval, a toast message appears at the top of the screen confirming that the
budget move is approved.

The system then automatically takes you to the Change Register, where you can see the approved
budget move record.

There is also an option to select the Submit icon from the Budget Move screen, which will place the
budget move into a Pending status in the Change Register.

7.4.6 BUDGET MOVE CHANGE REGISTER

After approving or submitting a budget move, you are now in the Change Register. The Non-Associated
budget move that was just approved in the Budget Move screen, is now in Approved status.

After single clicking on an ID, the budget move details screen appears which shows the Adjusted CB
changes that were made within the Budget Move screen. Below you can see the $5,000 being
deducted from the first cost item and moved into the last two cost items. Adjustments have also been
made to the Adjusted CB total MHrs for all 3 cost items.
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Scenario

In this scenario, you need to move $1,000 from the Current budget from one cost item's budget
to another cost item's budget, in a timely manner. To save time, you need to approve the budget
more quickly, as you also have the appropriate permissions to perform this task.

PERFORM A NON-ASSOCIATED BUDGET MOVE

1. Select two cost items from the CBS.

2. Select the Actions drop-down menu, hover over budget move and contract adjustment, then
select Budget move.

3. Select the Non-associated radio button.

4. Name the Issue #.

5. Click Next.

6. Enter a dollar value for the first cost item by double-clicking in the Adjusted CB total field.

7. Enter a negative dollar value for the second cost item by double-clicking in the Adjusted CB total
cost field.
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8. Click Submit.

7 . 5 BUDGET QUANT ITY / MAN-HOUR
ADJUSTMENT

During the course of a project, it is typical to have scope modifications that warrant changes to
quantities and/or labor hours.

It is important to remember that changing man-hours or quantities will affect budgeted values of
MH/QTY, QTY/MH, and Unit-Costs, but will not change the overall dollar value of your budget.

InEight Control contains a Budget Quantity / Man-Hour Adjustment Wizard that walks you through the
following steps for performing a quantity and/or man-hour adjustment:

1. Select Items

2. Assign Amounts (quantities, man-hours, or both)

3. Summary (submit to pending)

The following Step by Step walks you through the process for performing a budget quantity
adjustment:

PERFORM A BUDGET QUANTITY / MAN-HOUR ADJUSTMENT

1. Select the Actions drop-down menu, hover over Budget move & contract adjustment, then click
Budget quantity & Man hour adjustment. 
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l The Budget quantity & Man Hours adjustment – Details window appears

2. Type 002XX in the Issue # free text box (where XX are your initials).

3. Type 002XX in the CCO (Contract Change Order) text box (where XX are your initials).

4. Type Tonnage increase due to material change in the Description free text box.

l It is recommended that each budget adjustment have a concise description of why the
adjustment is needed

5. Click Next.
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l The Select Items window appears

6. Select the a cost item from the tasks list.

l You can select more than one cost item to adjust, however these changes will be
grouped as a single line item in the Change Register

7. Click Next.

l The Assign Amounts window appears

8. Enter the change to the man-hours or quantities into the appropriate field. For this example,
type 5,000 in the Quantity field.
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9. Click Next.

l The Summary window appears

10. Review your changes, then click Submit to send them out for approval.

l This budget move is now listed in the project’s Change Register with a status of
Pending

Later in this lesson, you will learn how to approve and modify budget changes from the Change
Register.

7 . 6 CONTRACT ADJUSTMENT

A contract adjustment, often referred to as a Change Order, represents a change to the total project
budget. If you are a contractor this also results in a change to total contract price.
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7.6.1 PAY ITEM VS. COST ITEM

Contract adjustments involve changes to both your contract price (pay items) and your budget (cost
items). To avoid confusion, the following table reviews the purpose and function of pay items and cost
items.

Term Function

Pay
Item

For contractors, this represents a project deliverable, including the pay quantity
defined by the owner and the contracted unit price you will be paid for completion of
the work. Pay item prices include your overhead and profit.

For owners, this feature can be used in a variety of ways or may even be ignored. One
way it can be used is to represent funding sources and total funded amounts. It can
also be used to bill internal or external partners.

Cost
Item

The individual cost-related activities required to complete the deliverables of the
project.
Cost items represent the costs you budget to complete the work and therefore do not
include profit. 

InEight Control contains a Contract Adjustment Wizard that walks you through the following steps for
performing a contract adjustment:

1. Select Pay Items (or create new)

2. Adjust Pay Item

3. Select CBS Items

4. Assign Amounts

5. Adjust Cost Categories

6. Submit (to pending)

The following Step by Step guides you through the creation of a pay item contract adjustment.

PAY ITEM CONTRACT ADJUSTMENT

1. Select the Actions drop-down menu, hover over Budget move and contract adjustment, then
click Contract Adjustment. 
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2. Select Start with pay items.

3. Type a number in the Issue # text box.

4. Type the same number in the CCO (Contract Change Order) text box.

5. Enter a Description in the Description text box.

6. Click Next.

7. On the Select Pay Items screen, select the desired pay items.

8. Click Next.

9. Enter the appropriate values on the Adjust Pay Item screen.

10. Click Next.

11. On the Select CBS items screen, select the applicable cost items.

12. Click Next.

13. On the Assign Amounts screen, enter the desired values in the MHrs and Total quantity fields.

14. Click Next to get to the Summary – step 8.

15. Review your entries, select the Back button as needed to make any corrections.

16. Click Submit.

7.6.1 .1 VIEW LIST OF PAY ITEMS

You can see a list of pay items already created in a contract adjustment.

When creating a pay item in a Contract adjustment, you can now see a list of previously created pay
items in Control > Workspaces > Actions > Budget move and contract adjustment > Contract
Adjustment > Pay items > Create a new pay item > Pay item number, instead of needing to navigate to
the pay item’s register.
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The list helps you keep any current number and description formatting to follow the next consecutive
number, or description scheme.

You can also see the pay items that are awaiting approval.
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7.6.2 UPDATE CURRENT ESTIMATE VALUES BASED ON
CURRENT BUDGET ADJUSTED VALUES

You can update your current estimate values based on the adjusted current budget values for contract
adjustments.

In the cost item step of the Contract adjustment wizard, you can add the following columns from the
Column chooser that show how the current estimate values are based on the adjusted current budget
values:

l Cost source

l Update CE total cost

l Update CE total MHrs

l Update forecast (T/O) qty

l CE total cost

l CE total MHrs
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l Forecast T/O qty

l New CE total cost

l New CE total MHrs

l New forecast (T/O) qty

The check boxes under the Update CE total cost, Update CE total MHrs, and Update forecast (T/O) qty
let you opt to update the current estimate based on what is adjusted in the current budget after the
contract adjustment is approved.

In a contract adjustment, the Update CE total cost and Update CE total MHrs check boxes
are active for plug cost source only. They cannot be edited for detail cost items because
cost is driven by your associated resources.

For example, if the Adjust CB cost is $500, $500 is added to the CE total cost after the contract
adjustment is approved if the Update CE total cost box is checked. You can preview the results in the
New CE total cost, New CE total MHrs and New forecast (T/O) qty columns.

You can select multiple cost items to update the Update CE total cost, Update CE total MHrs, and
Update forecast (T/O) qty columns by selecting the Update CE from CB option in the Auto-calculate
feature and then selecting the values you want to update.
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To have the Current estimate cost, man-hours, and quantity check boxes selected by default to be
updated with adjusted Current budget cost, man-hours, and quantity values when doing change
orders, you can switch the Default CE values to be updated from CB values to ON in Settings > Control
> Project Tracking.

When the setting is enabled, all applicable check boxes are selected. This is a quick way to keep CE and
CB values in sync without having to enter values twice.

You can match CE from CB only in a cost items first contract adjustment and in a non-
associated budget move.
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For more information, see the Default CE values to be updated from CB values section in Tasks
settings.

7.6.3 CHANGE MARKUP IN CONTRACT ADJUSTMENTS

Control consumes markup amounts from InEight Change. The total amount and costs coming from
Change, including the markup, integrate into Control. Billing rate markup, CCO markup, and CCO
unassigned markup are all contract adjustment header fields that can help you make more informed
decisions on how to adjust the Adjusted current price.

7.6.4 CONTRACT ADJUSTMENTS WITH COST ITEM
MARKUP

Performing contract adjustments that start with cost items lets you assign markup and fee values to
pay items. Your pay items are then driven off of your cost items plus some markup percent in addition
to a flat fee as well. The sum of your markup and fee is your planned profit.

The contract adjustment details register also has a new header that displays the amount that is going
to change while navigating through the contract adjustment steps.

The following Step by Step guides you through the creation of a cost item contract adjustment.
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COST ITEM CONTRACT ADJUSTMENT

1. Select the Actions drop-down menu.

2. Hover over Budget move and contract adjustment, then click Contract Adjustment.

3. Select Start with Cost items, fill out the Issue #, CCO, and Description fields as needed, then
select Next.

4. In the Cost Items screen, select a cost item, or, if there are no cost items on the grid, cost
items by selecting the Add icon.

5. Enter values in the Adjusted CB total cost, Markup %, or Fee fields. Select Next to get to the pay
item screen.

6. In the Adjusted Total Price column, manually override the total price by selecting the total price
field you want to change. Enter a new value, then select Next.

l The Summary tab is read-only. Use this step to finalize and confirm your contract
adjustments.

7. Select Submit to send for approval or Draft to save for later edits.

7.6.5 CONTRACT ADJUSTMENTS FROM CCM

Contract adjustments can be made within the Change application and are visible in the Change
Register of the Control application. After an Issue is created in Change, and becomes an Executed
Contract Change Order, it appears as a pending contract adjustment in Control.

The contract adjustment does not allow you to select Start with cost items if you are
using a CCO-draft that originated from Change.

Control creates a new line item in the Change Register that states the following details:

l CCO label

l Issue #

l Description

l Total contract cost adjustment

From the Change Register, you can revise the new contract adjustment line item and then define which
pay items the negotiated price should be assigned to, as well as which cost items should be updated
with additional budget. In the Contract Adjustment Wizard users can view the CCO agreed price and
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net contract change based on your adjusted pay items. After the items have been defined the contract
adjustment is then submitted and goes through the change approval process.

7.6.5 .2 ASSIGN PAY ITEM ASSIGNMENT WHEN A NEW COST
ITEM COMES FROM CHANGE

When new cost items are sent to Control from Change, you can assign cost items to pay items. After a
contract adjustment is approved, the pay item assigned during the contract adjustment is shown in the
Pay item assignment field in the CBS.

7.6.6 CONSUME PAY ITEM ASSOCIATIONS WITH NEW
COST ITEMS FROM INEIGHT CHANGE

Control change orders can consume Change’s pay items association with new costs items. Change
associates new cost items with pay items as part of a contract adjustment, once approved.
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For example, when you create a new cost item in Change with a pay item association for a contract
adjustment, and then execute, the newly created cost item becomes associated with the pay item that
was assigned in Change.

This pay item assignment shows in the contract adjustment cost item and pay item steps.
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7.6.6 .3 CREATE PRE-APPROVED COST ITEMS IN INEIGHT
CHANGE

You can create plug cost item placeholders directly in Change. This integration begins when an issue is
created in Change, a new cost item is added, then converted into a CCO and executed.

After the executed CCO is revised in Control as a CCO draft, approving the CCO initiates the creation of
the new cost item.
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Approving the CCO in Control creates the new cost item.

Additionally, the cost item is inserted as the last record in the CBS.
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7.6.7 PAY ITEM LOCKING

At the beginning of a project, pay items in Control are unlocked. You can modify the following current
amounts directly in the grid when your price is not locked:

l Current price

l Current unit price

l Current pay quantity

l Current billing method

l Current forecast takeoff quantity

The original columns in the grid shows what your original pay values were for those pay items before
any change orders or contract adjustments were done.

For example, prior to any changes, the original columns show your agreed upon pay item values. Then
the current columns shows your original values.

UNLOCKING PAY ITEMS

1. From the CBS tab of the Control Workspaces page, click the Actions drop-down menu.

2. Select the Unlock Pay Items option.

When your pay items are already unlocked, a yellow banner is shown.

You can edit your billing method directly in the grid if the billing method has not already been billed.
You can also edit directly in the pay item details slide-out panel.

InEight Inc.  |  Release 25.5 Page 367 of 572

Control User Guide 7.6 Contract Adjustment



You can also add new pay items directly in the pay items register without doing a contract adjustment.
For example, if you click the Add pay item icon and the price is unlocked, you can add a pay item
directly into the grid which opens the pay item slide-out panel.

After you are finished editing the pay item register, you can lock your price either from the banner or
from the Actions menu. After the price is locked, the items from the grid become read-only. The only
way to make changes now is to do a contract adjustment. Current values change while original values
stay the same.

Any pay items that you edit or add are tracked in the pay item audit log as well as price locks.

7.6.8 IMPORTING BUDGET REVENUE DETAILS FROM
INEIGHT CHANGE

You can associate cost items from Control to an issue in Change. The adjusted cost, quantity, and man-
hours for selected cost items are imported from Change into a contract adjustment in Control. These
items automatically populate the the contract adjustment that is generated from Change.

Page 368 of 572 InEight Inc.  |  Release 25.5

7.6 Contract Adjustment Control User Guide



7.6.8 .4 BUDGET HEADER INFORMATION

The header information includes the following:

l CCO total buget

l CCO unassigned budget

l Net budget change

l Net contract change

The CCO total budget includes the cost amount that was adjusted in Change. The CCO agreed price
section includes the Executed CO amount. The CCO agreed price is the cost plus mark ups.

The CCO unassigned budget is the difference between the Net budget change, which is the sum of all
the modifications in the contract adjustment, and the CCO total budget. For example, if you have any
items not allocated to a cost item, the CCO unassigned budget changes value.

The Net budget change is the adjusted CB total cost.

The Net contract changes are derived from the total pay item changes. For example, you can add a pay
item directly in the grid, and either add all of that amount to one pay item or split it out among pay
items.

You can also price out a change order using the agreed-upon cost item amounts from Control. Then,
when you execute a CCO in Change, Control automatically attributes the adjusted amounts to the
correct cost items.

The Net contract change must equal the CCO price or it cannot be approved, causing an error to show.
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7 . 7 CHANGE APPROVAL PROCESS

After submission, all budget moves must be reviewed and approved before their values are added to
the Current Budget. The Change register allows users with appropriate permissions to review the
details of contract adjustments and budget moves, and either revise, reject, or approve the changes.

To access the Change Register, click on the “Change Register” tab at the top of the Control workspace.
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l The submitted entries have a status of Pending in the Status column of the Change register

l Rejecting the change ends the change process and prevents the proposed changes from
updating any pay items or cost items

l Revising the change restarts the change process for the proposed pay and cost items, and
re-submits the change for approval

l Approving the change makes the proposed pay and cost item changes final and updates
the project price and cost information accordingly

Right click on a change register record to view further record details, make revisions, and review the
changes that were previously made to the change record.

l The Details slide-out panel shows an overview of changes that were made to a particular
change record, along with attributes such as the change order type, CBS position move
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from/to, and adjusted CB total cost /MHrs/Qty

l The Revise option takes you directly into the budget/contract move to review the change steps,
and make any additional changes
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l Review is a read-only option that takes you directly into a budget/contract move to review the
change steps

Control retains Change column filters when you navigate out of the Change register, and
then go back to the register.

7.7.1 GROUP BY OPTION

Activate the Group by icon to show certain Change columns in groups of like information. Similar to the
CBS, you can activate the Group By icon in order to categorize certain columns in the Change Register.

Select a column header, drag it into the gray field above the column headers, and then drop it.
Additionally, multiple columns headers can be placed in the Group By field.
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After the Group by icon is activated, and one or more columns are grouped, such as the Status column,
you can see all the change records in their respective groupings. You can also see a subtotal for each of
the groupings.

APPROVE A CONTRACT ADJUSTMENT / BUDGET MOVE

1. Click on the Change Register tab.

2. Click a Contract Adjustment record.

3. Review your proposed changes to both your pay item, and cost item(s) as applicable.

4. Click the Approve button.

If you reject a change order and then revise, the revision is noted in the change
record’s ID number.
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EXERCISE 7.1 — CHANGE MANAGEMENT

Now that you have covered the key tasks related to change management, you can practice making
changes on your own. You can use your own project (if available) or the training project used in this
lesson.

1. Review the project and determine a scenario that would require a contract change.

2. Perform a Contract Adjustment per your scenario, including the creation of a pay item.

3. Once completed, approve the Contract Adjustment.

Congratulations, you have completed this exercise!
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REVIEW

1. Where can you review the details of your contract adjustment or budget move and
choose to either revise, reject, or approve the change?

a. Change Register

b. Approval Screen

c. CBS Log

d. Contract Change Log

2. When creating a budget move, what is recommended?

a. Issue number

b. Description

c. Dollar amount

d. All of the above

SUMMARY

As a result of this lesson, you can:

l Explain the change management process

l Complete a cost budget move

l Complete a quantity budget move

l Complete a man-hour adjustment

l Create an adjustment to the contract

l Describe the change order approval process
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8 . 1 INE IGHT CONTROL WORKFLOW –
REVENUE MANAGEMENT

8 . 2 PAY ITEM DETA ILS

When you right click on a pay item, a context menu appears with four options for managing pay items.
You can:

l Insert a pay item

l Delete a pay item

l Access/maintain pay item details

l Access/maintain billed revenue details.

Selecting Pay item details will open a Pay item Details slide out panel.
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You can also access this context menu by hovering over to the right of the Description and clicking on
the three black dots.

8.2.1 DETAILS TAB

The first tab in Pay item details is called Details. This is where you can view the details for the pay item
such as Total Price, Pay Quantity, and Unit Price. You can also make changes to fields such as Pay Item
number, Line number, and Description.
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8.2.2 ATTRIBUTES TAB

Next is the Attributes tab. This is where you can associate specific tags to your pay item, or to define
field values.

8.2.3 CHANGE ORDERS TAB

The Change Orders tab displays all change orders associated to the selected pay item.
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8.2.4 COST ITEMS TAB

The Cost Items tab displays the cost items that are assigned to the selected pay item. In this example
there are two cost items assigned to the 002 Concrete – Labor & Material pay item.

8.2.5 COST CATEGORIES

The Cost Categories tab shows a break at the cost category level for the cost items that are assigned to
that pay item. This tab is a quick way to see where you have cost and revenue as well as where you
have revenue at the pay item level for the pay item at the cost category level. The different fields
represent the different billing methods that are available currently.
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Forecast final revenue, Revenue earned, and Markup amount only show at the totals level of the cost
categories.

Forecast final revenue and Revenue earned shows the information that is pulled from the pay item's
register.

The Total cost to date column breaks down the information from the information from the cost items
assigned to the pay based on where you claimed the cost for those items.

The Markup amount calculates the difference between your total price and your agreed upon current
budget cost for those assigned cost items. The Markup amount uses the calculation Total price on the
pay item - sum of the CB total cost on the assigned cost items

8.2.6 CREATING AND LOCKING PAY ITEMS

When setting up your project, you can manually create pay items or quickly import your pay items by
uploading them from a Microsoft Excel spreadsheet.

UPLOAD PAY ITEMS FROM A MICROSOFT EXCEL SPREADSHEET

1. In the Actions menu, select the upload icon to upload the Excel spreadsheet.

2. Drag and drop your Microsoft Excel spreadsheet or select browse to upload it.

3. Select the New import option.

4. After the spreadsheet is uploaded, choose the columns you want to see.
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8.2.6 .1 ADDING PAY ITEM DETAILS

Because the project has not started, pricing is unlocked. This means you can:

• Add new pay items

• Enter price and quantity for each item.

When you are done adding details, your pay items show the current values that were entered.

8.2.6 .2 LOCKING IN YOUR PRICING

After you are done with your list and ready to move forward, lock in your pricing. To lock pricing select
Actions > Lock/unlock price > Lock price. This saves the changes as the original pricing for the project. If
you are not ready to lock all items, you can also select the individual pay items and lock or unlock them
from the Actions menu.

After the pricing is locked on a pay item, the pay item's price can only be edited through a contract
adjustment.

Partial locking is available. When set, you can add pay items at any time during the project life cycle,
and you can lock each pay item individually after you enter the price is entered for that pay item.

8 . 3 BULK IMPORT PAY ITEMS

You can import pay items in mass directly into the Pay Item and Proposal register, similar to how cost
items can be imported directly into the CBS.

You can access the Excel import feature by clicking on the Import icon on the far right toolbar of
Control > Workspaces > Pay Items.
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When you click on the Import icon within the Pay Items tab of the Workspaces page, the Import Pay
Items window is shown.

Title Description

1 Import from
Excel

You can either drag and drop or browse to the file to import. Microsoft
Excel files (.xlsx,, .xls) and Comma Separated Value (.csv) files can
be imported.

2 Import Type You can add new pay items into the Pay Item and Proposal register.

3 Information
message

Explains that once an import file is specified, the next step will allow
you to match the columns in your spreadsheet to the appropriate
columns in Control.

Overview – Import Pay Items window
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Clicking Next brings you to the Map columns window, where you can map your Excel columns to the
applicable column in Control.

Title Description

1 Template After you map the import file columns to the Pay Item columns in Control,
you can save your settings as a template for future use. This is helpful when
you need to make scope changes or updates on a regular basis. 

2 Control
field

The names of the column headers in Control that you can map your data to. 

3 Mapped A green checkmark indicates the column in your import file is mapped
correctly to the Pay Item's column. The Green key indicates the matching
code you specified is locked.

4 File
columns

The names of the column headers in your import file that you can map to the
pay item columns in Control.

Overview – Map Columns Window
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8.3.1 SPREADSHEET RULES

For the import to work correctly, the items in your Excel spreadsheet need to be formatted in a certain
way so that Control can recognize them. The following table indicates important spreadsheet rules to
follow to make sure your data imports successfully:

Attribute Rules

Import
function

Reads the first worksheet within the referenced workbook.
Stops the import process when a blank row is encountered, so consolidating
the data to be imported is required.

First row of
data

This is the header row of the data.
This becomes the titles that are referenced during the mapping process.
During import, headers are not read if a blank header cell is encountered.

Numbers Need to be the actual number, not the summation of cells.
Cannot contain the $ or other currency symbol.
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Attribute Rules

Second row
of data

This is the first row of data import.

If you make changes in the spreadsheet, you must save the spreadsheet before
importing. Only saved data are imported.

After clicking the Next button, the system reads your Excel file and attempts to import pay items. A
successful import shows a message stating the number of files to be imported.

If the import is not successful, a message is shown stating that errors exist. An error file is provided for
you to download, review, make corrections to your Excel file, then eventually continue with the pay
item import again.
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The import error download file shows exactly where the error(s) exist within the Excel file.

8 . 4 EARN ING RULES

On the Cost Items tab the Update earning rules icon updates the earning rules for all associated cost
items. For each cost item associated to a pay item, you can adjust the earning rules by Earning % and
Earnings Timing. The Earnings timing indicates when you can earn revenue for a specific cost item
associated to a pay item. You can select from the following earnings timing options:
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l Percent complete – You will earn revenue based on the % complete of the cost item

l Start –You will earn all the revenue when the work of the cost item is started (e.g., Mobilization)

l Finish – You will not earn any revenue for the cost item until all the work is completed (e.g., QC
item)

In this case for your Structural Steel Project, cost item 3 has an earning rule that equals 75% of the
Earning Amount (Forecast) of the pay item’s final revenue. Respectively, cost item 5.2 has an earning
rule of 25% of the Earning Amount (Forecast).

Since the Total Price of this pay item is $2,919,020.71, it is expected that cost item 3 will earn 75% of
this amount, and cost item 5.2 will earn 25%.
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Billing method of Cost plus

When the billing method of the pay item is set to Cost Plus, then the Update earnings
rules option will be disabled. Therefore, the associated cost items of the pay item will
earn revenue based on the assigned estimate resources’ billing rates and the % complete
of the cost item.

ADJUSTING PAY ITEM EARNING RULES

1. On the Pay Items tab, select a pay item.

2. Hover over to the right of the Description and click on the three black dots.

3. Select Pay item details.

4. Select the Cost Items tab.

5. Click the Update earning rules icon.

6. Change the Earning % percentages for each associated cost item so the total will equal 100%..

7. Click Save.

8 . 5 B I LLED REVENUE

On the Pay Items screen, selecting Billed revenue details from the context menu opens the Billed
revenue slide out panel.
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The Billed revenue slide out panel is where you can record what you bill to the client.

8.5.1 BILLED TAB

The Billed Revenue Details window defaults to the Billed tab. This is where you enter in information
about what you want to bill to your customer and also view pending billable quantity and pending
billable revenue based on the progress of the cost items associated and their earnings rules.
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After selecting apply, the billed amount is visible on the Pay Register screen under the five Billed
columns:

l Is billed - If checked, a billing record has been created

l Billed quantity - This is based on your pay quantity, and depends your UOM, and how you want
to bill the quantity
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l Billed revenue - What you billed to the client

l Pending billable quantity = Earned quantity - Billed quantity to date

l Pending billable revenue = Earned revenue - Billed revenue to date

8.5.1 .1 UNIT PRICE PROPORTIONAL BILLING

When you bill revenue or quantity for unit price pay items, the billed quantity or revenue automatically
adjusts proportionally to the entered billed value to match the unit price.

For example, if the current unit price is $1,000.00 and the billed quantity is 0.50, then the billed
revenue automatically calculates at $500.00.

Once a pay item is billed, you can no longer delete the pay item.

8.5.2 BILLED REVENUE DETAILS

Once you have billed revenue and quantity to your customer, all columns will populate with values.
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As soon as work is progressed on the cost item(s) associated to a pay item, the quantity earned,
revenue earned, pending billable quantity, and pending billable revenue fields will populate with
values. When a bill is processed, the billed quantity and billed revenue fields will update, and the
pending billable quantity and pending billable revenue fields will also update (subtract out the new
billed amounts). The quantity earned and revenue earned columns are not affected by billing.

As a result of the Push or Get Billed revenue actions, this will update each respective pay item.

You can also view a record of the newly created bill in Billed History by navigating back to Billed
Revenue Details screen.

The billing-related fields that are now part of the Pay Items register are the Billed Revenue, Billed
Quantity, Quantity earned, Revenue earned, Pending billable quantity, and Pending billable revenue
columns. Once you have billed revenue and quantity to your customer, all columns will populate with
values. The pending amount fields are driven from the Quantity earned and Revenue earned amounts.
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Furthermore, the pending amount fields help you identify what has been billed versus what is left to
be billed based on what has been completed for your cost items. 

The Is billed checkbox also populates when a pay item has been billed.

Within the Pay item register you have a date filtering option available for the pay items that can be
applied to columns based on the billed date. To get back to the to date calendar, click on the calendar
icon and select To date from the drop-down.

8.5.2 .2 CHANGE ORDERS

When creating a bill in the slide-out panel, or from the bill multiple pay items option, you can select a
change order to assign the billed amount to.

Associate a change order to a pay item by selecting a change order either from the Billed revenue
details, or Bill multiple pay items options. This lets you select which approved change orders to assign
to the bill.
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After submitting the bill in the Billed History tab, the associated change order becomes associated with
the bill.

The Total Change Order Amount column shows how much of a pay item’s price is from change orders.
This is a summary of all the approved change orders that are attributed to a pay item. The Billed
Change Order Amount shows how much money has been billed to the customer against a change
order.
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The following Step by Step walks you through how to bill a customer for revenue earned.
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BILLING REVENUE

1. On the Pay Items tab, select the a pay item.

2. Hover over to the right of the Description and click on the three black dots.

3. Select Billed revenue details.
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4. Under the Billed tab, enter the following:

l Billed revenue = $100.00.

l Cost category = Installed Materials

l Billed quantity = 1

l Billed date = today’s date

l Cost item = [insert a cost item from the dropdown menu]

l Notes = ‘billing $100.00 for materials needed for concrete prep work, performed on
08/02/2019’

5. Select Apply.
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8.5.2 .3 PAY ITEM BILLING IN MASS

Billings often include multiple pay items. For that reason Control also allows users to claim billed
quantities and revenue for multiple pay items at a time using the pay item grid view. This is in lieu of
using the Billed Revenue Details slideout panel, per pay item. On the Pay Items screen, select those
desired pay items you wish to bill.
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In the example below for Pay Item 11.1, the Revenue Earned represents the amount that has been
earned to date. Revenue earned is based on the cost items associated to this pay item. As cost items
are being claimed, Revenue earned is generated. For Pay Item 11.1, under Revenue earned,
$365,924.12 has been earned to date. Billed revenue is showing that $20,966.00 has been billed thus
far. The difference between the Revenue earned and the Billed revenue, is the Pending billable
revenue which is $344,958.12. This is the amount that you can bill to the customer.

Typically, when it's time to bill, you can select the pay items with positive values in the Pending billable
revenue column.

A negative value in the Pending billable quantity and/or Pending billable revenue fields
signifies an over billing to the customer.

When it's time to bill a customer, select the desired pay items to mark for billing, right click, then select
the Bill multiple pay items option.
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The New Bill Request screen appears, which displays billing related fields to potentially be billed to the
customer. The Pending billable quantity and Pending billable revenue fields are at zero because their
values have been moved to the Billed Revenue and Billed quantity fields, to be billed as part of the
overall transaction. The Billed revenue and Billed quantity values in the New bill request window will
match the Pending billable revenue and Pending billable quantity values in the Pay items tab.

In the New Bill Request example below, the values in the Billed quantity and Billed revenue fields are
the amounts that are to be billed to the customer. The Billed Revenue and Billed Quantity columns
show the same amounts that exist in the Pay Item screen under the Pending billable quantity and
Pending billable revenue columns.

You also have the option to change the Billed Revenue amount in the New Bill Request screen. For
example, if there's remaining work still to be done, and it's not 100% complete, you can change the
Billed revenue to a different amount. Using the example below for Pay item 11.1, you have the option
to partially bill the Pending billed revenue of $344,958.12. By changing the Billed revenue amount to
$300,000.00, the remaining $44,958.00 displays under the Pending billable revenue column.

Now, you can see that if you bill for $300,000.00, then you still have $44,958.00 available to bill.
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It's possible to assign the bill request to a Cost category and a Cost item. Each billed revenue
transaction requires a cost category to be selected. The default value is Undefined.

Enter and save any information specific to the bill request in the Notes field.

When you select the Submit button in the New Bill Request screen, the billed transaction appears in
the Billed History tab in the Billed Revenue Details slideout tab.
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This action also creates new audit log entries in the Pay Item's audit log, that show the pay item that
was changed, along with fields that display the before and after values, and the user that made the
change.

Updates are made to the following Pay Item fields: Billed revenue, Billed quantity, Pending billable
revenue, and Pending billable quantity. If the Billing method is Cost Plus, then the Forecast final
revenue and forecast unit revenue fields will also be updated.

The following Step by Step walks you through how to bill for multiple pay items.
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BILL FOR MULTIPLE PAY ITEMS

1. On the Pay Items tab, hold down the SHIFT key and select any 3 pay items you wish to bill
in one transaction.

2. Navigate to the Bill multiple pay items screen by clicking on the context menu.

l The Billed Revenue in the New Bill Request screen should match the Pending billable
revenue in the Pay Item screen

3. Change the Billed revenue value to bill half the amount to the customer.

l The other half should appear in the Pending billable revenue field

4. Assign a cost category to the new bill request.

5. Type Billing half the amount the customer now, and will bill the other half when job is
complete in the Notes field.

6. Select the Submit button.

7. Navigate to the Billed History tab for the pay item just updated and look at the entry
created for this transaction.

8.5.3 ACTUALIZING REVENUE

In Pay Items, after a bill has been sent to a client, you can log revenue that has been received and log
and track received revenue.

In the Pay Items register, when you select the Claim Revenue icon, it shows all transactions for all pay
items that contain billed revenue that has not been logged as received.
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Alternatively, you can right-click on one or more pay items and select Actual revenue details.
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The Actual revenue details form opens, which shows all the selected pay item billed transactions. In
the Revenue received column, you can enter the amount of money received by a client. The Revenue
received date lets you enter the date the money is received.
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You can select all or some of the billed transactions, and then click the Auto Calculate icon to match
the total revenue received values with the billed revenue values (everything that has been billed has
been received in total).

The revenue is also updated on the Billed History tab in Billed Revenue Details, for a pay item.

After the Actual revenue details form is submitted, the Revenue received (to date) column on the Pay
Items form shows the pay item amount received.
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8 . 6 REVENUE FORECAST PROBAB IL I TY

Revenue can come from Control or Change. Only Contract Adjustments have revenue. You can also
adjust your pay item values in a Contract Adjustment. For example a drop down field called Approval
Probability is a drop down of all your revenue categories and their associated probability. This drop
down field displays the Approval probability by percentage and associated name.

Follow the steps below to select an approval probability.

Page 410 of 572 InEight Inc.  |  Release 25.5

8.6 Revenue Forecast Probability Control User Guide



APPROVAL PROBABILITY

1. Select the Actions drop down menu.

2. Hover over Budget move and contract adjustment, then click Contract Adjustment. 

3. In the Approval probability drop down, select the percentage and associated name.

4. In step 3, select the add icon to add either new or existing pay items.

5. Enter a value into the Adjusted total price text box.

6. Either save as Draft or select the Submit button. Now it shows the selected approval probability
in the Change Register. It also displays in the line item slideout. This updates automatically based
on status changes.

7. If your line item is approved, it has a 100.00% in the Approval Probability column.

8. If a Contract Adjustment has been revised or rejected, then the line item has a 0.00% in the
Approval Probability column.

That Contract Adjustment's revenue is never going to be earned or added to the
pay items because a new Contract Adjustment has been created.

9. If your line item is in a Draft or Pending state, the Approval Probability column displays the
approval probability you selected for that line item.

If you don't select an approval probability, the Approval Probability column is
blank.

Your Approval Probability drives the price you include in your Forecast Final Revenue. For this next
example, we are going to include the Unapproved Revenue into the Forecast Final Revenue. In the Pay
Items Register, the Unapproved Revenue column calculates all the Contract Adjustments. The column
adds up all Contract Adjustments that include the pay item and the adjusted price that has note yet
been approved. The Unapproved Revenue column calculates anything that is in a Draft or Pending
state.
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In Pay Item Details, the Change Orders, you can view the following details:

l Total price change

l Total unit price change

l Total pay quantity change

l Approval probability

l Adjusted forecast final revenue

l Status

The Forecast Final Revenue is the sum of all the Adjusted Forecast final revenue. Calculating the
Unapproved Revenue with the Forecast Final Revenue provides you with a more accurate look at the
revenue you will see when the Contract Adjustment is approved. Nothing is added into the Total Pay
Item Price until it is approved.

Approval Probability drop down is only available in the Contract Adjustment. Everywhere else it is read
only. To manually adjust the Contract Adjustment, go to the Change Register. Then right click the line
item you want to change and select Revise. The Contract Adjustment can also automatically change
based on status changes.

The Revenue Category Name and probability percentage drives the Approval Probability. The Revenue
Category Name draws from the Revenue Categories in the Master Data libraries.

Page 412 of 572 InEight Inc.  |  Release 25.5

8.6 Revenue Forecast Probability Control User Guide



The Revenue Categories show the Revenue category name and probability percentage for only active
revenue.

8 . 7 T IME PHASED BUDGET

Time phased budget lets you plan out where to spend money in the months of the active fiscal
calendar for the project.

The point of being able to time phase your budget is so that you can plan out your budget cost per cost
item. You are spreading out your budget over the course of the project for each cost item.

8.7.1 BUDGET ORGANIZATION SETTING

The time phased budget feature includes an organization setting located in the Project tracking tab of
the Control settings. The organization setting sets the default for all the projects within that
organization.

You can also change the budget setting at the project level. If you are starting new projects in your
organization, you need to have Time phasing budget switched on.

By default all the projects that are created under that organization also have the time phased budget
enabled. This is the same for when budget is disabled.

InEight Inc.  |  Release 25.5 Page 413 of 572

Control User Guide 8.7 Time phased budget



8.7.2 EDIT PAST TIME PHASED BUDGET VALUES

The Edit past Time phased budget values toggle lets you edit past fiscal period time phased budget
values.

When this setting is enabled, you can edit your past time phased budget values via a budget move or a
contract adjustment in the time phased budget step, with the proper permissions.

Selecting the new Rebaseline icon resets the cost item's time phased budget distribution based on the
Start and Finish dates against that cost item. Rebaselining lets you amend your time phased budget
distribution costs for a cost item.

You can also edit any of the Adjusted cost values manually for past months.

Page 414 of 572 InEight Inc.  |  Release 25.5

8.7 Time phased budget Control User Guide



At the project level, the time phased budget inherits the organization settings, but still lets you switch
the budget setting On or Off at the project level. For example, you can have time phased budget
turned on at the organization level and you can turn it off at the project level.

8.7.3 SWITCHING OFF TIME PHASING BUDGET

If the Time phasing budget is switched on, that means there is time phasing budget data in the
database. If you turn it off time phasing budget at the project level, it gives you the following warning
message:

All of your time phased budget data is going to be deleted if you switch time phased
budget off. You must select the check box in the warning dialog acknowledging that you
understand and accept these conditions.

If you still want to turn off the time phasing budget, you can select Yes and then click Save. This will
delete the time phasing budget data from the database.
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8.7.4 SWITCHING ON THE TIME PHASING BUDGET

If you want to turn on time phased budget, the following dialog box appears if there are any missing
start or end dates:

Every cost item in your project needs the start and finish date entered to use that data in the time
phase budget.

When time phased budget data is calculated, the calculation is based off of the data in the current
budget and total cost for the cost item. Then, the cost is distributed to the cost items start date, finish
date, and cost curve.

Page 416 of 572 InEight Inc.  |  Release 25.5

8.7 Time phased budget Control User Guide



8.7.4 .1 DEFAULT ALL BUDGET TO CURRENT FISCAL PERIOD

The first option you have is to default all of the budget to the current fiscal period. Then, all cost items
that don't have defined start and finish dates have the current budget going to the current fiscal
period.

For example, if you look at WBS phase code 1007, you would have $100,000 put into December 2020.

8.7.4 .2 DEFAULT TO PROJECT START AND END DATES

The next option is to default to the start and end dates. On the project details page you define all the
project start and end dates. After those are defined, then we can default all of those missing start and
end dates to just the project start and end dates.

8.7.4 .3 POPULATE MISSING DATES MANUALLY

You can also return to the Time phased budget step and manually populate the missing dates. If you
choose this option, the budget setting turns off again (if it wasn't already turned off and on again in
previous sections). You then have to go into the CBS and manually enter all the start and finish dates.
Then, you could turn the budget setting back on and it should distribute the budget.

Time phased budget data currently can only be seen in the CBS contract adjustment.

For more information about settings for time phasing budget, see Time-phasing.
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8.7.5 TIME PHASED BUDGET IN CONTRACT
ADJUSTMENT

From the CBS, select cost items to adjust in the contract adjustment.

Then select the Actions drop-down, hover over the budget move and contract adjustment and then
select Contract adjustment.

In the contract adjustment, there is an area called Change order attributes. This area lets you set your
change orders/contract adjustment to the following:

l Start date

l Finish date

l Cost curve
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Cost Curve can be adjusted in many ways. If you select Bell Shaped the cost adjustments increase
during the summer months and then decreases in the winter months.
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In step 3 of the contract adjustment, the Time phased budget step can be used for both Start with Cost
items work flow and the Start with Pay items work flow. You can adjust your time phased budget in
either contract adjustment work flow.

The only time your time phased budget should change is when you get change orders and
you have to change your overall budget amount.

For the Start dates, you cannot put budget in the past. If you try to select a month that has already
passed, you will get an error stating Start date must be in an open fiscal period.
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Finish date has to be greater than your start date otherwise you get the following error.

Move onto step 2 Cost Items. You can add Adjusted CB total cost. In this example we are adding $100
to each cost item.

In the Time phased budget step, the 100 dollars now has to be distributed. Scroll over to the
Distribution type column.

In step 3, only TERMINAL cost items will be brought into that grid. Non-terminal cost
items do not show on the Cost items grid of the contract adjustment.

There are three different Distribution types:
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l Change order (default setting)

l Cost Item

l Manual

When Distribution type is set to Change order, it means it is pulling in the start date, finish date, and
cost curve from the details step of your change order.

The changes to the Adjusted total cost column are then distributed throughout the start and finish
date and shows in the Adjusted Cost column.

If your cost curve was set to linear, roughly the same amount of cost goes into the same fiscal period.
Since some months are longer than others, they will have additional cost.

8.7.6 TIME PHASED BUDGET AT THE BUDGET MOVE

Time phased budget is included for both the non-associated and associated budget move.

The total adjusted CB total cost must be zero before you can move budget. This shows as a net zero
budget adjustment when you are moving budget from cost items to other cost items. You can also
move the time phased budget.

You can set the start date, finish date, and cost curve for the budget move change orders.
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The Time phased budget step is similar to the Time phased budget step for Contract adjustment. The
distribution type on this step is where you can select to distribute by the change order attributes or the
cost item attributes. You can also manually adjust your cost.
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When you adjust the budgeted cost either through a contract adjustment or a budget move, you can
adjust the cost over the different fiscal periods and decide where to place the adjusted cost.

8.7.7 TIME PHASED BUDGET GRIDS

In the left side gird, you have many of the cost item details in columns. This includes the following
columns:

l CBS position

l Description

l WBS phase code

l Start

l Finish

l Cost curve

l Distribution type

l CB total cost

l Adjusted CB total cost

l Pending budget cost: any outstanding budget cost that has not yet been approved. For
example, if you have another pending contract adjustment, it adds those values in this
column.

l Phased budget cost delta
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You can adjust the amount of columns you see using the slider to move between the left side grid and
the right side grid.

The right side grid shows your cost and adjusted cost columns. Your cost columns show current cost
that has been approved.

For example, in the CB total cost column, if you have $1,000 approved, the cost columns for each
month distributes that cost throughout each month.

8.7.8 CHANGING DISTRIBUTION TYPE TO COST ITEM

You can change the auto distribute type to Cost item if you want your adjusted budget to use
attributes from the CBS.

To do this, you can select one, many, or all of your cost items in the left side grid, and then click on the
auto distribute icon. Then select Cost item.

InEight Inc.  |  Release 25.5 Page 425 of 572

Control User Guide 8.7 Time phased budget



Your Distribution type has changed to cost item. You are now distributing your adjusted budget based
on the cost item attributes that are pulling in from the CBS.

This also changes how the Cost curve distributes the adjusted cost. As you can see from the screenshot
above, some cost curves have been adjusted.

8.7.9 MANUAL DISTRIBUTION OF COST ADJUSTMENT

You can change a specific cost item's cost adjustment to zero and then manually redistribute that
zeroed cost to other months. If you do not distribute the cost to other months, the following missing
amount for the adjustment cost is highlighted in orange.
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After redistribution, there are some manual indicators showing what the value was before the change.

The warning indicator on the cost curve column lets you know that your cost item contains manual
time phased months and is not technically back loaded anymore.

8.7.10 DELTAS IN A ADJUSTED COST COLUMNS

Deltas appear on a contract adjustment when the adjusted cost for a cost item does not match the
current budget total cost.

You are not allowed to submit or approve a cost item adjustment that has a delta.
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That is where the phased budget cost delta column displays any missing or over budgeted costs for
any one cost item.

This column sums up all of your adjusted cost in the right side grid and compares it to the Adjust CB
total cost.

For example, if you have $10 not distributed, you need to add it to the adjusted cost in that same cost
item before moving onto the next step. If the current budget total cost has $100, you must spread that
total cost amount throughout your months.

Hovering over the delta warning in the right side grid shows where the error in cost is occurring. If you
have multiple deltas in different cost items, the delta cost would then sum up all delta costs.

If you attempt to submit or approve the contract adjustment with deltas and you return to the Time
phased budget step, the Phased budget cost delta column shows which cost items have a delta. You
need to resolve the deltas and redistribute the costs in the Adjusted cost columns in the right side grid
before moving forward.

You can also adjust your delta costs using the same Auto distribution button from earlier and selecting
Change order. Change order always distributes without a delta.
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Now you can submit and approve your contract adjustment. All those values are going to be
committed into your time phased budget.

For example, if you sync into your ERP, you can receive all changes made in the contract adjustment
right after those changes have been approved.

8.7.11 VIEW COST COLUMNS

If you want to view just your adjusted cost columns, select the View Cost column slider to turn off your
cost columns. Only the adjusted cost columns shows. These columns show what you are adjusting in
the active project months for the contract adjustment.

8.7.12 DATE RANGE FILTER

The date range filter lets you filter the right side grid to show only the months you want to see. You
can view the project months based on the following options:

l This month (current fiscal month you are in)

l Next 3 months
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l Next 6 months

l Next 12 months

l Through project finish date

You can also manually select the months you want to view using the Show months drop-down lists.

8.7.13 APPROVING BUDGET WARNINGS

You can't approve budget set in the past. If you have any adjusted cost set for the current month
(December) and the contract adjustment is approved in the next month (January), the approver
receives a warning stating you have budget in past or closed periods.

The contract adjustment can still be approved, but the adjusted cost from the closed month moves to
the following month.

The other option the approver has is to revise the adjusted cost. When revising, the adjusted cost from
December has already moved into the adjust cost column for January. If you do not want all of the
previous month added into a single month, you can manually move the additional adjusted cost from
January into the other open fiscal period months.
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REVIEW

1. Revenue columns can only be populated for a cost item that has an assigned _____?

a. UOM

b. Unit price

c. Pay item

d. Cost curve

2. What are the four tabs within the Pay Item slide out?

a. Details, Attributes, Revenue, Cost Items

b. Revenue, Cost Curves, Change Orders, Cost Items

c. Details, Cost Curves, Change Orders, Cost Items

d. Details, Attributes, Change Orders, Cost Items

3. In the Pay item details slide out panel, which tab contains the Update earning rules
option?

a. Details

b. Cost Items

c. Attributes

d. Change Orders

4. The _________ slide out panel is where you can record what you bill to the client

a. Billed revenue details

b. Pay item details

c. Forecast revenue details

d. Cost curve details

SUMMARY

As a result of this lesson, you can:
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l Forecast revenue and determine profit

l Manage pay item details

l Adjust pay item earning rules

l Bill customers per pay item or in mass

l Track billed revenue
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LESSON DURATION: 20 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Navigate to the Schedule data block

l Edit schedule data inside the CBS

l Edit schedule data using Excel import

l Integrate planning activities

l Schedule using Primavera

LESSON TOPICS



9 . 1 SCHEDUL ING OVERV IEW

Inside of the Control application exists the functionality to track schedule dates at a CBS level.  The
ability to easily add and modify this information allows you to accurately track your operations planned
and completed dates.

The schedule data can either be mass imported through an Excel upload, created and modified directly
within the CBS, or by way of Primavera schedule integration through and XER file import.  This lesson
will cover all options.

9 . 2 SCHEDULE DATA BLOCK

The schedule data block is where all information regarding schedule dates is contained.  Some of the
key fields inside this data block are:

l Schedule ID

l Planned Start Date

l Planned Finish Date

l Early Start Date

l Early Finish Date

l Late Start Date

l Late Finish Date

l Actual Start Date

l Actual Finish Date

You can add and edit this information directly inside the Schedule data block. However, this will only
allow you to modify one CBS line item at a time.

The following Step by Step shows you how to add the Schedule data block, save a Scheduling view, and
add various dates for a specific CBS item.
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SCHEDULE DATA BLOCK

1. From the Workspaces page of the Steel Structure Job, remove each data block from the page,
except for the Tasks and Task Details data blocks, by right clicking on the context menu.

2. For each data block you plan to remove, select Remove Data Block

3. Once the data blocks are removed, click the Add Data Block button.
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4. Drag and drop the Schedule Data Block to the right of Task Details.

5. Select Module [your initials] – [description.]

6. In the schedule data block, type your Initials.01234 in the Schedule ID field.

7. Click the right arrow to move to next set of columns in the schedule data block.
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8. Double click into each field and enter the following:

l Start = 10/05/2020

l Finish = 10/15/2020

l Early Start = 10/01/2020

l Early Finish = 10/15/2020

l Late Start = 10/07/2020

l Late Finish = 10/15/2020

l Entering dates on any terminal CBS item will auto-populate the parent’s dates. If there are
multiple terminal items under one parent, any start dates will take the earliest and any
finish dates will take the latest

l Once all the initial schedule dates are entered, the schedule data block also allows for the
project to track actual dates

9. Click the Right Arrow to move to next set of columns in the schedule data block.

l You will leave these columns blank for this Step by Step
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9 . 3 SCHEDULE EXCEL IMPORT

The Control application allows for an Excel import to import data into the Schedule data block.  This is
especially useful when bringing in large sets of data for multiple CBS items.

Excel imports can sometimes 'hang' while attempting to import CBS data. If this happens, it's possible
to cancel an Excel import while the system continues the attempt to import the data.

The following Step by Step covers downloading this Excel sheet, entering the necessary data, and
importing it back it into Control.

EXCEL IMPORT

1. From the Workspaces page, using the Schedule view on the CBS tab, click the Export button,
then CBS as CSV.

l This creates a CBSDataBlock folder in your Downloads folder

2. Open the CBSDataBlock.csv file.
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3. Inside the Excel spreadsheet, delete all rows except forModule [your initials] – [description].

4. Enter the following:

l Actual Start = 10/03/2020

l Actual Finish = 10/12/2020

5. Save the file to your computer (as .xlsx, .xls, or .csv).

6. From the Control > Workspaces page, click the Import button for Cost Items.
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7. Click Browse to select your Excel file.

8. Select Cost Items and cost item attributes, Update Existing Items and CBS position.
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9. Click Next.

10. Next, you will map which columns from the Excel sheet get imported to which columns in
Control. Click on CBS Columns to sort A-Z.

InEight Inc.  |  Release 25.5 Page 441 of 572

Control User Guide 9.3 Schedule Excel Import



11. Under File Columns, match Actual Finish and Actual Start to the CBS columns description.

12. Do the same for WBS Phase Code.

13. Click Next. 
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l The actual dates you specified import into the Schedule data block

The Excel import can only be accomplished if the Control > Settings > Schedule
setting is set to Manual Entry.
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9 . 4 PR IMAVERA SCHEDULE INTEGRAT ION

The XER (file extension used by Primavera containing project file related data) import functionality
allows the milestones and schedule dates (baseline and current) to be integrated into planning
activities. Schedule IDs in Control are used to map Primavera Activity IDs to import and export the
project information. The status of construction activities and progress are then integrated back into
the InEight scheduling tools.

The Primavera schedule integration not only allows for XER file import of schedule dates but is also
capable of a cost item bi-directional push and pull between Control and Primavera. XER imports
integrate critical milestones and schedule dates into planning activities in the InEight cloud platform.

It’s also possible for you to map the existing Control 25 CBS tag fields, and also the existing 15 user
defined fields to P6. Conversely, you can create new fields in P6 based on tagging scheme. This allows
you to filter Primavera and Control in similar ways, with the same sets of dates within both
applications.

You also can push (Physical) % complete to P6. As you are progressing in Plan or Progress, and as
quantities drive the percent complete in Control, it’s possible to push the percent complete back to the
associate activity in P6.

9.4.1 PRIMAVERA SCHEDULE INTEGRATION SETTINGS

The setting to change the schedule data source to Manual entry or an XER file type is in Settings >
Control > Schedule > Define project schedule.

Under the Schedule data source, it’s possible to manually enter schedule dates, or you can utilize the
XER file type.
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After selecting your Schedule data source, you will have the option of making sure that your schedule
IDs are similar across your baseline and current schedule.

If you uncheck one of these options, and then check it back, you will be given the option to copy
existing Schedule ID column values to Baseline schedule ID column, and vice versa. This is a way to
ensure that data consistencies remain in check for both baseline and current monthly schedule.
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Under Percent complete, you can either update the XER file with physical percent complete from
Control, or not.

Under the second dropdown for Update XER activities, you have the option to update XER with tags
and user defined fields from Control, or not to.

If you choose to update XER with tags and user defined fields, the Define tags and user defined export
rules table appears. The 3 options to choose from are to match using Control field name, match using
external system field name, or do not export.

If you choose to map to an external system field (as shown below using Tag 15 for the second record),
you will need to manually type in the name of the field first. Because this is not an API, the system is
not aware the existing fields within P6. Therefore, you need to self-determine which Control values
you want to populate in P6.
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9.4.1 .1 PRIMAVERA XER SCHEDULE INTEGRATION
PREREQUISITES

1. XER file type or manual entry must be selected in Settings > Control > Schedule, in the Schedule
data source section.
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2. On the Schedule data block, the Scheduled columnmust be checked prior to importing a
schedule.

3. The Schedule ID in Control must match the Activity ID in the XER file.

The following steps walk you through how to import a Primavera .XER file into Control.
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SCHEDULE INTEGRATION IMPORT

1. From the CBS tab of the Control Workspaces page, select the Import icon on the top right menu
bar, then click Schedule.

2. A warning message appears asking if the XER Activity Ids and Control IDs match. Click Yes if both
IDs match before continuing.

3. In the Import schedule data window, click on the Browse icon in the Drag and drop file portion
of the screen.
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4. In the Import schedule data window, click on the Browse icon in the Drag and drop file portion
of the screen.

5. Select the desired .XER file that was generated in Primavera.

l Once the .XER file is uploaded, the Browse box turns green

6. In Options, select either the Baseline schedule or Current schedule for the schedule type that
you want to import.

7. Select Next.

8. Select Import after reviewing the Schedule summary.
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l The Importing data process screen displays the current status for each step of the .XER
data import.

l If there are errors in any of the steps, you can click on the Pending unmapped items found
link to make the corrections
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l You can also navigate to Audit Log > Import history to view the import status, which
includes the Total line items imported

9. If there are corrections to be made, once completed, you can select Import to re-import the
data. 

10. When the import is successful, select the Close button.
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l Check the Control: Schedule block for newly imported scheduled dates

l This is a quick audit to make sure that the desired Primavera dates imported successfully
into Control

The following steps walk you through how to export a Primavera .XER file from Control.

PRIMAVERA SCHEDULE INTEGRATION EXPORT

1. From the CBS tab of the Control Workspaces page, select the Export icon on the top right menu
bar, then click Schedule as XER.

InEight Inc.  |  Release 25.5 Page 453 of 572

Control User Guide 9.4 Primavera Schedule Integration



2. Assuming you have Percent Complete and User defined Fields and tags turned on in your
settings, click Export.

l Depending on what you’d like to export, you can always uncheck undesired options

l After selecting Export, an XER file will generate and be placed within your C:/Downloads
folder. The file will be named <job name>(Schedule).xer

l At this point you are ready to import the XER file into Primavera

9.4.2 PERCENT COMPLETE COLUMN UPDATES IN CBS

If you are progressing your schedule in P6, it's possible to import this progress data directly into
Control using the Schedule Integration Import process. The % Complete column records within the CBS
can receive updates from the P6 XER file. The XER file can originate from Primavera or InEight
Schedule. As long as the % Complete data is captured within the XER file, it will update the CBS with
this new schedule information.
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By not using this feature, the % Complete column updates from P6 will not populate the % Complete
column within Control. You would need to update the CBS with the % Complete or claimed quantity via
other methods for completing progress measurement which are addressed in the Progress
Measurement & Forecasting User Guide.

This feature allows for the Schedule Import process to align the P6's schedule % complete with the cost
item's % Complete.

After running the Schedule Integration Import process, you can check the CBS and verify the progress
results in the % Complete column.
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REVIEW

1. Where can you enter schedule dates for your cost items?

a. Cost item details

b. Task details data block

c. Schedule data block

d. On the Schedule tab

e. On the Schedule slide out panel

2. Using the Control Import feature, you can import which of the following types of data?

a. Tasks

b. Current Estimate

c. Schedule

d. Cost Categories

e. All of the above

3. When importing a Primavera schedule, the Schedule ID in Control must match the
_______ in the XER file.

a. Import ID

b. Current Estimate ID

c. Task Details ID

d. Activity ID

e. Start Date ID

4. When using the Define project schedule: Schedule data source feature, which option
allows you to export a Primavera formatted file to eventually be used to import directly
into Primavera?

a. Manual entry file

b. XER file type
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c. Activity ID file type

d. Task Details file type

e. Schedule file type

SUMMARY

As a result of this lesson, you can:

l Navigate to the Schedule data block

l Edit schedule data inside the CBS

l Edit schedule data using Excel import

l Integrate planning activities

l Schedule using Primavera
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ACCOUNT CODE STRUCTURE
(ACS )

LESSON DURATION:   30 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Define what an account code is

l Set up account codes within the library

l Assign account codes to cost items

l Define the quantity contribution for each account code

l Review and analyze the audit log

LESSON TOPICS

10.1 InEight Control Workflow – Account Code Structure 461
10.2 What is an Account Code? 461
10.3 Account Code Setup 462

10.3.1 Staging vs. Published Account Codes 462
10.3.2 Account code permissions 469

10.4 Account Code Assignment 478
10.5 Audit Log 478

10.5.1 CBS 479
10.5.2 ACS 479
10.5.3 Integration 480
10.5.4 Import history 482



10.5.5 Pending status 485
10.5.6 Failed with errors status 487

10.6 Quantity Contribution 488
10.6.1 ACS Navigation 489
10.6.2 Account Code Quantity 489
10.6.3 Quantity Contributors 490
10.6.4 ACS Unit of Measure Toggle 492
10.6.5 Account Code Quantity Conversions 493
10.6.6 Notes Column 495

10.7 Measurement Types 495
10.8 Cost Category Label Customizations 497
Review 499
Summary 499
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10 . 1 INE IGHT CONTROL WORKFLOW –
ACCOUNT CODE STRUCTURE

10 . 2 WHAT IS AN ACCOUNT CODE?

Account Codes serve as a standardized coding system to track like operations across a company, for
the purpose of global reporting and benchmarking. Account Codes typically follow a hierarchical
structure which allows for summary level reporting rolled up to company standards, but can also be a
flat list.

Account Codes are assigned to cost items similar to a tag on a cost item. Once an account code has
been assigned to all terminal cost items you can view many project and organization reports organized
by the account code structure, rather than individual project cost break down structure which often
differs from project to project. Account Codes can also tie back to InEight Estimate where estimators
can assign the same standard set of account codes to estimate items, and compare them to active or
completed projects for historical benchmarking.
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10 . 3 ACCOUNT CODE SETUP

The master set of account codes is created and stored under Master data libraries > Account Codes. 

10.3.1 STAGING VS. PUBLISHED ACCOUNT CODES

The Account Codes master data library contains four tabs: Published, Staging, Audit Log, and Import
Log.
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l The Published tab lists all account codes that have been created and published under the Staging
tab.

l Under the Staging tab, you create and edit account codes, and then publish them for use.
Account codes are not available for use in projects until they are published

l The Audit Log tracks changes made to the Account Code Structure, including the value before
and after, the changed date, and who made the change

l Under the Import Log tab, you can track the status of all the account code import processes.

l When you hover over the Failed with errors imports, a pop-up will provide a brief import
status, along with next steps

l Under the pop-up, there is a down facing blue arrow where you can download a detailed
error log

Account codes are typically maintained at an organization administration level to ensure that
categories and codes remain consistent with company standards.

The account codes within the Account Code Structure are arranged into a hierarchy of parent-child
relationships that can contain varying levels of detail, indicated by color, for each level of the hierarchy.
You can assign account codes to cost items anywhere, from the highest level to the lowest level. The
lower the level assigned, the higher the level of detail associated to the account code.

The example below shows a level 3 account code (50.03.04) acting as a parent to two subordinate
account codes (50.03.04.002 and 50.03.04.004).
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The following Step by Step walks you through how to create a new account code.

CREATE AN ACCOUNT CODE

1. From the Project home page, select the 1st Level drop-down menu.

2. SelectMaster Data Libraries.

3. Select Account Codes.
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l All the account codes appear on your screen in a hierarchy format

4. Select the Staging tab.

5. Click the check box next to any of the existing account codes.

6. Click the Add Account Code button.
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l This creates a new account code with the code you selected as the parent

l In the Account code details slide out panel, the following can be assigned:

Item Function

Parent Account
Code

Account Code with lower level “child” account codes below
it.

Account Code The alpha numeric sequence assigned as the code.

Description Description detailing the account code’s scope.

Currency The currency assigned to the account code.

UoM Primary The primary unit of measure for the account code.

UoM Secondary The secondary unit of measure for the account code.

Auto Quantity
Primary/Secondary

Automatically roll up cost item quantities if the cost items and
this account code have the same primary/secondary UoMs.
It can also be set on a project specific basis.

Parent Roll Up
Behavior

Controls whether primary or secondary quantities of
account code roll up to the parent account code’s primary or
secondary quantity.

Account Code
Tag 1-20

Tags that can be associated to account codes to enable
them to be categorized.

User Defined Field
1-10

Optional open-text fields you can use to add information
related to the account code.
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The asterisk (*) at the beginning of a tile indicates it is a required field and it must
be populated before the code will be created.

7. Fill in the information below:

l Account code: Your Initials (Since a parent was selected when creating this new account
code, numbering prior to ‘–Your Initials’ will be the parent’s)

l Description: Your Initials – Account Code

l Currency: US Dollar

l UoM primary: Ton

l Leave all other defaults/blanks

8. When you have filled out all the information, click Stage to send the new account code to staging
area.

l The new account code now exists in the Account Code Structure on the Staging tab

l The new account code will not be available for use within projects until it is published
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9. If you have the permissions to publish account codes, check the box for the account code you
created..

10. Click the Publish button in the top-right corner of the page.

You can also edit existing account codes within the Account Code Structure, as indicted in the steps
below.

EDIT ACCOUNT CODE DETAILS

1. From the Account Code – Staging tab, select the account code you created.

2. Click the Edit Account Code button.

l The edit account code page opens where changes can be made

Note that only the description, auto quantity primary, auto quantity secondary,
parent roll up behavior, and account code tags can be edited after an account code
has been created. All other items are greyed out and read only.

3. Once you are done editing the account code, click Stage to update the account code.
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10.3.2 ACCOUNT CODE PERMISSIONS

If you have the required permissions, you can delete, replace, or rename account codes.

The account administrator does not have permissions automatically assigned to approve
account codes. Your account administrator must add the permission to approve account
codes in the Master data libraries to the administrative account.

10.3.2 .1 DELETING ACCOUNT CODES

Follow the step-by-step to delete an account code.

If you are deleting a parent account code, all children under the parent are also deleted.

InEight Inc.  |  Release 25.5 Page 469 of 572

Control User Guide 10.3 Account Code Setup



DELETING ACCOUNT CODES

1. Go to the Master data libraries and then select Account codes.

2. From the Staging tab, select an account code you want to delete.

3. Select the Edit icon in the upper-left corner.

4. On the Edit account code page, select Delete account code, and then click Next.
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In the Replacement account code optional text box, you can enter in an existing
account code to replace the account code you are deleting.

5. On the Delete account code confirmation page, select Delete in the lower-right corner.
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6. Click the Stage button.

l This takes you back to the Staging page.
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7. From the Staging page, select Approve all, and then select Approve.

l You can view your current items and deleted items in the Published tab.

The deleted account code shows the following error code in the Cost Item Details and in the CBS tab.
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10.3.2 .2 REPLACING DELETED ACCOUNT CODES

To remove the #REF! error in the cost item details slide-out panel and grid, select the error to open the
Assign Account Code dialog box. Select another account code from the list, and then click Assign. The
error on both the CBS tab and the Cost Item Details slide-out panel is replaced with the account code
you selected.
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10.3.2 .3 RENAMING ACCOUNT CODES

If you have the required permissions, you can rename account codes. Follow the step by step to
rename an account code.

RENAMING ACCOUNT CODES

1. Go to the Master data libraries, and then select Account codes.

2. From the Staging tab, select an account code you want to rename.

3. Select the Edit icon in the upper-left corner.
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4. On the Edit account code page, enter a new name for your selected account code in the
Description text box. Then enter a new name for your selected account code.

5. Click the Stage button.

l This takes you back to the Staging page.
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6. From the Staging page, select Approve all, and then select Approve.

l You can view your current items and renamed items in the Published tab.
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Your renamed account code is viewable through the Account code column, Cost
Item Detail tab, and the ACS tab.

10 . 4 ACCOUNT CODE ASS IGNMENT

Account codes can only be assigned to terminal items. Parents cannot have an account
code.

ASSIGN ACCOUNT CODES TO COST ITEMS

1. From within the Control Workspaces page of a project, select the CBS tab to view your Cost
Breakdown Structure.

2. From the View menu, select the Project Controls view by first selecting View more, if not already
displayed.

3. Within the Task Details data block, click on the right arrow to progress to the Account Code
column.

4. For a cost item you wish to have an Account Code assigned, double click in the Account Code cell
for that cost item.

5. Use the search box to find the account code to assign, then click Select, and then click Assign.

10 . 5 AUD IT LOG

The Audit Log tab within the CBS register is used to capture changes that were made within InEight
Control and is broken down into five sub-tabs located on a left sidebar menu. Each log is designed to
capture the changes that happened within each of the different registers and during syncronization.

All five audit logs can be access by selecting Audit log tab menu bar, then selecting each individual
audit log on the far left.
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10.5.1 CBS

You can access the CBS audit log by selecting CBS from the left side menu.

The CBS audit Log captures changes in the CBS register and utilizes an attribute field to identify what
type of change was made. Other columns include:

l Changed By (who made the change)

l Change Date (the date and time the change was made)

l The attribute value before and after

l Forecast cost before and after

l Forecast man-hours before and after

l Posting date before and after

10.5.2 ACS

You can access the ACS Audit Log by selecting ACS from the left side menu.

The ACS Audit Log functions similarly to the CBS Audit Log, but contains the changes that were made
within the ACS (Account Code Structure) tab. The fields utilized to capture what changes were made
are:

l Change attribute

l Changed By (who made the change)
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l Changed Date (the date and time the change was made)

l Attribute value before and after

10.5.2 .1 PAY ITEMS

You can access the Pay Item Audit Log by selecting Pay Items from the left side menu.

The Pay Item Log again functions similarly but contains changes that were made to the pay items. The
fields utilized to capture what changes were made are:

l Attribute

l Changed By (who made the change)

l Changed Date (the date and time the change was made)

l Value before and Value after

l Total price before and after

10.5.3 INTEGRATION

You can access the Integration/Sync Audit Log by selecting Integration from the left side menu.
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The Sync Audit Log is different from the other three. This log is used to capture:

l Whether the syncronization process between InEight Control and the ERP system was completed
successfully

l How long the sync process took to complete and who requested the sync

It keeps track of the following functions, as seen under the Actions > Sync menu:

l Push CBS Structure

l Push CBS Structure and Budget

l Push CBS Structure and Live Forecast

l Push CBS Structure and Actual Qty

l Get Plan Quantities

l Get Actual Cost and MH

The syncing relationships and process will be discussed further in Lesson 12 - Interfaces.

The status field will automatically update and change from Queued to Succeeded. 
Queued status items can be cancelled if there is an error or if the sync is no longer
necessary by clicking the Cancel a Queued Sync button in the top right-hand corner of the
sync log.

To help troubleshoot sync issues, you can click on the Processing details link to get more information
on which steps succeeded, are suspended, or failed.
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If a sync error should occur, you can click on the Log Handle link to obtain troubleshooting information.

This brings you into the InEight Suite App Logs screen, where you can see information relating to the
error including Level, Time, Domain, Area, Exception Message, Exception Type and Correlation Id,
which can help you determine the cause of the sync error.

10.5.4 IMPORT HISTORY

You can access the Import history audit log by selecting Importhistory from the left side menu.

The Import history log contains status information for all imports coming into InEight Product Portfolio.
For example: cost item and actuals import processes can both be viewed in the Import history log for
status, then you can eventually make corrections and reprocess.
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The Import history audit log allows you to take action on import and sync failures, based on error
messages. Error messages are contained within the Error File Here for those imports that have failed
import.

You can view progress in sync longs, view error messages, and then resolve issues in effort to continue
with your import.

Section Description

1 File name The name of the actual import file being used to import data.

2 Status The current status of the import file. There are six import status that
can define the current state of an import process.

3 Processing
Details

This column describes the processing state in which the file is being
processed. This column is not applicable for all statuses.

4 Total line
items

This is the total line items that are included within the Excel import file.

5 Errors This is a count of the number of errors during import.

6 Total import This is the total amount of records that were successfully imported
from the Excel import file.

7 Added
estimate
resources

This is the total amount of added estimate resources that were added in
the CBS.

8 Added pay
items

This is the total amount of pay items successfully imported from the
Excel import file.

9 Created by This is user responsible for importing the Excel upload file.

10 Created date This is the actual date the Excel upload file was imported.

11 Last edited by This is the last user to edit the Excel upload file.

12 Last edited
date

This is the last date the Excel upload file was edited.

Control – Audit Log
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If you hover over one of these Status symbols below, it provides you with a brief explanation of the
selected status.

Here are some examples:

There are six possible import statuses listed below.

Status
Status
Icon Definition

Failed Import failed due to a duplicate row within the Excel file.
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Status
Status
Icon Definition

Failed with
errors

Import failed with an attachment to download with further information.

Pending The Excel import file is pending, further action is needed. The double
blue arrows will open a new window where you can correct and re-
process the Excel import file. The blue circle with the line through it will
cancel the import completely.

Cancelled The Excel import file has been cancelled.

Processing The Excel import is still processing. Once this is complete, the status
will move into one of the other five statuses.

Complete Processing of the Excel import files is complete.

10.5.5 PENDING STATUS

When an import is in a Pending status, this means that further action is needed to complete the Excel
file import.

There are two options:

Option 1

1. By selecting the double blue errors, you will be taken to another window to continue processing
the faulty records.

As an example, in the below screenshot, there are 3 existing errors. If you hover over one of the errors,
it will tell you what needs to be corrected.

In this case, there is an issue with the account code assignment, as the pop-up hover suggests.

InEight Inc.  |  Release 25.5 Page 485 of 572

Control User Guide 10.5 Audit Log



2. When you double click into one of the 3 errors, it will take you directly into an account code
assignment screen where you can make the correction.

From here you can select an account code and click on Assign.

3. After all corrections have been made to the existing errors, you can select the Import button on
the top right on the screen.
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4. A warning message appears stating that changes will be made, and this project will be disabled
until completion.

5. Once processing has finished, you will receive an Import complete message.

6. The Import history page now shows that the imported file is now successfully imported and
updates the Last edited date.

Option 2

1. Selecting cancel, the blue circle with the line through it, will cancel the import completely.

10.5.6 FAILED WITH ERRORS STATUS

When an import is in a Failed with errors status, the system will generate a Word error report. The
document displays detected errors while attempting to import the Excel file values. Errors will need to
be reviewed within the Word document
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An example of the Failed with errors Word error file provides direction on how to proceed with
correcting the Excel import errors, and a course of action to run the import again

The only option with a Failed with errors status is to review the errors, resolve them within the initial
Excel file import, and then re-import the file.

10 . 6 QUANT ITY CONTR IBUT ION

At the project level, you can manage account codes under the ACS tab from the Control Workspaces
page. On the ACS tab, you can see the account codes assigned to your cost items, along with the
related parent account codes, with account code details and quantity contributors.

Other budget information is automatically pulled into the ACS Details data block including, Total Cost,
Unit Cost, Unit Rates, Primary and Secondary Quantity Ratios, Quantities Complete, and Account Code
Tags. To access this information, click the right arrow to view the second, third and fourth panels of the
data block.
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10.6.1 ACS NAVIGATION

The ACS tree lets you easily navigate up and down your ACS structure and also provides a way to filter
down to a subset in the structure. Open the ACS tree slide-out panel by clicking on the ACS tree icon on
the side toolbar.

Similar to the CBS color coded hierarchy, the ACS gives you the option to differentiate your account
codes by color. Click on the ACS data block ellipsis to select this option to help you identify which level
of the hierarchy a specific account code is located.

10.6.2 ACCOUNT CODE QUANTITY

There are two methods for defining primary and secondary quantities for your account codes:
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l Manual entry in the Primary Qty and Secondary Qty fields

l Using the auto-quantity feature to have them automatically inherit the quantities of any cost
items that have the same unit of measure as the assigned account code

DEFINE ACCOUNT CODE QUANTITY

1. From the Workspaces page of the Steel Structure Job, select the CE + CB viewset from the View
drop-down list.

2. In the Current Estimate data block, double click in the Secondary UoM field for a cost item you
assigned an account code to.

3. Select a Secondary UoM from the drop-down list different than the cost item's primary UoM.

4. Click the side arrow to navigate to the Secondary Qty column.

5. Double click in the Secondary Qty field for your cost item and enter a value.

6. Select the ACS tab.

7. In the Primary Qty field for the account code assigned to the cost item you just changed and type
in a quantity value.

8. For your account code, check the Auto-quantity (Primary) check box.

9. To view what cost items are assigned to the account code, right click on your account code and
select ACS item details.

If you have the account code slideout open and want to open a different account code's item details,
you can select a different account code. The details slideout updates to the current account code's
details. You no longer have to exit out of one ACS item only to right click and select ACS details slide
out to open another.

10.6.3 QUANTITY CONTRIBUTORS

Within your project, you can specify how primary and secondary quantities contribute to your account
codes. Specifically, you can indicate how:

l Cost item primary and secondary quantities contribute to assigned account code primary and
secondary quantities

l Child account code primary and secondary quantities contribute to parent account code primary
and secondary quantities
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For both cost item and account code contributions you can have quantities roll up:

l Primary quantity to primary quantity

l Primary quantity to secondary quantity

l Secondary quantity to secondary quantity

Account codes will only automatically inherit quantities from cost items/account codes
using the same unit of measure.

10.6.3 .1 CONTRIBUTION OPTIONS – COST ITEM TO ACCOUNT
CODE

From the ACS item details slide out panel, you can specify how cost item quantities roll up to the
account code that is assigned to it, by selecting the appropriate checkbox. The total of the contributing
cost item(s)’s quantities will roll up to become the account code quantity.

10.6.3 .2 CONTRIBUTION OPTIONS – CHILD ACCOUNT CODE TO
PARENT ACCOUNT CODE

On the ACS page, in the ACS qty contributors data block, you can specify how child account code
quantities will roll up to their parent account codes by selecting the appropriate checkbox.
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10.6.4 ACS UNIT OF MEASURE TOGGLE

In the ACS register, you can toggle different Unit of Measures. The Unit of Measure toggle has three
different options:

l As entered Unit of Measure

l English (Imperial Unit of Measure)

l Metric

Page 492 of 572 InEight Inc.  |  Release 25.5

10.6 Quantity Contribution Control User Guide



If you want to display and edit in liters instead of gallons for example, you would select the ruler icon
in the top right corner of the ACS register, and then select Metric. The quantity amount converts in the
browser and displays in the alternate unit of measure.

10.6.5 ACCOUNT CODE QUANTITY CONVERSIONS

Cost items that are tracked in one unit of measure can be tracked in another UoM. For example, cost
items that are tracked in a metric UoM can contribute to account codes tracked in imperial UoM. This
saves time in maintaining account code quantities, as project team members do not have to perform
quantity conversions manually. Data accuracy is also ensured since any manual errors are eliminated
from the conversion process.

In this example, CBS item Asphalt Paving and Break Removal contains a Forecast quantity of 3,000 with
a UoM of Square Meter.
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In the ACS, you can display the Primary UoM Alternate System column to see what UoM is needed to
track cost items in, so they contribute to your account codes. The Auto-quantity column is set up so
that quantities are summing up the CBS. The Primary Qty of 3,587.97 is automatically populated. There
is no further action to allow this value to roll up to the account code.

The system will automatically take the Forecast Qty in the CBS, and convert that number to the value
shown in the Primary Qty field displayed in the ACS. In the above example, the CBS Forecast Qty of
3,000 in square meters is being converted to the 3,587.97 square yards, as shown in the ACS.
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10.6.6 NOTES COLUMN

A Notes column is available for you to add to a new or existing data block. The Notes column lets you
add commentary to any of the ACS records.

After notes are added to a record, the Notes column populates with the number of comments that are
currently added to each record.

10 . 7 MEASUREMENT TYPES

In master data libraries units of measure, there are two sections. The sections are Units of measure,
and Measurement types. Using any two Units of measure that share the same Measurement type
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(such as area), you are able to do a measurement type conversion in the ACS.

If you have a cost item with a different unit of measure assigned to an account code, but with the same
measurement type, that cost item can contribute to the same account code.

You can have a cost item with a measurement type of acre contribute its values to its assigned account
code if the account code has a measurement type of square foot. This is Because acre and square foot
are both a measurement type of Area.

The column Primary to Primary lets you choose the cost item that contributes quantities of the account
code.

The items without a check mark, such as Cubic Yards, have a measurement type that is not considered
an area, so you cannot select Primary to Primary for Cubic Yards, Ton, and Each.
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10 . 8 COST CATEGORY LABEL
CUSTOMIZAT IONS

In Master data libraries > Cost categories, there is a Enable custom labels toggle. If this toggle is turned
on, all of your cost category field names come from the custom columns depending on your language
preference in Control. Language preference is located in user settings.

You can overwrite the custom labels if you have the applicable permissions. Depending on where you
have cost categories shown in the product, the overwritten labels show with the new custom labels.

These labels can be viewed at the organization level. Every project within that
organization can see these labels.

If the organization prefers a different field name, it can be renamed using the cost category custom
labels.

Dimmed custom labels cannot be overwritten. For example, the Field name Total.

If the custom label for the field name is blank, then the custom label column will use the default name
for the field name column.

One way of finding these custom labels in the project is by going to the CBS register. From there, open
the Cost Categories slide-out panel. Under the Cost category column, find your custom label. For
example, the Labor Base field name can be customized and renamed L-Base.
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These changes can take a few minutes to fully generate because custom categories span
the entire project.

If the Enable custom labels toggle has been shut off, then the category names come from the Field
names in the Master data libraries only.

Page 498 of 572 InEight Inc.  |  Release 25.5

10.8 Cost Category Label Customizations Control User Guide



REVIEW

1. Account codes are created inside which of the following:

a. ACS register page

b. Library

c. Project settings

2. Which of the following are account codes used to track?

a. Quantity

b. Budget

c. Account Code Tags

d. Unit Costs

e. a, b, and d

f. All of the above

3. Which of the following is not tracked in the CBS Audit Log?

a. Change Attribute

b. Changed By

c. Change Date

d. Pay Item Value

e. Forecast Cost Before and After

SUMMARY

As a result of this lesson, you can:

l Define what an account code is

l Set up account codes within the library

l Assign account codes to cost items
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l Define the quantity contribution for each account code

l Review and analyze the audit log
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LESSON DURATION: 30 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Explain the InEight cloud platform Functional Flow diagram

l Explain the different InEight Control Push interfaces and use cases

l Explain the different InEight Control Get interfaces and use cases

l Identify where to go to audit sync transactions
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11 . 1 INTERFACES OVERV IEW

The InEight cloud platform has several options for synchronizing information from one platform to
another. This gives you multiple options to utilize data efficiently between various programs, saving
you time and resources.

The table below shows you the high-level functions of multiple platforms to help you better
understand how these tools interrelate.

Title Description

Estimate Create CBS / ACS / WBS structures
Create cost estimates
Analyze contractor/supplier quotes
Prepare bid proposals
Benchmark estimate values

Contract Create and manage bid packages
Set up and manage contracts
Create and manage issues and change orders

Control Edit CBS / ACS / WBS structures
Manage budgets and contracts
Manage forecasts
Record actuals (manual entry, or import from Plan and ERP)
Calculate job costs / variances, earned values, contract earnings

Plan Associate planning components with CBS / ACS / WBS structures
Create work plans and packages

Progress Create work plans and daily plans
Record progress and timesheets (as-builts)
Approve executed daily plans

ERP Budget, Payroll, Forecasts, AP/AR, Final Costs

Overview – Interfaces
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For this lesson, you will focus on the programs that integrate directly with Control (after the initial
import from Estimate) and will go over how to perform the basic “Push” and “Get” actions to move
data between systems. 

The workflow diagram below shows the connections between the programs, and details on what data
passes between the various InEight products:

11 . 2 PUSH AND GET ACT IONS

Control Integrations typically have one direction that specific information travels. As data is generated
or modified in one product, it does not automatically change in other connected products
downstream; you must perform a sync action, referred to as “Push” or “Get”.

l A Push sync occurs when you are in a program and you would like to send information to a
different program

l A Get sync occurs when you are in a program and you would like to retrieve information from a
different program

You can view the various integration options by clicking on the Actions menu from the Control main
page and hovering over the Sync option.  The image and table below give a description of the sync type
functions:
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Sync Type Function

1 Push CBS Structure Syncs the Control CBS Structure to the ERP system.

2 Push CBS Structure
and Budget

Syncs the Control CBS Structure, budgeted quantities, man-
hours, and costs to the ERP system.

3 Push CBS Structure
and Live Forecast

Syncs the Control CBS Structure and Live Forecasted
quantities, man-hours, and costs to the ERP system.

4 Push CBS Structure
and Actual Quantities

Syncs the Control CBS Structure and job-to-date actual
quantities to the ERP system.

5 Push CBS Structure,
Budget, Live Forecast,
and Actual QTY

Simultaneously performs all the syncing functions listed above
(1-4).

6 Push Pay Item Syncs the Pay item list and data to the ERP system.

7 Push Billed Revenue Syncs job to date billed amounts to the ERP system.

8 Push Forecast
Revenue

Sync pay item revenue values (billed revenue, earned
revenue, forecast revenue).

9 Get Quantities
(Through Previous Pay
Period or Job To Date

Retrieves the claimed quantities from InEight Plan and
incorporates the information to Actual QTY within Control.

10 Get Actual Cost and
MH

Retrieves actual project costs and man-hours from the ERP
system and incorporates the information to Actual Costs and
Actual Man-hours within Control.

11 Get Billed Revenue Retrieves billed amounts from the ERP system and
incorporates the information to Billed revenue within Control

Overview – Sync Options
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SYNC OPTIONS

1. From the Control main page, click the Actionsmenu.

2. Select Sync from the Actions drop-down.

3. Select Push CBS Structure from the Sync drop-down.
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l A toast message appears at the top of the screen showing the process initiated

l You follow the same steps for selecting the other synchronization options

l For the Get Plan Quantities option, you will need to select the Through Previous Pay
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Period option

11 . 3 AUD IT LOG INTEGRAT ION

As you utilize the sync option, you have the option to go back and audit the status of the actions taken.
The Audit Log Integration displays any synchronization process that has been initiated and its status.  It
is used to capture whether the synchronization process between InEight Control and the ERP system
was completed successfully.  The log can also tell you how long the sync process took to complete and
who requested the sync.

SYNC AUDIT LOG

1. From the Control Workspaces page, click on the Audit Log tab.

2. On the left side bar menu, click on Integration.
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l The log displays the current sync status

11 . 4 SCHEDULED SYNCS

Scheduled syncs let you set a time and date for the type of information you want updated from either
push or get data.

You can set up recurring syncs or a one-time sync to get up-to-date costs on man-hours. Scheduled
syncs occur at the point and time you scheduled them for.

To start scheduling syncs, the tab Sync integrations has been added to the Control Project settings.

If no syncs are scheduled, you can add a sync by selecting the Add sync schedule button.

There are five required fields you must fill out in order to schedule a sync.

l Sync type

l Time zone

l Start date
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l Time to run sync

l Repeat

Sync types lists all available push and get syncs.

The Time zone is where you select which region's time zone you are in.

Start date functions similarly to selecting a start date for a project. You cannot select to start a sync
from a day in the past. The scheduled sync starts at the current day by default unless you select
otherwise.
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You can only select start times in 30 minute increments.

The Repeat section is where you select how often a scheduled sync repeats. You can choose to have
the sync repeat daily, weekly, monthly, or never depending on your preference. You can end the
schedule syncs on a certain date or end after a number of occurrences.

For daily syncs, select how often you want to repeat the sync or when you want the reoccurring syncs
to end.

For weekly syncs, select which days the sync repeats on as well as when you want the sync to end.
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For monthly syncs, select what day in the month the sync repeats and when you want the sync to end.

After you click Add, the sync appears in the synch integrations tab.
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You can edit syncs or delete them using the edit and delete buttons on the far right of the sync data
box.

You can schedule all your syncs for the project at one time. If you already have syncs
configured for currently existing projects, you don’t need to reconfigure your setup for
this feature.

For any new projects that do notyet have scheduled syncs set up, you need to go to the Application
integrations section of Control. Follow the Step by Step to navigate to the Application integrations
page.

NAVIGATING TO APPLICATION INTEGRATION

1. From the header bar, select the projects drop-down.

2. Hover over Suite administration. That is where you would set up all of your sync configurations.

3. Select Application integrations.
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REVIEW

1. How can you know a sync process initiated?

a. Viewing the CBS Audit log

b. Appearance of a toast message

c. There is no way to tell

2. Where can you view the status of a sync process?

a. In the Change Register

b. On the CBS tab, in the Forecast data block

c. On the Pay Items tab, under the sync status column

d. In the Sync Audit Log

SUMMARY

As a result of this lesson, you can:

l Explain the InEight cloud platform Functional Flow diagram

l Explain the different InEight Control Push interfaces and use cases

l Explain the different InEight Control Get interfaces and use cases

l Identify where to go to audit sync transactions
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CONTROL SETT INGS

As an administrator, you can configure settings at the organization and project level in Control. The
correct setting details must be added to manage projects successfully.

l Organizational settings— Settings configured at the organizational level are inherited when
creating associated child organizations and new projects within the organization. You can
configure organizational settings in Main menu > <organization> > Settings > Control.

l Project settings— At the project level, you can refine the default inherited organizational
settings to customize how they are applied in each project. You can configure project settings in
<project> > Settings > Control.

Organizational settings are applied as default settings for new projects. As an administrator, you can
configure the default project settings to how they will apply to your individual project.

12.0.1 CONSIDERATIONS

You must have Level 3 – Account Admin permissions in InEight Platform, or an assignment to the root
organization based on permission configuration.



Every new project launch has its own particularities, and the setup and initialization of these projects
depends on multiple factors, such as:

l Project organizational structure

l Staff and resources assigned

l Location of the project

l Units of measurement

l Currencies

l Financial reporting period

This lesson covers how to set up these project options.

Establishing roles and permissions is an administrative function. As such, access to these
settings may not be available to you, as the setup of these settings may not be within the
scope of your daily tasks.

12.0.2 USER MANAGEMENT

The User Management page provides a list of users inside your organization. You can view any user’s
project access, roles, and permissions within your organization. Users with required administrative
permissions can edit and grant permissions to other users, up to the equivalent level of access they
have been granted.

VIEW THE ROLE AND PERMISSIONS OF A USER

1. From any InEight application, click on the First Level Menu in the upper left corner of your
screen, and from the drop-down menu, select Suite Administration, then User Management.
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2. Scroll down the list or use the Search field to find and select a user.

3. To view the record, right click on the name, and select Show Info.

l You can also click on the Show Info button located on the upper-right register menu bar

InEight Inc.  |  Release 25.5 Page 517 of 572

Control User Guide



You can use the Search located in the upper right corner of the page to search for a
keyword in any column in the User Management database.

l Once you click on the Show Info option, a slide out panel appears on the right. From
this panel, you can view the contact information, as well as the role and project
access of that specific user.

Note that once your organization implements the InEight cloud platform, you will
be able to link your contacts’ address book to your user information.

12.0.3 ORGANIZATIONAL BREAKDOWN STRUCTURE

The Organizational Breakdown Structure represents the way your company is structured and divided,
such as departments, districts, sectors, etc. Roles and permissions can be added at different levels in
your OBS, so users with a district level access would have access to all the projects under that district’s
umbrella.

Page 518 of 572 InEight Inc.  |  Release 25.5

Control User Guide



12.0.4 ROLES AND PERMISSIONS

A role is defined as the function that a user occupies inside an organization or project. A role in
Platform contains a set of predetermined authorizations and permissions. When a role is assigned to a
user, they acquire all the permissions of that role in the project or organization that you can assign to
users or project staff. With sufficient rights and permissions, you can add or remove a role and all
access it provides from the user. The Roles and Permissions section is where you can view what
permissions each different role has. Refer to Platform topic for information about adding, deleting,
modifying, and assigning roles.

The administrator levels range from 0-3 and give you a predetermined set of permissions,
with the lowest level giving read only access, and higher levels having more abilities to
adjust settings and edit fields within the InEight portfolio of products.

InEight Control has many permissions that control important functions within the program. 

12 . 1 PROJECT SETT INGS

To manage a project successfully in Control, the correct project details must be added before project
initiation. To view project details, go back to the All projects & organizations page of the InEight cloud
platform.
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12.1.1 ORGANIZATIONS PAGE

The Organizational Breakdown Structure (OBS) represents the hierarchical company structure. It can
have regions, such as Eastern and Western, and within those regions, the company can have also
divisions, such as Electrical, Paving, and Masonry. The organization can continue to be more refined to
the level such as states, cities, districts. Projects are the lowest level of the structure but they do not
show in the OBS.

The OBS controls your access. Where you are assigned in the organization determines what access you
inherit and the visibility you have to other areas of the OBS. The higher the level a user is placed on the
OBS, the more actions they can perform, and the more organizations and projects they can view. A
user assigned at only the project level has no visibility to any other projects or administrative pages.

To access the OBS, go to All projects & organizations > Organization.
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12.1.1 .1 UNIQUE BUDGET CODE SEGMENTS

You can populate budget segments in Workspaces to show a unique code label. Unique budget code
segments contain additional options to identify a cost item using four independent fields that are
separated by periods. Budget codes can be configured at the organization level and are primarily used
with Time Center.

When the edit WBS phase codes and budget segments permission is assigned to a role in Suite
administration > Roles and permissions > Control, users are allowed to populate the WBS phase codes
and budget segments in the CBS workspace. This permission only applies based on configurations set
for the WBS phase code and the budget segments. The edit WBS phase codes and budget segments
permission must be selected to allow users to edit WBS phase codes and budget segments.
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When only the Add wbs phase code and budget segments permission is assigned, users are only
allowed to import WBS phase code and budget segments, and not to edit them.

When importing, users who have only been assigned the Add wbs phase code and budget segments
permission must use the New items option in the Import CBS data dialog box.
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OPEN PROJECT DETAILS

1. From the All projects & organizations page, right-click on your job.

2. Select Edit Project, or click the Edit icon.

12.1.2 PROJECT PAGE

The Edit Project page is where general project setup information is edited and stored, including the
following settings:

l Project Details

l Location

l Project Dates

l Prime Contact

l Currency and Markets
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12.1.3 PROJECT SETTINGS

You access Project settings from the Project home landing page. From the Project home page, you can
either:

l Select Settings from the side menu

l SelectManage settings on the Settings tile 
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The Project settings page contains setup information for all the InEight products, including Control. A
list of tabs on the left allow you to navigate to the appropriate settings for each application.

The settings that pertain to Control are located under two of the tabs, as listed below:
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l General

l Home Page

l Global Options

l Fiscal Calendar

l Document Types

l Custom Lists

l Attribute Definitions

l Menu Options

l Control

l Project Tracking (Organization, Project)

l Forecast (Organization, Project)

l Estimate Resources (Organization, Project)

l Schedule (Organization, Project)

l Revenue (Project)

l Sync Integrations (Project)

l Others (Organization, Project)

12.1.4 HOME PAGE

The Home Page tab lets you create URL links to be placed directly on the Project home page at both
the Organization and Project levels.
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12.1.5 GLOBAL OPTIONS

The Global Options tab controls the master data libraries, cost item integration behavior, advanced
work and scheduling features, and the template library. The three cost item integration behaviors
provide flexibility in how to configure Control with and without a direct tie to an ERP system. There is
also an option to pass cost items directly from other sources to applications.
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12.1.6 FISCAL CALENDAR

The settings in the Fiscal Calendar can be set at the organization and project levels. These settings
specify the start and end dates for fiscal years and financial periods, such as month-end dates. It is
important to know the different cut-off dates, especially when you pull the current period actual
quantities to compare them to prior periods, or when you synchronize your quantities with the other
applications.

Changes to a project level fiscal calendar only impact the project, while changes to the organization
level fiscal calendar impact all projects that do not have fiscal calendar modifications. If there are no
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changes at the project level, and the project matches the organization fiscal calendar settings, the
project inherits the organization-level settings.

Any changes to the project fiscal calendar impact read-only snapshots, which are captured at the
closure of month-end plus days, for the period month being closed. Changes also influence the
monthly time buckets in time phase forecasting and budgeting and to the time periods in which claims
can or cannot be posted.

12.1.7 DOCUMENT TYPES

You can assign a document type to InEight applications. This lets you filter the payload of Document
Types for visibility and use in the assigned application.
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12.1.8 CUSTOM LISTS

Like the tag feature in InEight Estimate, you can enter your tags and their values to use later for
categorizing your cost items as you manage your project in Control.

Many of the tag fields are validated fields, meaning you can choose from options in a drop-down list.
You define both the names of the tags and their drop-down values here.

The field names associated with Cost breakdown structure and Account codes, are tags defined and
editable at the organizational level; you cannot edit them at the project level, as indicated by the
statement “Inherited from parent organization”.

12.1.8 .2 CBS URL COLUMNS

You can create direct links to URL addresses outside of Project Suite under Custom Lists. In the URL
Field values you can define a URL with associated criteria to be used as an attribute for a cost item in
the CBS.

In the URL Builder enter a URL that you want associated with your list name, along with any other
dynamic attributes such as Project ID and CBS position code. Paste your URL and highlight the section
you want to reference with another field. First highlight an attribute in the URL string, and then click
the [T] reference icon to select which field to connect with.
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These quick links are accessible in the CBS and can contain detailed information pertaining to the cost
item and project, which can also link to external reports.

In the CBS cost item details attributes slide-out panel, the URL is concatenated to include the attributes
defined. A link is included on a cost item that opens a new tab.

The links can also be accessed in the CBS register. Up to five CBS URL columns can be viewed in a data
block in the CBS, per project.

At the organization level, CBS URL columns 6, 7, and 8 have been added to the CBS register. When you
define a CBS URL, it is then applied to each of the organization’s projects.
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Creating organization-level CBS URL links lets you associate shared documentation, such as external
standard reports that are used across the organization. Instead of setting up links for every project, you
can create a CBS URL link in Settings > Custom Lists.

12.1.9 ATTRIBUTE DEFINITIONS

Attribute Definitions are used to define project attributes which can be of the types text/date/number
or can have source values from Organization, Project, and Market master data. These definitions are
inherited to all projects in the organization.
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12.1.10 MENU OPTIONS

The below URL addresses specific to InEight products are updated when licenses are purchased or
activated. The URLs are customer specific. The ability to maintain the URLs are intended for users with
account admin only (root Org Setting) permissions. If no other products are purchased or activated, the
URL opens an InEight related page to learn more about the products.

12.1.11 PROJECT TRACKING (ORGANIZATION &
PROJECT LEVEL)

Under the Control tab, Project Tracking settings configure how your project tracks progress and
percent complete in Control.

These settings include the following options:

l What level to lock down your CBS structure to

l What value to base percent complete off

l If percent complete are capped at or allowed to exceed 100%

12.1.11.3 TASKS

The first option in the Tasks Section lets you maintain your CBS structure at a specific level. Selecting
yes, lets you determine your own CBS structure level.
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The second option is WBS Phase Code. Select Yes or No under the Generate WBS phase code
automatically?

l Yes indicates phase codes for newly created cost items to be automatically generated

l The WBS Phase code generation method regenerates all values beginning from the specified
start value

l The value entered in the WBS Phase code start value is the phase code for the first cost item
created. When automatic phase code generation is activated, the proceeding new cost items is
automatically created based on the phase code generation method selected.

l No indicates phase codes for newly created cost items must be manually entered

ENABLE MANUAL SNAPSHOTS

You can create a manual snapshot of Control project data in the CBS and Pay Items registers.

If you have the Enable manual snapshots setting enabled, you can create a snapshot at any point in
time, separately from any of the above-mentioned syncs.
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When the Enable Snapshots settings is enabled, you can select the Take Live Snapshot option from the
Current Live Forecast drop-down menu in the CBS to capture current values in the Live Forecast,
Current Budget and Current Estimate.

Snapshots can also be taken from the Actions menu.
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You can view the draft snapshot by selecting the View draft snapshot from the Current live forecast
drop-down menu. This lets you know that the draft snapshot is not yet finalized for the current month.

When you select View draft snapshot, the snapshot values load into the CBS in a read-only status.
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When you select the Take Live Snapshotmeu-option, consecutively, a message lets you know that an
existing snapshot already exists and a choice to override the previous snapshot.

The same snapshot functionality now exists in Pay Items, with the exact same option.
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ALLOW SYNCS TO REPLACE SNAPSHOTS

When the Enable manual snapshots and the Allow syncs to replace manual snapshots toggle is turned
to On, the manual snapshot is replaced when the Push Live Forecast and/or Push Forecast revenue is
synced. If this setting is disabled, syncs are replaced with manual snapshots.

12.1.11.4 ACTUALS

The image and table below give a brief explanation of Project Tracking: Actuals settings.

Title Function

1 Calculate %
complete

Calculate percent complete for individual cost items as a percentage
of:

l Forecast (T/O) Quantity
l Current Budget Quantity

2 % complete
cap

Cap any cost item percent complete at 100%

3 Calculating
roll-up method

Calculate percent complete for roll-ups, such as superior cost items
and account codes by Cost or Manhours

Overview – Project Tracking: Actuals
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Title Function

4 Roll-up %
complete

Roll-up percent complete weighted by
l Current Budget
l Current Estimate

5 Calculate man
hours earned
at the parent
level by…

Calculate man-hours earned for roll-up items by summing the man-
hours earned of the contributing items (regardless of roll-up items
percent complete).
Option 1: The summation of man hours earned from direct child items
Option 2: The total man hours multiplied by percent complete

6 Get actual
cost from
Contract

When turned on, the subcontract actual cost is received from
Contracts. Actual costs from Contract can consist of a goods receipt,
an accrual, or an invoice receipt/payment form. If a goods receipt and
an invoice receipt come in at the same time for a record, the higher
cost is recognized and not duplicated.

7 Drive
committed cost
values from
Contract

When turned on, the committed costs is driven from Contracts. When
turned off, committed costs are derived from the ERP.

8a Update %
complete from
Contract

Quantities that are claimed in Contract for SOV items updates the
percent complete in Control when the Update % complete from
Contract switch is enabled. Updating the percent complete provides
you with another way to claim quantities against schedule of value
items in Contract.
When quantities are claimed against a schedule of values item in
Contract and the Get quantities sync is executed in Control, the cost
items actuals quantity completed gets updated with a percentage
claimed toward the contract's schedule value total cost.

Overview – Project Tracking: Actuals (continued)
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Title Function

8b Calculate
percent
complete for
individual cost
items as a
percentage of

Calculate the percent complete for individual cost items as a
percentage of

l Current estimate total cost
l Committed total cost
l Forecast total cost
l Current estimate total cost

Overview – Project Tracking: Actuals (continued)
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12.1.11.5 ESTIMATED ACTUALS

This feature allows estimated actuals to be accrued to a cost item, then used to contribute to the
forecast. This results in the forecast being more accurate. The estimated actuals are calculated based
on the cost category values associated to the cost items.

When Turn on estimate actuals is enabled, you can choose to turn on or off estimated actuals based
on the cost category. You can enable estimated actuals in both Control and InEight Progress.

When any one of the following cost categories are enabled, the Claim Actuals tab shows the option
when claiming quantity to accrue estimated cost based on the amount claimed.
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You access the Claim actuals tab from the Control > Workspaces page by right-clicking the cost item on
the CBS tab and selecting Actuals details. The Actuals details slide-out panel is then shown where you
can select the estimated actuals option.
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On the CBS tab, the estimated actuals are shown as columns. These values can be added to the
Confirmed actuals (actuals that were imported into Control or manually entered in Control) to get all
the actuals for the project that are available. This helps you more accurately forecast your project.

12.1.11.6 ENABLING ACTUALS FOR PROGRESS

Using an example for Progress, if you have labor cost and man hours enabled for Progress and there is
an approved daily plan in Progress, those man-hours go over to Control automatically as estimated
man-hours. Then, those man-hours generate an estimated cost based on the operational rates for that
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resource. In this case, it would be using the Straight time rate, the Double time rate, and the Over time
rate.

The same process can happen for construction equipment and equipment hours. For example, if you
claim equipment hours in Progress and they are in an approved daily plan, then those hours go over to
Control as estimated equipment hours. The operational and equipment resources also have a unit cost.
Those hours times for that unit cost can then be used to generate an estimated construction
equipment cost.

12.1.11.7 ENABLING ACTUALS FOR CONTROL

If man-hours and equipment hours are enabled, then you claim a quantity, it can generate estimated
man-hours and equipment hours if there are CE amounts on those hours. For example, CE man hours
per unit and CE equipment hours per unit can be estimated. If those are nonzero and you claim
quantity, then the estimated man hours and equipment hours are generated.

If you do not have estimated actuals enabled in the project settings, you do not see any of the
Estimated actuals columns, and you also cannot add them to your view. Some of these columns are a
direct correlation with Progress.

Some of these columns are also from Control. The columns from Progress generate actual man-hours
and equipment hours from claimed quantity in Control. These columns come over directly from
Control and they affect your forecasts. Any estimated man-hours are included in your man-hours to
date and then the estimated actual cost is included in your total cost to date.

Your forecast equations look for total cost to date, man-hours to date, and equipment hours to date to
generate forecasts.

12.1.11.8 ESTIMATED ACTUALS PROCESS OVERVIEW

When you have synced everything from Progress, it is now in your ERP system. You can then bring in
the man-hours and equipment hours through the sync.
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After the sync is completed, you can reverse the estimated actuals as they have been accounted for as
confirmed actuals by bringing the actuals through the sync.

The Estimated columns are only general estimates. They are not confirmed hours until synced with an
ERP or an external payroll system. With an ERP you can make changes to where you can have taxes
added on which would raise the price for the estimated actuals. Estimated actuals that go into Control
from Progress are not guaranteed to be 100% correct. Your ERP is what confirms the final cost.

12.1.11.9 REVERSING ESTIMATES

When you bring in values from your ERP system, you can reverse your estimates with the actual values
as the replacement.

If you keep the estimated values without reversing after syncing with ERP system, those
values are detected as double values.

REVERSING ESTIMATED ACTUALS

1. From the CBS, select the cost items you want to revert actuals.

2. Select the Actions drop-down menu.

3. Hover over Reverse estimated actuals. Then, select Reverse estimated actual eqiup hrs and
const....
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4. Click Yes to confirm reversal.

You can also select Reverse estimated actual cost or Reverse estimated actual MHrs and labor
cost.

5. In the CBS, look for the Last estimated actual man hours reversal or Last estimated actual
equipment hours reversal columns.

Those columns show the date of the last time you reversed the amount.

In the actual history, the reversal shows as negative entries when you have successfully reversed
the estimated actuals.
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12.1.11.10 TIME PHASING BUDGET

Time phasing your forecast lets you take your forecast and break it down into more consumable,
estimate related time blocks/periods. This gives you more visibility into what activities and costs are
going to occur in smaller time periods. Time Phasing is explained further within the Forecasting lesson,
under Time Phased Forecasting.

Time phasing the budget lets you plan out where to spend money in the months of the active fiscal
calendar for your project. Time Phased Budget is explained further within the Revenue lesson, under
Time Phased Budget.

12.1.12 FORECAST (ORGANIZATION & PROJECT
LEVEL)

12.1.12.11 TIME PHASING

Time phasing your forecast lets you take your forecast and break it down into more consumable,
estimate related time blocks/periods. This gives you more visibility into what activities and costs are
going to occur in smaller time periods. Time Phasing is explained further within the Forecasting lesson,
under Time Phased Forecasting.
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12.1.12.12 FORECAST

The image and table below give a brief explanation of Project Tracking: Forecast.

Title Function

1 %
complete
for delta
from
straight-
line

% complete threshold for delta from straight-line calculation:

By configuring the value of % Complete threshold, you can determine the
equation used for the Delta from Straight-Line column depending on if
those cost items have their % complete greater than or less than the value
set in configurations.

Changing the threshold and impacting the formula is necessary because
when a cost item has not been sufficiently completed, the actuals data is
not yet reliable enough to predict the final anticipated cost (forecast cost) of
that scope of work, so a different equation should be used until that cost
item has been sufficiently completed.

For example, if the threshold is 3% complete, and a cost item is less than
3%, then delta from straight line = Forecast total cost - CB total cost. Once
the cost item has reached 3% complete, then the calc switches to Forecast
total cost - Average performance total cost

Overview – Project Tracking: Forecast

You can set manual forecast notes to be mandatory when switching to a manual forecast type. When
the Mandatory notes for manual Forecasts switch is set to On, entering forecast notes is mandatory for
Manual (EAC) and Manual (ETC) forecasts.

When manually forecasting, notes are required to be entered in the Forecast Notes dialog box. Once
confirmed, the notes are captured, and the forecast method automatically changes toManual.
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This feature helps to keep track of manually entered forecasts. You can use the notes to explain the
forecast. For example, you can enter a rationale for why a manual forecast is being used.

12.1.12.13 CUSTOM FORECAST METHOD CALCULATIONS

You can create custom forecast methods at both the project and organization levels by configuring
your own calculations.
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To create a custom Forecast Method, click Add custom forecast method, and then enter the Forecast
Method Name, Forecast Total Cost and Forecast Total Mhrs calculations. You can create a maximum of
10 custom organization and project level forecast methods each at one time.

Select the Formula icon to choose fields to include in your forecast formula.
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In the CBS you can set the Custom Forecast Method for a cost item at the organization or project level,
which updates the Forecast Total Cost and Forecast Total Mhrs based on the calculations created in
Settings.
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12.1.12.14 ENABLE FORECAST METHODS BASED ON ALLOW
AS-BUILT SELECTIONS

Select which forecast methods can be used based on the allow as- built settings, for both terminal and
non terminal cost items.

There are multiple forecast allow as-built options to choose from to help you configure your forecasted
cost items, in addition to the existing available Control forecasting methods. When an option is
disabled, that method is not available to select for cost items with the allow as-built selected.
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12.1.13 ESTIMATE RESOURCES (ORGANIZATION &
PROJECT LEVEL)

The Wage rate composition determines what percentage of each labor hour will be calculated at the
scale 1, scale 2, or scale 3 rate.
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12.1.14 SCHEDULE (ORGANIZATION & PROJECT
LEVEL)

Under the Schedule sub-tab, you can define the data source for your project's schedule using manual
entry or import using and XER type file. You can also create custom cost curves to apply to your
progressed work, based on actual costs and schedule. Plug day calculations and Schedule ID's are also
maintained in the Schedule tab.
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12.1.15 REVENUE (PROJECT LEVEL)

12.1.15.15 REVENUE AND COST TIMING

You can change the Retention percentage, Tax rate, and Payment Timing at the cost category level.
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You can set the average calendar days elapsed from the billing collection, in addition to setting the end
of project date to any of the options available in the drop-down menu.

You can also enter a default retainage percent that is held back from each bill on the pay items. Pay
item retainage creates an incentive for contractors to complete contracted work on a project.
Typically, contractors do not get paid the total amount of money until all work or a set milestone is
completed. With pay item retention, an agreed upon retainage percentage is held back by the owner
for each bill by the client until the owner agrees to release the retention.

When changing the Default retainage percent setting you can choose to either update all existing items
on a project, update matching existing pay items, or only apply to pay items created in the future.

When it is time to bill for a pay item, the retainage percentage is used to automatically withhold the
percentage of the bill specified in the Billed Revenue details slide-out panel. You can also see your
adjusted net bill which excludes the retention withheld amount.
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On the Pay Items page, the Net billed revenue shows $90.00, while $10.00 is being withheld.

You can also release and track your full or partial retention amounts in both Billed Revenue Details and
Bill Multiple Pay Items, set a retention release date, then view the results in the Pay Item register.

When approving contract adjustments from Change to Control, pay item amounts are not required to
equal the amount received from Change if the Enforce change order price values to match between
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Control and Change is turned off. In Settings > Control > Revenue, disabling the switch to theOff
position is ideal when pay items are not being used in a contract adjustment.

The example below shows a CCO agreed price of $101.00 and an Adjusted current price of $22.00.
When advancing to the Summary page, you can now approve the contract adjustment without the
CCO agreed price and Adjusted current price matching.

When the Enforce change switch is enabled, the error message below stating that the contract
adjustment cannot be approved shows when the Adjusted current price does not equal the CCO price.

InEight Inc.  |  Release 25.5 Page 559 of 572

Control User Guide 12.1 Project Settings



12.1.15.16 BILLING METHOD DEFAULT EARNINGS RULES

You can also manage the settings for billing method default earning rules, pay item forecast quantity
rollups, and the markups. You can select the default earnings amounts based on forecast takeoff
quantity. The default earnings are calculated using the forecast takeoff quantity of the cost item and
comparing it to the total forecast takeoff quantities of all of the cost items assigned to that pay item to
generate the percentage.

The Fixed final price and Unit price settings let you select a default way to calculate those earnings
amounts based on takeoff forecast quantity or CE final cost. After the settings are saved, all of your
fixed final price pay items that normally calculate based on CE final cost and unit price then calculate
forecast takeoff quantity or any of the other options you select. You can still modify this selection at
the pay item level.

12.1.15.17 PAY ITEM FORECAST TAKEOFF QUANTITY
ROLLUPS

In the Revenue tab, you can manage settings for Pay Item Forecast takeoff quantity rollups. This setting
is used for pay item unit price only.

The toggle is only applicable to unit price pay items. It lets you enable the pay item forecast take-off
quantity to be calculated based on the sum of all the assigned cost items forecast takeoff quantities.

When enabled, you can no longer edit your pay item forecast takeoff quantity in the Pay item register.
If you click a field, you can no longer edit that field.

The Fixed final price and Cost plus values can be edited. The calculation is the sum of all the
contributing cost item’s forecast takeoff quantities. It can contribute to the pay item forecast if it has
the same unit of measure.

For example, you cannot add unlike units of measure. Only cost items that have the same unit of
measure as the pay item can contribute to that pay item’s forecast takeoff quantity.
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In the image above, the two cost items have different units of measure.

Cost item 1 has a unit of measure of box, which also has the pay item contribute quantity box checked.
Cost item 2 has a unit of measure of bag with the pay item contribute quantity box unchecked. When
you go into the update earning rules editor, you cannot check the pay item contribute quantity box for
cost item 2 because the unit of measure does not match with cost item 1.

If you deselect the pay item contribute quantity box for cost item 1, the cost item’s quantity does not
contribute to the pay item’s quantity. Then, the pay item quantity is zero. If it is checked, cost item 1
with the unit of measure of box has a forecast takeoff quantity of 150. This means the pay item also
has a forecast takeoff quantity of 150.

In the CBS, you can change the Unit of Measure from bag to box, and then forecast take off quantity
updates.
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By default they both now have the pay item contribute quantity checked and the pay item forecast
take off quantity is the sum of any cost items that have pay item contribute quantity checked.

For example, with cost item 2 updated, the forecast takeoff quantity from of 100 is added to the
forecast takeoff quantity of cost item 1. The total forecast takeoff quantity is now 250. It includes both
of them since they now both have a matching unit of measure.

Also, this affects you earnings percent as well if you have forecast takeoff quantity selected. The pay
item contribute quantity for both cost items drives your earnings percent if the forecast takeoff
quantity radio button is selected. It also decides which cost items are going to contribute to the pay
item’s forecast takeoff quantity.

When you turn on the pay item forecast quantity rollups, the Pay item contribute
quantity column does not show by default. To add it, go into the columns chooser, and
then select that column. After it is brought into your view, it remains there until you
deselect it from the columns chooser.
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When you are in the Update earnings rule dialog box, the Pay item contribute quantity column is a
default column in that view because it column is editable in the Update earning rule dialog box. That
column is not editable in the main table. You can only select to add it to your main table view in the
pay item slide-out panel for informational purposes.

The Pay item contribute quantity column is not available if the setting is off or if you are looking at a
unit price pay item. If the setting was turned on and a user brought in the column and then decided to
turn that setting off, then those columns would disappear.

12.1.15.18 PAY ITEM FORECAST TAKEOFF QUANTITY ROLL
DOWN

When the amount of contract deliverables changes on unit price contracts, manually updating all the
quantities for every associated cost item can be time consuming. Pay item forecast take off quantity
allocations can be proportionally rolled down to the assigned cost items by setting the Enable pay item
Forecast (T/O) qty roll down switch to On in Settings > Control > Revenue.
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The unit price pay item Forecast (T/O) quantities proportionally rolls down to the contributing cost
items’ Forecast (T/O) quantities. Pay item to cost item roll down changes also show in the CBS Audit
log.

The Allow as-built setting must be set to All or Quantity for the selected cost items.

12.1.15.19 MARKUP

For more information, see Markup.

In Revenue tab, you can configure a default markup percent that applies the markup to the entire
project. The Markup percent table adds a markup per cost category and per resource type on all of the
cost categories in resources in the project.
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For example, if you added 10% to Labor resources, then any labor resources automatically have a 10%
markup added to it and that affects the resources charge rate. Then that charge rate affects the
amount of revenue that cost items can bill for and earn.

After you set labor at 10% and click Save, you are prompted with this dialog box confirming that you
are making a change to an existing markup.

From this dialog box, you can choose to update all existing cost categories. For this example, it adds
10% resource markup percent for all labor resources.
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The option to update matching existing cost categories selection changes the current charge rates for
cost items that were modified. Anything that has not been modified such as a labor resource that has
not been manually modified, this option overrides it with 10%.

You can also specify whether to only apply cost items and resources created in the future. When
selected, no changes are made to existing resources. Any newly created resources, in this example
labor resources, have a 10% markup added to them.

Cost categories are applicable in plug cost items that do not have resources or are not resource-driven.
The cost categories have only a blanket cost category markup that helps drive the total revenue
amount on the cost item.

You can view this information from Markup columns such as Billing rate markup amount, CE billable
amount, Markup amount, and CE revenue amount.

The column Markup amount uses the following formula:

l Markup percent x your current estimate = markup amount.

The Billing rate markup amount, for plug cost items is always set to zero because you can only have a
billing rate on resources. So if this is a detailed cost item, this is just showing your billing rate markup
amount for all of those resources.

The column CE billable amount uses the following formula:

l The Current estimate amount + your Billing rate markup amount = CE billable amount.

The column CE revenue amount uses the following formula:

l The CE billable amount + your Markup amount = CE revenue amount.
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The CE revenue amount is how much revenue a cost item can have. This is only applicable for cost plus
pay items. You can apply markups on cost items and they do not affect the revenue on those cost
items. The markups affect the revenue for cost plus pay items and any cost items that are assigned to
cost plus pay items.

12.1.16 SYNC INTEGRATIONS (PROJECT LEVEL)

Schedule sync integrations to run at specific times such as Pushing the CBS structure or Pushing Billed
Revenue.
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12.1.17 OTHERS (PROJECT LEVEL)

12.1.17.20 REQUIRED COST ITEMS

You can prevent the project from syncing when required cost items are not included by setting the
Prevent project from syncing if required cost items are not added toggle to Yes.

12.1.17.21 DECIMAL PRECISION

The image and table below summarize the different decimal precision options:

Name Function

1 Currency Number of decimal places for currencies. Any field that includes currency
data will be affected by this setting.

2 Cost
Summary

Number of decimal places for total cost information both at the terminal
and non-terminal level.

3 Unit Cost Number of decimal places for any unit cost displayed.

4 Quantities Number of decimal places for any quantities displayed.

5 Percentages Percent complete calculations at both the terminal and non-terminal
level.

Overview – Decimal Precision

Numeric fields can be configured to omit decimals for currency, unit cost, percentages, cost summary
and quantities.
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12.1.18 OTHERS (ORG LEVEL)

12.1.18.22 REQUIRED COST ITEMS

A Prevent project from syncing if required cost items are not added toggle has been added to prevent
the project from syncing if required cost items are not added. The Required cost items feature lets you
create standardized or most commonly used cost items at the organization level and then add them at
the project CBS level.
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12.1.18.23 CHANGE ORDER DETAILS

Change Order fields can be configured as validated drop-down list fields at the organization level.

After the toggle is set to On, the Discipline, Issue #, and CCO fields are validated in the drop-down list
values. When the toggle is set to Off, these fields are free text fields with no validations.

In the example below, six validated issues have been selected to be associated with this change order
after it is submitted.
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REVIEW

1. How many administrative levels are there when you create a new role?

a. 1

b. 2

c. 3

d. 4

2. There are several options when setting up project tracking. What setting is NOT included
in these options?

a. How import of your CBS structure will be configured

b. How percent complete for individual cost items will be calculated

c. Configuring and naming tags

d. Capping percent complete at 100%

SUMMARY

As a result of this lesson, you can:

l Create and manage InEight Control roles and permissions

l Navigate and define the different type of InEight Control project settings
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